Manual Part No. MAN-PVR-7K-3.7
June 22, 2015

Copyright © 2000—2015 Harmonic Inc. All rights reserved. Omneon, and the Omneon logo are trademarks of Harmonic Inc.

Manual Part No. MAN-PVR-7K-3.7
June 22, 2015

Copyright © 2000—2015 Harmonic Inc. All rights reserved. Omneon, and the Omneon logo are trademarks of Harmonic Inc.

Harmonic, the Harmonic logo, [all other Harmonic products mentioned] are trademarks, registered trademarks or service marks of Harmonic Inc. in the United States and other countries. Dolby, Dolby Digital, Dolby Digital Plus and Dolby E are registered trademarks of Dolby Laboratories. Implementations of AAC and HE-AAC by Fraunhofer IIS. Other company, product and service names mentioned herein may be trademarks or service marks of their respective owners. All product and application features and specifications are subject to change at Harmonic’s sole discretion at any time and without notice.

Disclaimer
Harmonic reserves the right to alter the equipment specifications and descriptions in this publication without prior notice. No part of this publication shall be deemed to be part of any contract or warranty unless specifically incorporated by reference into such contract or warranty. The information contained herein is merely descriptive in nature, and does not constitute a binding offer for sale of the product described herein. Harmonic assumes no responsibility or liability arising from the use of the products described herein, except as expressly agreed to in writing by Harmonic. The use and purchase of this product do not convey a license under any patent rights, copyrights, trademark rights, or any intellectual property rights of Harmonic. Nothing hereunder constitutes a representation or warranty that using any products in the manner described herein will not infringe any patents of third parties.

Third-Party Product Trademarks
Adobe® After Effects®, Photoshop®, Flash® Professional, Premiere®
Avid® Media Composer®
Dolby® E, Dolby Digital, Dolby Digital Plus
Jünger Audio™
Apple® QuickTime®
Microsoft® MediaRoom®
Microsoft® PlayReady®
DOCSIS® 3.0
Start Over® TV

Third-Party Copyright Notes
Dolby is a registered trademark of Dolby Laboratories. Dolby Digital, Dolby Digital Plus, Dolby Pulse, aacPlus, AC-3, and Dolby E are trademarks of Dolby Laboratories.
Level Magic and Jünger are trademarks of Jünger Audio Studiotechnik GmbH.
MPEG Audio technology licensed from Fraunhofer IIS http://www.iis.fraunhofer.de/amm/
PitchBlue® is a registered trademark of Vigor Systems.
QuickTime and the QuickTime logo are trademarks or registered trademarks of Apple Computer, Inc., used under license therefrom.

Trademark Acknowledgments
Harmonic and all Harmonic product names are trademarks of Harmonic Inc. All other trademarks are the property of their respective owners.
The software described in this document is furnished under a license agreement or nondisclosure agreement. The software may be used or copied only in accordance with the terms of those agreements.

Java®
May be covered by one or more of U.S. Patents No. 6,571,351; 6,696,996; 6,545,721; 6,574,225; 6,895,003; 6,522,649; 6,643,702; foreign counterparts and pending patent applications.

This system is distributed with certain other software that may require disclosure or distribution of licenses, copyright notices, conditions of use, disclaimers and/or other matter. Use of this system or otherwise fulfilling their conditions constitutes your acceptance of them, as necessary. Copies of such licenses, notices, conditions, disclaimers and/or other matter are available in any one of the following locations: the LEGAL NOTICES AND LICENSES directory of the distribution disk of the software, the root directory of the hard disk drive of the Products, or by contacting us at support@harmonicinc.com.

Notice
Information contained in this guide is subject to change without notice or obligation. While every effort has been made to ensure that the information is accurate as of the publication date, Harmonic Inc. assumes no liability for errors or omissions. In addition, Harmonic inc. assumes no responsibility for damages resulting from the use of this guide.

License Agreement and Limited Warranty
1. AGREEMENT: This is a legal agreement (“Agreement”) between you (“you” or “your”) and Harmonic, or its appropriate local affiliate (“Harmonic”, “we”, “us” or “our”). Use of our product(s) and any updates thereto purchased or validly obtained by you (the “Products”), and/or the Software (as defined below) (collectively, the “System”), constitutes your acceptance of this Agreement. “Use” includes opening or breaking the seal on the packet containing this Agreement, installing or downloading the Software as defined below or using the Software preloaded or embedded in your System. As used herein, the term “Software” means the Harmonic owned software and/or firmware used in or with the Products and embedded into, provided with or loaded onto the Products in object code format, but does not include, and this Agreement does not address, any third-party or free or open source software separately licensed to you (“Third Party Software”). If you do not agree to this Agreement, you shall promptly return the System with a dated receipt to the seller for a full refund.

©2015 Harmonic Inc. All rights reserved.
2. LICENSE: Subject to the terms and conditions of this Agreement (including payment), we hereby grant you a nonexclusive, nontransferable license to use the object code version of the Software embedded into, provided solely for use with or loaded onto the Product, and the accompanying documentation ("Documentation") for your internal business purposes. The Software and any authorized copies are owned by us or our suppliers, and are protected by law, including without limitation the copyright laws and treaties of the U.S.A. and other countries. Evaluation versions of the Software may be subject to a time-limited license.

3. RESTRICTIONS: You (and your employees and contractors) shall not attempt to reverse engineer, disassemble, modify, translate, or create derivative works of, rent, lease (including use on a timesharing, applications service provider, service bureau or similar basis), loan, distribute, sublicense or otherwise transfer the System, in whole or part except to the extent otherwise permitted by law. The Software may be operated on a network only if and as permitted by its Documentation. You may make one (1) back up copy of the object code of the Software for archival purposes only. Evaluation Software will be run in a lab, nonproductive environment. Results of any benchmark or other performance tests may not be disclosed to any third party without our prior written consent. Title to and ownership of the Software and any documentation, trade secrets, trademarks, and other intellectual property rights in the System, shall remain our or our licensors' property. You shall not remove or alter any copyright or other proprietary rights notice on the System. We reserve all rights not expressly granted.

4. LIMITED WARRANTY: (a) Limited Warranty. We warrant to you that, commencing on your receipt of a Product and terminating 1 year thereafter, the System will perform substantially in accordance with its then-current appropriate Documentation. The Product (including replacements) may consist of new, used or previously-installed components. (b) Remedies. If the System fails to comply with such warranty during such period, as your sole remedy, you must return the same in compliance with our product return policy, and we shall, at our option, repair or replace the System, provide a workaround, or refund the fees you paid. Replacement Systems are warranted for the original System's remaining warranty period. (c) Exclusions. EVALUATION SOFTWARE IS LICENSED ON AS-IS BASIS AND SUBJECT TO 4(d). We will have no obligation under this limited warranty due to: (i) negligence, misuse or abuse of the System, such as unusual physical or electrical stress, misuse or accidents; (ii) use of the System other than in accordance with the Documentation; (iii) modifications, alterations or repairs to the System made by a party other than us or our representative; (iv) combination, operation or use of the System with equipment, devices, software or data not sold by us; (v) any third party hardware or Third Party Software, whether or not provided by us; (vii) any failure other than by us to comply with handling, operating, environmental, storage or maintenance requirements for the System in the Documentation, including, without limitation, temperature or humidity ranges. (d) Disclaimers. We are not responsible for your software, firmware, information, or data contained in, stored on, or integrated with any Product returned to us for repair or replacement. SUCH LIMITED WARRANTY IS IN LIEU OF, AND WE SPECIFICALLY DISCLAIM, ANY AND ALL OTHER WARRANTIES, WHETHER EXPRESS, IMPLIED OR STATUTORY, INCLUDING, BUT NOT LIMITED TO, ANY IMPLIED WARRANTIES OF SATISFACTORY QUALITY, MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OR NON-INFRINGEMENT. WE DO NOT WARRANT THAT THE SYSTEM WILL MEET YOUR REQUIREMENTS OR BE UNINTERRUPTED OR ERROR-FREE. NO ADVICE OR INFORMATION, WHETHER ORAL OR WRITTEN, OBTAINED FROM US OR ELSEWHERE, WILL CREATE ANY WARRANTY NOT EXPRESSLY STATED IN THIS AGREEMENT. Some jurisdictions do not allow the exclusion of implied warranties or limits on how long an implied warranty may last, so such exclusions may not apply to you. In that event, such implied warranties or limitations are limited to 60 days from the date you purchased the System or the shortest period permitted by applicable law, if longer. This warranty gives you specific legal rights and which vary from state to state or country to country.

5. LIMITATION OF LIABILITY: WE AND OUR AFFILIATES, SUPPLIERS, LICENSORS, OR SALES CHANNELS ("REPRESENTATIVES") SHALL NOT BE LIABLE TO YOU FOR ANY SPECIAL, INCIDENTAL, CONSEQUENTIAL, PUNITIVE, OR EXEMPLARY DAMAGES OF ANY KIND, INCLUDING BUT NOT LIMITED TO LOST REVENUES, PROFITS OR SAVINGS, OR THE COST OF SUBSTITUTE GOODS, HOWEVER CAUSED, UNDER CONTRACT, TORT, BREACH OF WARRANTY, NEGLIGENCE, OR OTHERWISE, EVEN IF WE WERE ADVISED OF THE POSSIBILITY OF SUCH LOSS OR DAMAGES. NOTWITHSTANDING ANY OTHER PROVISIONS OF THIS AGREEMENT, WE AND OUR REPRESENTATIVES SHALL NOT BE LIABLE TO YOU ARISING FROM OR RELATING TO THIS AGREEMENT OR THE SYSTEM SHALL BE LIMITED TO THE TOTAL PAYMENTS TO US UNDER THIS AGREEMENT FOR THE SYSTEM. THE FOREGOING LIMITATIONS SHALL NOT APPLY TO DEATH OR PERSONAL INJURY TO PERSONS OR TANGIBLE PROPERTY IN ANY JURISDICTION WHERE APPLICABLE LAW PROHIBITS SUCH LIMITATION. YOU ARE SOLELY RESPONSIBLE FOR BACKING UP YOUR DATA AND FILES, AND HEREBY RELEASE US AND OUR REPRESENTATIVES FROM ANY LIABILITY FOR DAMAGES DUE TO THE LOSS OF ANY SUCH DATA OR FILES. SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO SUCH EXCLUSIONS MAY NOT APPLY TO YOU.

6. CONFIDENTIALITY: Information in the System and the associated media, as well as the structure, organization and code of the Software, are proprietary to us and contain valuable trade secrets developed or acquired at great expense to us or our suppliers. You shall not disclose to others or utilize any such information except as expressly provided herein, except for information (i) lawfully received by the user from a third party which is not subject to confidentiality obligations; (ii) generally available to the public without breach of this Agreement; (iii) lawfully known to the user prior to its receipt of the System; or (iv) required by law to be disclosed.

7. SUPPORT: Updates, upgrades, fixes, maintenance or support for the System (an "Upgrade") after the limited warranty period may be available at separate terms and fees from us. Any Upgrades shall be subject to this Agreement, except for additional or inconsistent terms we specify. Upgrades do not extend the limited warranty period.

8. TERM; TERMINATION: The term of this Agreement shall continue until terminated in accordance with this Section. We may terminate this Agreement at any time upon default by you of the license provisions of this Agreement, or any other material default by you of this Agreement not cured within thirty (30) days after written notice thereof. You may terminate this Agreement any time by terminating use of the System. Except for the first sentence of Section 2 ("License") and for Section 4(a) ("Limited Warranty"), all provisions of this Agreement shall survive termination of this Agreement. Upon any such termination, you shall certify in writing such termination and non-use to us.

9. EXPORT CONTROL: You agree that the Products and Software will not be shipped, transferred, or exported into any country or used in any manner prohibited by the United States Export Administration Act or any other export laws, restrictions, or regulations (the "Export Laws"). You will indemnify, defend and hold us harmless from any and all claims arising from your or your employees or agents relating thereto. In addition, if the Products or Software are identified as export controlled items under the Export Laws, you represent and warrant that you are not a citizen, or otherwise located within, an embargoed nation (including without limitation Iran, Iraq, Syria, Sudan, Libya, Cuba, North Korea, and Serbia) and that you are not otherwise prohibited under the Export Laws from receiving the Software. All rights to the Products and Software are granted on condition that such rights are forfeited if you fail to comply with the terms of this Agreement.

10. U.S. GOVERNMENT RIGHTS: The Software and the documentation which accompanies the Software are "Commercial Items," as that term is defined at 48 C.F.R. §2.101, consisting of "Commercial Computer Software" and "Commercial Computer Software Documentation," as such terms are used in 48 C.F.R. §2.122 or 48 C.F.R. §227.7202, as applicable. Consistent with 48 C.F.R. §227.7202-1 through 227.7202-4, as applicable, the Commercial Computer Software and Commercial Computer Software Documentation are being licensed to U.S. Government as end users (a) only as Commercial Items and (b) with only those rights as are granted to all other end users pursuant to the terms and conditions here. Harmonic, 4300 North First Street, San Jose, CA 95134 U.S.A.

11. GENERAL: You shall not assign, delegate or sublicense your rights or obligations under this Agreement, by operation of law or otherwise, without our prior written consent, and any attempt without such consent shall be void. Subject to the preceding sentence, this Agreement binds and benefits permitted successors and assigns. This Agreement is governed by California law, without regard to its conflicts of law principles. The U.N. Convention on Contracts for the International Sale of Goods is disclaimed. If any claim arises out of this Agreement, the parties hereby submit to the exclusive jurisdiction and venue of the federal and state courts located in Santa Clara County, California. In addition to any other rights or remedies, we shall be entitled to injunctive and other equitable relief, without posting bond or other security, to prevent any material breach of this Agreement. We may change the terms, conditions and pricing relating to the future licensing of our Systems and other intellectual property rights, including this Agreement, from time to time. No waiver will be implied from conduct or failure to enforce rights nor effective unless in a writing signed on behalf of the party against whom the waiver is asserted. If any part of this Agreement is found unenforceable, the remaining parts will be enforced to the maximum extent permitted. There are no third-party beneficiaries to this Agreement.

©2015 Harmonic Inc. All rights reserved.
Agreement. We are not bound by additional and/or conflicting provisions in any order, acceptance, or other correspondence unless we expressly agree in writing. This Agreement is the complete and exclusive statement of agreement between the parties as to its subject matter and supersedes all proposals or prior agreements, verbal or written, advertising, representations or communications concerning the System.

Every reasonable attempt has been made to comply with all licensing requirements for all components used in the system. Any oversight is unintentional and will be remedied if brought to the attention of Harmonic at support@harmonicinc.com.

Documentation Conventions
This guide may use some special symbols and fonts to call your attention to important information. The following symbols appear throughout this guide:

**DANGER:** The Danger symbol calls your attention to information that, if ignored, can cause physical harm to you.

**CAUTION:** The Caution symbol calls your attention to information that, if ignored, can adversely affect the performance of your Harmonic product, or that can make a procedure needlessly difficult.

**LASER DANGER:** The Laser symbol and the Danger alert call your attention to information about the lasers in this product that, if ignored, can cause physical harm to you.

**NOTE:** The Note symbol calls your attention to additional information that you will benefit from heeding. It may be used to call attention to an especially important piece of information you need, or it may provide additional information that applies in only some carefully delineated circumstances.

**IMPORTANT:** The Important symbol calls your attention to information that should stand out when you are reading product details and procedural information.

**TIP:** The Tip symbol calls your attention to parenthetical information that is not necessary for performing a given procedure, but which, if followed, might make the procedure or its subsequent steps easier, smoother, or more efficient.

In addition to these symbols, this guide may use the following text conventions:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Explanation</th>
</tr>
</thead>
<tbody>
<tr>
<td>Typed Command</td>
<td>Indicates the text that you type in at the keyboard prompt.</td>
</tr>
<tr>
<td>&lt;Ctrl&gt;, &lt;Ctrl&gt;+&lt;Shift&gt;</td>
<td>A key or key sequence to press.</td>
</tr>
<tr>
<td>Links</td>
<td>The <em>italics in blue</em> text to indicate Cross-references, and hyperlinked cross-references in online documents.</td>
</tr>
<tr>
<td>Bold</td>
<td>Indicates a button to click, or a menu item to select.</td>
</tr>
<tr>
<td>ScreenOutput</td>
<td>The text that is displayed on a computer screen.</td>
</tr>
<tr>
<td>Emphasis</td>
<td>The <em>italics</em> text used for emphasis and document references.</td>
</tr>
</tbody>
</table>

**NOTE:** You require Adobe Reader or Adobe Acrobat version 6.0 or later to open the PDF files. You can download Adobe Reader free of charge from www.adobe.com.
# Table of Contents

## Chapter 1: Introduction
- General Information ................................................................. 11
- Main ProView 7000/7100 Applications ........................................ 11
  - TS Descrambling Applications ............................................. 12
  - Decoding Applications ....................................................... 12
  - Transcoding Applications ................................................... 12
- ProView 7000 Platform Main Features and Configurations ............... 12
  - Multi-Transport Stream Descrambler ..................................... 14
  - Multi-Format Decoder .......................................................... 15
  - MPEG-4 AVC <-> MPEG-2 Transcoder .................................... 18
  - DMS (Distribution Management System) .................................. 18
- ProView 7000 Mechanical Structure ........................................ 19
- ProView 7000 Enclosure .......................................................... 19
- ProView 7000/7100 Front Panel .............................................. 19
- ProView 7000 Rear Panel ....................................................... 19
- ProView 7000 Management ...................................................... 20

## Chapter 2: Quick Start
- Installation and Cable Connection ........................................... 21
  - Installation ............................................................................. 21
  - Electrical Connection ........................................................... 21
  - Cable Connections .............................................................. 22
- Switching On ............................................................................ 22
- Configuring the IP Parameters .................................................. 22
- Configuring and Monitoring ...................................................... 23
  - A Typical ProView 7000 Configuration Using the Front Panel ....... 23
  - EMS Initial Setup .................................................................. 26
  - A Typical ProView 7000 Configuration Using EMS ..................... 30

## Chapter 3: Front Panel Overview
- Main Elements and Structure .................................................. 35
- Front Panel Display ................................................................. 36
  - Menu Pages ............................................................................. 36
  - Parameter Pages .................................................................... 37
  - Edit Value Pages .................................................................... 37
  - Radio Select Pages ............................................................... 38

## Chapter 4: Device Configuring Using the Front Panel
- Configuring the DVB-S/S2 Input Port Properties .......................... 39
- Configuring the DS-3 Input Port Properties ................................ 42
- Configuring the Decoding Programs ......................................... 44
# Table of Contents

- Service Selection Mode .................................................. 45
- Redundancy Configuration .................................................. 45
- Video Configuration .......................................................... 46
- PCR Configuration ............................................................ 48
- Audio 1–4 Configuration ..................................................... 48
- SDI Groups ........................................................................ 49
- VBI/VANC Configuration ..................................................... 50
- DPI to GPI .......................................................................... 52
- OSD ..................................................................................... 52
- Routing and Descrambling .................................................. 52
- Configuring the GbE Ports, Sockets and Routing Table ............ 57
- CA Definitions ..................................................................... 60
  - Verimatrix .......................................................................... 61
  - BISS .................................................................................. 61
  - CAM 1-4 Sub Menus .......................................................... 61
    - Selecting All Elementary Streams .................................... 61
    - Configuring Only Relevant Elementary Streams .............. 62
    - Accessing the CAM MMI Menu ........................................ 62
- Unit Menu ............................................................................. 62
  - Management Port Menu ...................................................... 62
  - SW Version Menu .............................................................. 63
  - HW Inventory Menu ........................................................... 63
  - Date/Time Menu ................................................................ 64
  - Set Active Version ............................................................. 64
  - License .............................................................................. 64
  - BOOTP Menu .................................................................... 64
  - LCD Contrast Menu ............................................................ 64
  - GPI Menu .......................................................................... 64
  - Reset Unit Menu ............................................................... 65
  - Restore to Defaults Menu .................................................. 65
- Presets .................................................................................. 65
- DMS ..................................................................................... 65

## Chapter 5: Monitoring Using the Front Panel ................................................. 67

- Device Monitoring ............................................................... 67
  - Status OK .......................................................................... 67
  - Alarms .............................................................................. 67
  - DMS .................................................................................. 69
- Monitoring the DVB-S/S2 Input Port Properties ......................... 69
- Monitoring the Decoding ........................................................ 70

## Chapter 6: Remote Management using EMS ................................................. 71

- Configuring the IP Parameters ............................................... 71
- EMS System Requirements ................................................... 72
- Installing EMS ..................................................................... 72
- Launching EMS .................................................................... 73
# Table of Contents

Adding a Device ........................................................................................................... 73  
Changing a Device’s Connection Settings ................................................................. 74  
Connecting a Device .................................................................................................... 74  
Checking Device Connectivity ..................................................................................... 75  
Disconnecting a Device ............................................................................................... 76  
Removing a Device ...................................................................................................... 76  
Displaying the Device Explorer .................................................................................... 77  
EMS GUI Structure ...................................................................................................... 77  
Manipulating EMS GUI Components .......................................................................... 77  
Refreshing the EMS Screen .......................................................................................... 78  
Toolbar .......................................................................................................................... 78  
EMS Device Explorer ................................................................................................... 80  
DMS ............................................................................................................................... 81  

## Chapter 7: Device Configuring Using EMS ................................................................. 83  

### Physical Input Ports and Slots  
ASI Input Port ................................................................................................................ 84  
DVB-S/S2 In Port Properties .......................................................................................... 85  
DS-3 In Port Properties .................................................................................................. 89  
GbE Ports for Input ........................................................................................................ 89  
CAM Slots ..................................................................................................................... 94  
CAM Properties ............................................................................................................ 96  
BISS Table Management ............................................................................................... 98  
Verimatrix Properties .................................................................................................. 99  

### Multiplex Inputs  
Input Programs Management ....................................................................................... 100  
Input Tables Management ............................................................................................ 101  
Input Unreferenced PIDs Management ..................................................................... 102  
Multiplex In Port Properties ......................................................................................... 102  
Input Program Properties ............................................................................................. 109  
Input Elementary Stream Properties .......................................................................... 110  
Input Conditional Access Messages Properties ....................................................... 110  
Input Tables Properties ................................................................................................ 111  
Input Unreferenced PID Properties ............................................................................ 112  

### Multiplex, Transcoding & Decoding Outputs  
Multiplex Output .......................................................................................................... 113  
Multiplex Output Properties ......................................................................................... 119  
Transport Stream Port Route Property Sheet ............................................................. 120  
Output Multiplex Program Properties ........................................................................ 121  
Output Multiplex Elementary Stream Properties ...................................................... 123  
Output Tables Properties .............................................................................................. 124  
Output Unreferenced PID Properties ........................................................................ 126  
Decoding Channel Properties ...................................................................................... 127  

### Physical Outputs  
ASI Output Port Properties .......................................................................................... 142  
GbE Ports for Output ..................................................................................................... 143  
GbE Ports for Output  
ASI Output Port Properties  
GbE Ports for Output
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>HDMI and DVI Output</td>
<td>147</td>
</tr>
<tr>
<td>Element Properties</td>
<td>147</td>
</tr>
<tr>
<td>Cross Connections</td>
<td>148</td>
</tr>
<tr>
<td>Setting Multiplex Cross Connections</td>
<td>148</td>
</tr>
<tr>
<td>Input to Decoder Channel Connection</td>
<td>157</td>
</tr>
<tr>
<td>Editing and Deleting</td>
<td>159</td>
</tr>
<tr>
<td>CAM Slot Management</td>
<td>159</td>
</tr>
<tr>
<td>Descrambling a Cross Connected Program</td>
<td>160</td>
</tr>
<tr>
<td>Descrambling a Decoded Program</td>
<td>160</td>
</tr>
<tr>
<td>EMS Connection Wizard</td>
<td>160</td>
</tr>
<tr>
<td>Setting Program Cross-Connection using the Connection Wizard</td>
<td>161</td>
</tr>
<tr>
<td>Setting Decoding Channel using the Connection Wizard</td>
<td>162</td>
</tr>
<tr>
<td>Low Delay Mode</td>
<td>162</td>
</tr>
<tr>
<td>Selecting Low Delay Mode</td>
<td>163</td>
</tr>
<tr>
<td>Device Management</td>
<td>164</td>
</tr>
<tr>
<td>Reboot Device</td>
<td>165</td>
</tr>
<tr>
<td>Device Identification</td>
<td>166</td>
</tr>
<tr>
<td>Reset CAM Slot</td>
<td>166</td>
</tr>
<tr>
<td>Log-In / Log-Out Control of the Device</td>
<td>166</td>
</tr>
<tr>
<td>Setting Up/Changing the Device Log-in Password</td>
<td>166</td>
</tr>
<tr>
<td>Managing Presets</td>
<td>166</td>
</tr>
<tr>
<td>Backing Up/Restoring the Device Configuration</td>
<td>169</td>
</tr>
<tr>
<td>Restoring the Factory/Default Device Access Password</td>
<td>170</td>
</tr>
<tr>
<td>Device Properties</td>
<td>171</td>
</tr>
<tr>
<td>Network Properties</td>
<td>171</td>
</tr>
<tr>
<td>Hardware Properties</td>
<td>173</td>
</tr>
<tr>
<td>Device Communication Properties</td>
<td>178</td>
</tr>
<tr>
<td>Device Users’ Access Properties</td>
<td>180</td>
</tr>
<tr>
<td>Device Software Upgrade Properties</td>
<td>181</td>
</tr>
<tr>
<td>Device License Properties</td>
<td>182</td>
</tr>
<tr>
<td>Device Date and Time Properties</td>
<td>182</td>
</tr>
<tr>
<td>GPI Properties</td>
<td>183</td>
</tr>
<tr>
<td>Transcoding Properties</td>
<td>184</td>
</tr>
<tr>
<td><strong>Chapter 8: Monitoring using EMS</strong></td>
<td>186</td>
</tr>
<tr>
<td>Device Communication Status</td>
<td>186</td>
</tr>
<tr>
<td>Alarms</td>
<td>187</td>
</tr>
<tr>
<td>Alarm Properties</td>
<td>188</td>
</tr>
<tr>
<td>Alarm History</td>
<td>188</td>
</tr>
<tr>
<td>Refreshing the EMS Screen</td>
<td>188</td>
</tr>
<tr>
<td>DVB-S/S2 Input Port Properties Status</td>
<td>189</td>
</tr>
<tr>
<td>Decoding Channel Properties Status</td>
<td>189</td>
</tr>
<tr>
<td>DPI Log</td>
<td>191</td>
</tr>
<tr>
<td><strong>Appendix A: Contacting the Technical Assistance Center</strong></td>
<td>192</td>
</tr>
</tbody>
</table>
Appendix B: Safety and Regulatory Compliance Information ..................194
Important Safety Instructions .............................................................. 194
Safety Symbols & Translated Safety, Warning & Caution Instructions (English) ........ 194
Symboles de sécurité et traduits de sécurité, d'avertissement et Attention Instructions (français) .......................................................... 197
Sicherheit Symbole und übersetzte Sicherheit, Achtung & Vorsicht Anleitung (Deutsch) 200
Site Preparation Instructions .............................................................. 203
Product End-of-Life Disassembly Instructions ....................................... 205
  Product Disassembly Process ......................................................... 205
  Safety Rules (English) ................................................................. 205
  Règles de sécurité (French) .......................................................... 205
EU Manufacturer’s Declaration of Conformity ....................................... 206
Electromagnetic Compatibility Notices – Class A .................................. 206
Product Regulatory Compliance .......................................................... 208
Product Regulatory Compliance Markings ............................................ 208
Product Environmental Compliance .................................................... 210
  EU RoHS .................................................................................. 210
  EU REACH ........................................................................... 211
  China RoHS ........................................................................... 211
  Other RoHS and REACH type Regulations ...................................... 213
  Waste Electrical and Electronic Equipment (WEEE) ......................... 213
  Battery Directive ........................................................................ 213
  WEEE Take-Back Request Program .............................................. 213
Compliance with additional country specific environmental, safety and EMC standards: 214

Appendix C: Characteristics and Specifications .................................215
Transport Stream Input Interfaces .......................................................... 215
Transport Stream Output Interfaces ...................................................... 217
Transport Stream Processing ............................................................... 217
Conditional Access (DVB-CI) ............................................................... 217
Video and Audio Decoding ................................................................. 217
Video Transcoding ............................................................................ 219
Video and Audio Interfaces ................................................................. 220
Control and Monitoring ..................................................................... 220
Compliance ....................................................................................... 220
  EMC ......................................................................................... 220
  Safety ....................................................................................... 220
Environment ...................................................................................... 221
Physical and Electrical Characteristics ................................................ 221

Appendix D: Connectors and Front End Card Options .......................222
Overview of Rear Panel Ports and Connectors ...................................... 222
RGB Port Pin Configuration ................................................................. 226
ProView 7000 GPI Port Pin Configuration ............................................ 227
ProView 7100 GPI Port Pin Configuration ............................................ 228
Balanced Digital Audio Port Pin Configuration .................................... 229
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Balanced Audio Port Pin Configuration</td>
<td>230</td>
</tr>
<tr>
<td>GPI Relay Position Names</td>
<td>231</td>
</tr>
<tr>
<td>Front End Card Features</td>
<td>232</td>
</tr>
<tr>
<td><strong>Appendix E: Device Explorer Icons</strong></td>
<td>235</td>
</tr>
<tr>
<td><strong>Appendix F: Front Panel Menu Tree</strong></td>
<td>237</td>
</tr>
<tr>
<td><strong>Appendix G: ProView 7000 Alarm List</strong></td>
<td>239</td>
</tr>
<tr>
<td><strong>Appendix H: Software Management</strong></td>
<td>245</td>
</tr>
<tr>
<td>Active Version Management</td>
<td>245</td>
</tr>
<tr>
<td>Software Upgrade Manager</td>
<td>245</td>
</tr>
<tr>
<td>Upgrading the Firmware of ProView 7000s</td>
<td>246</td>
</tr>
<tr>
<td>Viewing the Software Upgrade Log</td>
<td>247</td>
</tr>
</tbody>
</table>

©2015 Harmonic Inc. All rights reserved.
Chapter 1
Introduction

Thank you for choosing the ProView™ multifunctional receiver.
The ProView 7000/7100™ multifunctional receiver platform provides an ideal solution for digital
turn around processing (DTA), descrambling, decoding and transcoding applications.
Topics:

- General Information
- Main ProView 7000/7100 Applications
- ProView 7000 Platform Main Features and Configurations
- ProView 7000 Mechanical Structure
- ProView 7000 Management

General Information

The Harmonic ProView 7000 is a single rack unit (1RU) scalable receiver, DVB descrambler,
multi-format video decoder and MPEG stream processor. The modular ProView 7000 addresses
the full spectrum of content reception applications from decoding to descrambling and re-
multiplexing of multiple transport streams.

Main ProView 7000/7100 Applications

Harnessing a flexible and modular design, the ProView 7100 addresses the vast spectrum of
content reception applications, from single-channel decoding 4:2:0/4:2:2 and MPEG-4 AVC to
MPEG-2 transcoding to DVB descrambling and re-multiplexing of multiple transport streams.

1. All references to the ProView 7000 include the ProView 7100 unless the ProView 7100 is specified.
**TS Descrambling Applications**

The ProView 7000/7100 is designed to economically meet the needs of digital turn around operators. Using its on-board quad DVB common interfaces and its embedded descrambling engines, the ProView 7000/7100 descrambles and re-multiplexes selected services from up to four transport streams, applying the operator’s CA to the new digital chain. The ProView 7000/7100 enables operators to create new SPTSs or MPTSs comprised of re-multiplexed services from the original streams. It is possible to output programs over IP or ASI.

The ProView 7000/7100 also supports all IP headend architectures, using Harmonic’s Flex encoder card for operators wishing to re-encode content.

**Decoding Applications**

The Harmonic ProView 7000/7100 professional receiver decoder is designed to provide a flexible solution for all applications, from SD/HD MPEG-2/MPEG4 AVC 4:2:0 decoding for the primary and secondary distribution markets, to 4:2:2 8/10 bits decoding for the contribution market. It is equipped with industry standard digital and analog outputs, including analog video and audio, AES/EBU, SD-SDI, HD-SDI and 3G-SDI. The unit also performs HD down-conversion and aspect ratio adaptation of HD programs to generate professional quality baseband analog video and audio outputs for easy integration with the existing cable network infrastructure.

**Transcoding Applications**

The Harmonic ProView 7100 professional receiver can be configured to perform any-to-any transcoding of up to eight channels of H.264 to MPEG-2 and MPEG-2 to H.264, allowing programmers to efficiently distribute superior quality video content while using minimal satellite transponder capacity. Content can be received and transcoded to any resolution required by the local operator or affiliate.

---

**ProView 7000 Platform Main Features and Configurations**

The ProView 7000 platform’s wide range of features includes the following:

- Variety of inputs including DVB-S/S2, ASI, DS-34, and GbE inputs
- Any to any Port redundancy
- Integrated DVB-CI slots providing descrambling of multiple transport streams
  - ProView 7000 is equipped with 2 DVB-CIs to descramble 2 full TSs
  - ProView 7100 is equipped with 4 DVB-CIs to descramble 4 full TSs
- Verimatrix embedded descrambling
- Decoder service redundancy
- BISS descrambling - up to 4 full TSs

---

2. A license is required for more than one transport stream.
3. Requires a license with some hardware configurations, see Front End Card Features for details.
4. Requires some hardware configurations, see Front End Card Features for details.
5. IP data in requires a license.
6. Only on ProView 7100 with the latest firmware supporting this feature.
MPEG-4 AVC/MPEG-2 SD/HD 4:2:0 single/dual decoding
MPEG-2 4:2:2 8 bits SD/HD/1080P
MPEG-4 AVC 4:2:2 8 and 10 bits SD/HD/1080P
Decoding of 4 audio PIDs
MPEG-1 Layer II (Musicam), Dolby Digital, Dolby Digital Plus, AAC LC, HE AAC, Dolby E / Linear PCM Passthrough
Broadcast quality video and audio outputs
3G-SDI, HD-SDI, SD-SDI, HDMI and analog video outputs
Balanced and unbalanced digital audio outputs
Balanced analog audio outputs
ASI and GbE outputs
MPE decapsulation for offline data delivery
Re-multiplexing capabilities with up to four multiplexes
T2MI Deframing to MPEG TS
The ProView 7000 can generate up to four (4) TS outputs from one (1) TS input
Re-generation of DVB and MPEG PSI/SI
Low Delay decoding mode
EMS graphical user interface providing easy drag-and-drop management
SNMP monitoring
Closed caption (CEA-608 and CEA-708) re-insertion into VANC in SD/HD-SDI output
On screen display of DVB subtitles in SD and HD resolutions
Automatic service selection of the first service in the PAT
Genlock
SFN Remux (DSR) support (requires a Harmonic ProStream 1000)

The ProView 7000 platform is offered in three different application oriented configurations:

- Multi-Transport Stream Descrambler
- Multi-Format Decoder
- MPEG-4 AVC <---> MPEG-2 Transcoder

---

7. Only with certain hardware configurations.
8. Requires a license.
9. Requires a license with some hardware configurations, see Front End Card Features for details.
10. Dolby and Dolby Digital are registered trademarks of Dolby Laboratories.
11. Only with certain hardware configurations.
12. A license is required for more than one multiplex. When using IP In, the multiplex limit is 2.
13. Requires a license.
Multi-Transport Stream Descrambler

The ProView 7000 Multi-Transport Stream Descrambler is an ideal and cost effective receiver solution for digital headend turn around applications.

The platform’s DVB-S/S2\textsuperscript{16}, ASI, DS-3\textsuperscript{14}, and IP inputs, along with powerful descrambling and multiplexing capabilities, fully addresses the headend reception application requirements.

The basic configuration includes:

- 1 x ASI input (can grow up to 4 with license)
- 2 x GbE outputs with virtual IP on the output stream
- 2 x ASI outputs (up to 4 x ASI outputs on ProView 7100)
- Re-multiplexing capabilities with up to four multiplex outputs\textsuperscript{15}
- Regeneration of DVB and MPEG or PSI/SI
- Highly accurate PCR re-stamping
- Conditional access:
  - BISS – Full transport stream descrambling\textsuperscript{16}
  - Verimatrix embedded descrambling
  - Multi-program descrambling with DVB-CI (up to 2 or 4 TSs)
  - 2 or 4\textsuperscript{17} x DVB-CI slots
  - CA methods: Multicrypt, Simulcrypt
  - CAS (partial list): Viaccess®, Irdeto®, Conax®, Nagravision®

Hardware options:

- 1 x DVB-S/S2\textsuperscript{16} or 4 x DVB-S/S2\textsuperscript{16} or 1 x DS-3\textsuperscript{14} and 1 x passthrough input
- Single or dual decoder

License options:

- Multiple programs descrambling license (up to four TS descrambling, one channel descrambling is license free)
- DVB-S2\textsuperscript{16}
- DS-3\textsuperscript{14}
- 2 or 4 x Transport streams routing
- IP input
- IP input FEC\textsuperscript{17}

\textsuperscript{14} Requires some hardware configurations, see \textit{Front End Card Features} for details.
\textsuperscript{15} A license is required for more than one multiplex.
\textsuperscript{16} Requires a license with some hardware configurations.
\textsuperscript{17} ProView 7100 only and requires a license.
**Multi-Format Decoder**

The ProView 7000/7100 can be configured as a multi-format video decoder. The ProView 7000/7100 is for both Standard Definition (SD) and High Definition (HD) resolutions for MPEG-2 and MPEG-4 AVC decoding.

Its wide choice of input options and video/audio interfaces ensures compatibility to all reception and decoding application environments.

Basic configuration includes:

- **TS I/Os:**
  - 1 or 4 x DVB-S/S2\(^{18}\) or 1 x DS-3\(^{19}\) and 1 x passthrough input
  - 2 or 4 x ASI inputs
  - 2 x GbE inputs\(^{20}\)/outputs (virtual IP on the output stream)
  - 2 x ASI outputs (up to 4 x ASI outputs on ProView 7100)

- 2 or 4\(^{21}\) x CI slots enabling single program descrambling

- **Verimatrix embedded descrambling**

- **Decoder module video outputs** (ability to configure up to two modules per unit):
  - 2 x CV interfaces (2 outputs per video channel)
  - 2 x SD/HD/3G-SDI with embedded audio (2 or 4 outputs per video channel)
  - 1 x analog video RGB-HD (15 pin connector)
  - 1 x HD monitor interface (HDMI)

- **Decoder module audio outputs:**
  - 2 or 4\(^{22}\) x balanced analog audio stereo output pairs (15 pin D-Sub connector)
  - 2 or 4\(^{22}\) x balanced AES/EBU digital audio outputs (15 pin D-Sub connector)
  - 2 x unbalanced AES/EBU digital audio outputs (2 x BNC connector)

**Hardware options:**

- 1 x DVB-S/S2\(^{18}\) or 4 x DVB-S/S2\(^{18}\) or 1 x DS-3\(^{19}\) and 1 x passthrough input

- Genlock input

- Single or dual decoder

- 4:2:2 Single decoder\(^{22}\)

**License options:**

- HD MPEG-2 / MPEG-4 AVC decoding

- DVB-S2 (requires DVB-S2 card)

---

18. Requires a license with some hardware configurations, see Front End Card Features for details.
19. Requires some hardware configurations, see Front End Card Features for details.
20. IP video input requires a license.
21. ProView 7100 only.
22. Requires a license.
Chapter 1 Introduction

ProView 7000 Platform Main Features and Configurations

- DS-3 (requires DS-3 card)\(^{23}\)
- 2 or 4 x Transport Stream routing
- IP input
- IP input FEC\(^{23}\)
- AAC decoding
- 4 Audio PIDs decoding, Dolby 5.1 decoding to PCM (without down-mix)
- Low Delay Decoding
- Dolby E\(^{24}\) / Linear PCM Passthrough

Video decoding formats:
- MPEG-2 SD 4:2:0 MP@ML
- MPEG-2 SD 4:2:0 MP@HL
- MPEG-2 HD 4:2:0 MP@HL\(^{25}\)
- MPEG-2 SD 4:2:2 @ML
- MPEG-2 SD 4:2:2 MP@HL
- MPEG-2 HD 4:2:2 P @HL\(^{25}\)
- MPEG-4 AVC SD 4:2:0 MP@L3
- MPEG-4 AVC HD 4:2:0 MP@L4.0 / HP@4.0\(^{25}\)
- MPEG-4 AVC SD 4:2:2 HP@L3\(^{25}\)
- MPEG-4 AVC HD 4:2:2 @ HiP/Hi10P/Hi422P @ L4.1 (8 and 10 bit)\(^{25}\)

Maximum video rate:
- MPEG-2 SD 4:2:0 - 15 Mbps
- MPEG-2 SD 4:2:2 - 50 Mbps
- MPEG-2 HD 4:2:0\(^{25}\) - 50 Mbps
- MPEG-2 HD 4:2:2\(^{25}\) - 80 Mbps
- MPEG-4 AVC SD 4:2:0 - 10 Mbps
- MPEG-4 AVC SD 4:2:2\(^{25}\) - 50 Mbps
- MPEG-4 AVC HD 4:2:0 - 20 Mbps (MP), 25 Mbps (HP)
- MPEG-4 AVC HD 4:2:2\(^{25}\) - 100 Mbps (CAVLAC), 50 Mbps (CABAC)

Video formats:
- 1080p @ 50, 59.94, 60 fps
- 1080i @ 29.97, 30, 25 fps

---

\(^{23}\) ProView 7100 only and requires a license.
\(^{24}\) Dolby, Dolby E and Dolby Digital are registered trademarks of Dolby Laboratories.
\(^{25}\) Requires a license.
- 720p @ 59.94, 50, 60 fps
- 480i @ 29.97 fps
- 576i @ 25 fps
- 480p @ 59.94 fps
- Analog video output – PAL-B/G/I/M/N/D, NTSC, French SECAM, Russian SECAM

Audio Decoding:
- 2 or 4\textsuperscript{25} x Stereo pairs audio decoding
- Stereo down-mix
- MPEG-1 Layer-II (Musicam)
- Dolby Digital®
  - Dolby Digital® 2.0
  - Dolby Digital® 5.1 passthrough (AC-3 only)
  - Dolby Digital® 5.1 down-mix to 2.0
  - Dolby Digital® 5.1\textsuperscript{26}
  - Dolby Digital Plus 5.1 re-embedded to Dolby Digital 5.1 @ 640 kbps
- Dolby E® / Linear PCM passthrough\textsuperscript{26}
- AAC LC
  - AAC LC 2.0 audio
  - AAC LC 5.1 audio\textsuperscript{26}
  - AAC LC 5.1 audio down-mix to 2.0 audio
- HE AAC v1 and v2 audio
  - HE AAC 2.0 audio
  - HE AAC 5.1 audio\textsuperscript{26}
  - HE AAC v1 5.1 audio down-mix to 2.0 audio

Video Processing:
- HD video down-converted to SD with aspect ratio conversion
- Aspect ratio conversion 16:9 to 4:3
- VBI reinsertion in video
- CEA-608/CEA-708 CC support in CV and SDI VANC
- Letter Box, Center Cut
- SMPTE RP 186:2008 (class1.1) Video Index Information Coding
- SCTE 35 queuing commands to SCTE 104 splice request messages translation

\textsuperscript{26} Requires a license.
MPEG-4 AVC <-> MPEG-2 Transcoder

The ProView 7100 can be configured as an MPEG-4 AVC - MPEG-2 transcoder. It performs any-to-any transcoding of up to eight transcoding channels of H.264 to MPEG-2, enabling programmers to efficiently distribute superior quality video content while using minimal satellite transponder capacity. Content can be received and transcoded to any resolution required.

Configuration includes:

- 1, 2, 4 or 8 transcoding channels
- Video Input:
  - MPEG-4 AVC SD MP@L3
  - MPEG-4 AVC HD MP@L4.0/ HP@4.0
  - HD 1080i: 1920/1440, @25, 29.97, 30 fps
  - HD 720p: 1280/960 @59.94, 50, 60 fps
  - SD: 480i @ 29.97 fps, 576i @25 fps, 480p @ 59.94 fps; vertical - 720/704/544/528
- Video Output:
  - MPEG-2 SD 4:2:0 MP@ML
  - MPEG-2 HD 4:2:0 MP@HL
  - Output resolution conversion: HD to HD, HD to SD, SD to SD
  - MPEG-4 AVC SD MP@L3
  - MPEG-4 AVC HD MP@L4.0
- VBI passthrough
- Audio passthrough

License options:
- Transcoding HD (includes transcoding SD)

DMS (Distribution Management System)

DMS from Harmonic is a management system for video distribution networks over satellite or IP. It provides in-band / Over-The-Air (OTA) control of multiple ProView 7000/7100 devices installed in remote locations.

DMS can perform the following actions on ProView 7000/7100 receivers:

- Upgrade and activate firmware
- Full device configuration changes
- Blackouts
- Define disaster recovery for the receivers
- Upgrade Licenses
- CA Entitlement and subscriber management (Verimatrix CAS, BISS and CAMs)
- Sending different BISS keys to the devices
- Schedule events for automated operation
ProView 7000 Mechanical Structure

ProView 7000 Enclosure

The ProView 7000 platform is housed in a 19" 1RU mount ready enclosure. See Figure 1-1. It includes fans for right to left air passage for side-to-side heat dissipation, the ProView 7000 may be installed in a rack without spacing between units. This allows increased flexibility for installation of a large number of units in limited space environments and integration with additional DVB equipment.

ProView 7000/7100 Front Panel

The front panel of the ProView 7000/7100 platform provides an interface to locally manage and operate the unit.

Figure 1-1: ProView 7000 Platform General View

Figure 1-2: ProView 7100 Platform General View

The front panel includes, a large LCD display for menus and statuses, four direction buttons, an <ENTER> key an <Esc> key and two F keys.

Two LEDs show the WARNING and PWR/FAIL statuses.

A two or four slot DVB-CI (DVB Common Interface/smart card interface) enables using up to two Conditional Access Modules (CAMs) for stream descrambling.

See Main Elements and Structure for a description of the front panel.

ProView 7000 Rear Panel

The rear panel of the ProView 7000 platform includes all of the required professional input and output connectors. The AC connector and power switch are also located on the rear panel as well as the GND lug for grounding the unit when installed in a rack. The rear panel is provided in various configurations as required for different applications. See Front End Card Features for a description of the ports and connectors.
ProView 7000 Management

The ProView 7000 Platform provides a wide range of methods for local and remote monitoring and management:

Front Panel Control
The ProView 7000/7100 front panel provides an easy to use management interface using the large LCD screen and intuitive controls.

Remote Element Management System (EMS)
The ProView 7000/7100 EMS provides an extensive GUI for managing the device over a LAN.

Network Management System
The ProView 7000/7100 platform provides monitoring access to Network Management Systems using its SNMP agent.

ProView 7000/7100 Redundancy
Use NMX management for redundancy to ensure continued service in the event that a device malfunctions. You can use a single or multiple backup ProView 7000/7100s to ensure continued service with a single or multiple primary ProView 7000/7100s. This feature is limited to the management of up to 2 output ports, ASI or SDI.

NOTE: The devices must be identical in hardware configuration, port structure and license.

See the Harmonic NMX Installation/Setup Guide for operating instructions.
Chapter 2
Quick Start

This chapter provides instructions for quick initial setup of the ProView 7000.

Topics:
- Installation and Cable Connection
- Switching On
- Configuring the IP Parameters
- Configuring and Monitoring

Installation and Cable Connection

Refer to the ProView 7000 Hardware Installation Guide for detailed information on installation and cable connection.

Installation

The ProView 7000 can be installed in a 19" rack using mounting slides.

Electrical Connection

The ProView 7000 is powered by an AC power supply.

Earthing

The earthing stud shall be permanently connected to protective earth in building installations. Permanent earthing connection shall be made first prior to all other connections and be disconnected last. Cable 18AWG should be used. When the unit is rack-mounted, the device’s earth lug must be connected to the rack housing, which must be correctly earthed.

Temperature

This equipment is intended for a maximum operating ambient temperature of 50 degrees Celsius.

Power

The maximum permitted load for RF In output is 0.35A.

Below are special instructions for Nordic countries:
- When installed in Finland, Norway, and Sweden, this unit shall be installed in a restricted access location, where equipotential bonding is provided.
- This unit is permitted for connection to Norwegian IT power systems.
In Norway and Sweden: Equipment connected to the protective earthing of the building installation through the mains connection or through other equipment with a connection to protective earthing and to a cable distribution system using coaxial cable, may in some circumstances create a fire hazard. Connection to a cable distribution system must be provided through a device providing electrical isolation below a certain frequency range (galvanic isolator, see EN 60728-11).

Translation in Norwegian: “Utstyr som er koplet til beskyttelsesjord via nettplugg og/eller via annet jordtilkoplet utstyr – og er tilkoplet et kabel-TV nett, kan forårsake brannfare. For å unngå dette skal det ved tilkoping av utstyret til kabel-TV nettet installerer en galvanisk isolator mellom utstyret og kabel-TV nettet.”

Translation in Swedish: “Utrustning som är kopplad till skyddsjord via jordat väg接tag och/eller via annan utrustning och samtidigt är kopplad till kabel-TV nät kan i vissa fall medföra risk för brand. För att undvika detta skall vid anslutning av utrustningen till kabel-TV nät galvanisk isolator finnas mellan utrustningen och kabel-TV nätet.”

For installation in Norway see EN 60728-11:2010 standard.

Cable Connections

Connect the remaining cables:
- DVB-S/S2
- ASI
- DS-3 (optional)
- LAN
- Video output
- Video monitor

Switching On

Switch the unit on with the rear power switch.

Once the boot process is completed (after 2-3 minutes) the Status OK message displays on the front panel LCD.

Configuring the IP Parameters

To configure the IP parameters of a ProView 7000:
1. Press <ENTER> on the keypad.
   The root menu displays.
2. Navigate **Unit > Management Port > IP Configuration**.

![IP Configuration](image)

3. Set the IP Address, Subnet Mask and Default Gateway for the port.

4. After any change in the IP configuration, the **Apply port changes** item is added to the **IP Configuration** sub-menu to allow confirmation of the port setup.

5. Select **Apply port changes**.

6. Select **Apply Changes**.

### Configuring and Monitoring

You can configure the ProView 7000 using the front panel or remotely using EMS over the LAN.

The ProView 7000 EMS application provides a GUI for easy remote management of ProView 7000s. For EMS system requirements see **EMS System Requirements** on page 72.

To configure the ProView 7000 using the front panel, see **Front Panel Overview** on page 35 and **Device Configuring Using the Front Panel** on page 39.

To monitor the ProView 7000 using the front panel, see **Monitoring Using the Front Panel** on page 67.

To configure the ProView 7000 using EMS, see **Remote Management using EMS** on page 71 and **Device Configuring Using EMS** on page 83.

To monitor the ProView 7000 using EMS, see **Monitoring using EMS** on page 186.

Related topics:

- **A Typical ProView 7000 Configuration Using the Front Panel**
- **EMS Initial Setup**
- **A Typical ProView 7000 Configuration Using EMS**

### A Typical ProView 7000 Configuration Using the Front Panel

The ProView 7000 has four logical multiplexes. A license is required for using more than one multiplex. Some hardware configurations support up to four satellite RF inputs.

The basic order of configuring the ProView 7000 is:

1. Configure a DVB-S/S2 input port.
2. Descramble selection – Associate a CAM slot to a multiplex in port and enable descrambling mode.
3. DVB-S/S2 Input Port association – The **DVB-S/S2 In Ports** are associated by default to multiplex ins according to their index numbers (1-4), therefore **DVB-S/S2 In Port 1** is associated to **DVB Multiplex In 1**. You can associate different ports or additional ports to **Multiplex Ins**.
4. Stream and Program Routing – Associate input streams to device outputs.
5. Select programs for descrambling.
6. Decoder configuration.

To configure the ProView 7000 using the Front Panel:

1. If the input stream is received from a satellite, navigate Root > Reception > SAT (no.) > Configuration and configure the receiver parameters according to your satellite parameters, see Configuring the DVB-S/S2 Input Port Properties for details.

2. If the input stream is received from IP, perform the following to configure the GbE port:
   a. Navigate Root > GbE > GbE Port (1 or 2) > IP Configuration.
   b. Configure IP Address and Subnet Mask.
   c. Select Apply Port Changes.
   d. Select Apply Changes.
   e. Navigate Root > GbE > GbE Port (1 or 2) > Admin Status.
   f. Set Admin Status to Up.
   g. Navigate Root > GbE > Socket Configuration > Socket In > Socket (no.) > Traffic Parameters.
   h. Configure IP Address Type, UDP Port and IP Address if you are using Multicast.
   i. Navigate Root > GbE > Socket Configuration > Socket In > Socket (no.).
   j. Configure Socket De-Jittering Mode, SSM and Socket Admin Status.

3. If the output stream is sent to IP, perform the following to configure the GbE port:
   a. Navigate Root > GbE > GbE Port (1 or 2) > IP Configuration.
   b. Configure IP Address, Subnet Mask and Default Gateway.
   c. Select Apply Port Changes.
   d. Select Apply Changes.
   e. Navigate Root > GbE > GbE Port (1 or 2) > Admin Status.
   f. Set Admin Status to Up.
   g. Navigate Root > GbE > Socket Configuration > Socket Out > Socket (no.).
   h. Configure Destination IP Address and Destination UDP Port.
   i. Set Socket Status to Up.

4. If you wish to descramble, you must associate the CAM to the multiplex:
   b. Select a multiplex, TS1, TS2, TS3 or TS4.

   The descrambling mode default is Selective, you can change the mode to Full.

5. To access the CAM MMI menu, select CAM MMI.

6. Select a DVB-S/S2 input port:
   a. Navigate Root > Routing and Descrambling > TS (no.) > Input Selection.
   b. Select an input port for the received transport stream (Options are: SAT (1-4), ASI (1-4)).

7. Select Input Type, (Options are: MPEG and DVB). This also sets the respective PSI/SI tables for the output stream.
NOTE: The default option for stream type is DVB. For ATSC systems, set the stream type to MPEG.

8. To configure the multiplex output:
   a. Navigate Root > Routing and Descrambling > TS (no.) > Output Selection.
   b. Select one or more outputs for the received transport stream (Options are: ASI (1-2), Socket (1-4)). The four sockets are virtual and must be associated to a physical GbE port.
   c. Select Enable in each output sub-menu that you select.

   NOTE: In this mode, stream information is not processed and output bitrate is identical to input bitrate.

   d. Navigate Root > Routing and Descrambling > TS (no.) > Activation.
   e. Select Enable.

9. To select a program for descrambling:
   a. Navigate Root > Routing and Descrambling > TS (no.) > Descrambling > Program Descrambling.
      A list of all input programs received displays.
      Program name, program ID, program type and program scrambling state display.
   b. Select a program for descrambling.
   c. Select CAM Selection.
   d. Select CAM 1, 2, 3 or 4 to associate the program to it.

   Repeat steps 6 to 9 for each multiplex that you wish to use (1-4).

    If you only have a single decoder then there is no Decoder (no.) menu.

11. Select a multiplex, 1, 2, 3 or 4, for input.

12. Set the Service Selection Mode:
    a. Navigate Root > Decoding > Decoder (no.) > Configuration > Service Selection Mode.
       If you only have a single decoder then there is no Decoder (no.) menu.
    b. Select Program Selection.
13. Navigate **Root > Decoding > Decoder (no.) > Configuration> Programs**.
If you only have a single decoder then there is no **Decoder (no.)** menu.

<table>
<thead>
<tr>
<th>Name</th>
<th>ID</th>
<th>Type</th>
<th>Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>1 BBC</td>
<td>4301</td>
<td>TV</td>
<td>CAS</td>
</tr>
<tr>
<td>2 CNN</td>
<td>4302</td>
<td>TV</td>
<td>CAS</td>
</tr>
<tr>
<td>3 IBA 2</td>
<td>4308</td>
<td>AUDIO</td>
<td>FTA</td>
</tr>
</tbody>
</table>

The **Programs** menu displays a list of programs available on the input transport stream and enables you to select the program to be decoded.

The screen displays the program name if the input stream provides an SDT table, the program ID (decimal number), the program type (TV or Radio) and the program mode (CAS/scrambled or FTA/free to air).

Only one program can be selected (radio button selection).

14. Navigate **Root > Decoding > Decoder (no.) > Configuration> Descrambling > CAM Selection**.
If you only have a single decoder then there is no Decoder (no.) menu.

15. Select the CAM slot.

**EMS Initial Setup**

Before you can manage a ProView 7000 remotely, you must configure the IP parameters, see **Configuring the IP Parameters** on page 22.

Topics:
- Installing EMS
- Launching EMS
- Adding a Device

**Installing EMS**

The ProView 7000 EMS is stored in the ProView 7000 for easy installation using a web browser.

To install the ProView 7000 EMS:
1. Run a web browser and enter the ProView 7000 IP address.
The initial ProView 7000 dialog displays.

**NOTE:** The EMS application is a Java-based program which requires Java Runtime Environment version 1.6. If needed, install Java Runtime Environment 1.6, using the link provided on the Java Web start page.

To check the ProView 7000 EMS Java version:

1. Run `cmd` in Windows.
2. Enter `Java -version` and press Enter to check which version is currently on your station. Update if necessary from the Java Web start page.

2. Click **Launch ProView 7000 EMS** on the ProView 7000 web page to install the EMS. Some browsers display a download dialog at the bottom of the browser tab, you must open this dialog.

**NOTE:** EMS is launched by Java Web Start.

If the following **Windows can't open this file** dialog displays, perform the following:

1. Select **Select a program from a list of installed programs**.
2. Click **OK**.
3. Click **Browse**.
4. Navigate `Java > jre<version> > bin > javaws`.
5. Click **Open**.
6. Click **OK**.
The EMS application installs. Shortcuts are added to the desktop.

**Launching EMS**

Prerequisites:

The device IP address must be configured using the ProView 7000 front panel, see Configuring the IP Parameters.

To launch the ProView 7000 EMS:

- Double-click the Harmonic ProView 7000 EMS launch icon to launch EMS.
  The EMS GUI displays.

**Adding a Device**

The IP Address is the same one you configured in Configuring the IP Parameters on page 22. For details on user names and passwords see Log-In / Log-Out Control of the Device on page 166 and Device Users’ Access Properties on page 180.

To add a device:

1. Click Add Device on the EMS toolbar
   —or—
Select Administration > Add ProView 7000.

The EMS displays the Add ProView 7000 Device dialog.

2. Enter a name for the new ProView 7000 device.

3. Enter the IP Address of the new ProView 7000 device.

4. For automatic connection when launching the EMS, mark the Connect Device check box.

5. Click Add.

The Log In dialog displays.

6. Select a user name from the list, configure or monitor, the password is the same as the user name by default.

The device connects automatically.

If the device fails to connect, perform the following:

a. Right-click the device icon in the Devices box and select Ping in the device context menu.

b. Click Ping in the Ping dialog box.

c. If the ping fails, check your network connections and settings.

d. Right-click the device icon in the Devices box and select Connect in the device context menu.
A Typical ProView 7000 Configuration Using EMS

The ProView 7000 has four logical multiplexes. A license is required for using more than one multiplex. Some hardware configurations support up to four satellite RF inputs. All ProView 7000s have 2 GbE data ports.

The EMS enables building your own decoded output stream, by selecting specific elementary stream from a program. Drag and drop the ES icon from the input program branch onto the Output decoding icon. The ES Decoding Properties property sheet displays, allowing you to set the relevant parameters. Do not use ESs from different programs.

TIP: Descrambling Set-Up TIP:
When setting a program or an ES for decoding, the decoder properties menu enables the user to descramble the program and to select the CAM slot for the descrambling process.
For a detailed description of the options provided by the Decoding Channel property sheet see Decoding Channel Properties.

The basic order of configuring the ProView 7000 is:
1. Configure a DVB-S/S2 input port.
2. Descramble selection – The CAM Slot Properties property sheet monitors and manages the selected CAM slot element. It enables you to associate a CAM slot to a multiplex in port and enable descrambling mode.
3. Descrambling a Program – Select individual programs to descramble.
4. Input Port association – The DVB-S/S2 In ports in the Physical Input box are associated by default to multiplex ins in the Multiplex Input box according to their index numbers (1–4), therefore DVB-S/S2 In Port 1 is associated to DVB Multiplex In 1. You can associate different ports or additional ports to Multiplex Ins.

NOTE: If the input is MPEG then change the table extraction of either a multiplex in or a multiplex out to PSI Only before you associate the respective multiplex, see Multiplex In Port Properties and Multiplex Output Properties.

5. Stream and Program Routing – Drag-and-drop routing of input streams to device outputs.
6. Decoder Configuration.

To configure the ProView 7000 using EMS:
1. If the input stream is received from satellite, perform the following to display and configure a DVB-S/S2 input port:
   a. Expand the device tree in the Physical Input box to reveal the DVB in ports.
   b. Select the required DVB-S/S2 in port icon in the Physical Input box.
   c. Click Properties on the EMS toolbar.
d. Click **Show Status** in the bottom left corner of the properties property sheet.

The displayed properties are divided into two sections; the section on the left displays editable properties and the section on the right provides informative/status properties that cannot be edited by the EMS user.

e. Configure the properties in the left section and click **Apply**.

2. If the input stream is received from IP, perform the following to display and configure the GbE port:
   a. Select the device in the Devices box.
   b. Expand the device tree in the Physical Input box to reveal the GbE ports.
   c. Select the required GbE port icon in the Physical Input box.
   d. Click **Properties** on the EMS toolbar.
   e. Configure the GbE port, see **GbE Ports for Input** for details.
   f. Select a socket in the GbE branch in the Physical Input box.
   g. Click **Properties** on the EMS toolbar.
   h. Configure the socket, see **GbE Port Properties** for details.

3. If the output stream is sent to IP, perform the following to configure the GbE port:
   a. Select the device in the Devices box.
   b. Expand the device tree in the Physical Output box to reveal the GbE ports.
   c. Select the required GbE port icon in the Physical Output box.
   d. Click **Properties** on the EMS toolbar.
   e. Configure the GbE port, see **GbE Ports for Input** for details.
   f. Select a socket in the GbE branch in the Physical Output box.
   g. Click **Properties** on the EMS toolbar.
   h. Configure the socket, see **GbE Port Properties** for details.

4. To associate a multiplex in port to a CAM Slot:
   a. Select the required CAM Slot name in the Physical Input box.
b. Click **Properties** on the EMS toolbar.

The property sheet displays with the programs descrambled by the slot.

![Property Sheet](image)

c. Select a multiplex in port to connect to the CAM slot.

5. To descramble a program:
   a. Right-click a program in the **Multiplex, Transcoding & Decoding Output** box.
   b. Select **Properties**.

The Program Properties property sheet displays.

c. Mark the **Descramble with** check box.

d. Select a CAM slot.

e. Click **Apply**.

6. To associate a different port or additional ports to a Multiplex In:
   a. Drag a Port from the **Physical Input** box to a **Multiplex In** in the **Multiplex Input** box.

![Association](image)

A confirmation dialog displays.

b. Click **Yes** to create the association.
7. To cross-connect an input transport stream, a program, an EMM in a conditional access table (CAT) or even an unreferenced PID:
   a. Drag the item from the **Multiplex Input** box and drop it into the **Multiplex, Transcoding & Decoding Output** box.

   The Cross-Connect configuration property sheet displays for you to configure the parameters of the routed element.
   b. Configure the desired parameters and click **Create** to create the cross-connect.

8. To decode a program:
   a. Drag the program name from the **Multiplex Input** box and drop it on a decoding channel in the **Multiplex, Transcoding & Decoding Output** box.
The Decoder Channel Properties property sheet displays.

b. Configure the desired parameters or accept the defaults.
c. Click **OK** to confirm the decoding set-up.
Chapter 3
Front Panel Overview

The front panel of the ProView 7000 multifunctional receiver platform provides a managing interface for local monitoring and configuring the operation of the ProView 7000 unit. This chapter describes the operation of the front panel interface.

Topics:
- Main Elements and Structure
- Front Panel Display

Main Elements and Structure

The ProView 7100 and ProView 7000 front panels display information regarding the input streams and output streams and to perform basic operations. Figure 3–2 and Figure 3–1 illustrate the front panels.

**Figure 3–1: ProView 7100 front panel**

**Figure 3–2: ProView 7000 front panel**
The ProView 7100 and ProView 7000 front panels comprise the following:

- **Large LCD display** - The large LCD display provides enhanced menus with graphical interface such as charts, radio buttons, tables and icons.
- **Warning and Pwr/Fail indicators** - LED status indicators.
- **Arrow keys** - Use the four direction arrow keys to navigate the menu items. Use the up and down arrow keys to select characters for parameters.
- **<ENTER>** - Use the <ENTER> key to approve selections and set-ups.
- **<Esc>** - Use the <Esc> key to revert selections and set-ups.
- **Function Keys** - The <F1> key lists the decoder services and the <F2> key displays the satellite status report.
- **Alphanumeric keypad** (ProView 7100 only) - Use this keypad to enter digits and hexadecimal letters. Hold the <Shift> key to enter blue characters. Use the <Clr> key without <Shift>.
- **Up to four DVB-CI slots** - Enables you to use up to four Conditional Access Modules (CAMs) for stream descrambling.

**Front Panel Display**

The ProView 7000 front panel display has four types of pages:

- Menu
- Parameter
- Edit value
- Radio select

The front panel screen can display up to four items at a time. Additional items can be accessed using the <up> and <down> arrow keys. To differentiate between the visible and hidden menu items, two types of screen figures are used in the manual; the dark grey (or green) displays the first four visible items, an up-and-down icon ( ) and a light grey screen holding all the additional hidden items.

The following paragraphs describe the various front panel screen page types and how to use them in menu navigation and managing the device features.

**Menu Pages**

Menu pages display sub-menus and menu items.
Use the <up> and <down> arrow keys to move between the branches of the tree and press <ENTER> to select and display the next lower level in the menu tree.

The front panel root menu of the ProView 7000 is a simple menu screen.

To display the ProView 7000 root menu:

- Press <ENTER> on the front panel default page.

See Appendix F, Front Panel Menu Tree for a diagram of the front panel menu tree.

**Parameter Pages**

The parameter pages display the parameters of the element in the menu tree. They comprise on the left side, a list of the parameter names and on the right side, parameter values. Editable parameters have a pencil icon next to them. Parameters without the pencil icon are read-only.

![Configuration](Configuration.png)

Use the <up> and <down> arrow keys to move between the parameters and press <ENTER> to select an editable parameter to set-up. After pressing <ENTER>, an Edit Value or a Select Value Screen is displayed to configure new values for the parameter.

**Edit Value Pages**

Use Edit Value pages to edit parameter values. The parameter value can be a number or a string.

![Universal](Universal.png)

Use the <left> and <right> arrow keys to select a digit and the <up> and <down> arrow keys to change the value of the parameter. On the ProView 7100 you can enter values using the alphanumeric keypad. Press <ENTER> to confirm the change or <ESC> to revert to the original value.
Radio Select Pages

Radio select pages display a list of items for selection (⊙ = currently active, ⊙ = currently inactive):

![Modulation Standard](image)

Use the <up> and <down> arrow keys to move between the items and press <ENTER> to select the required option. After pressing <ENTER>, the selected option is activated.
Chapter 4
Device Configuring Using the Front Panel

Topics:
- Configuring the DVB-S/S2 Input Port Properties
- Configuring the DS-3 Input Port Properties
- Configuring the Decoding
- Routing and Descrambling
- Configuring the GbE Ports, Sockets and Routing Table
- CA Definitions
- Unit Menu
- Presets
- DMS

NOTE: If you make a change that can be controlled by DMS while being controlled by DMS, you can lose that change.

Configuring the DVB-S/S2 Input Port Properties

To configure the ProView 7000 reception parameters:
1. Navigate Root > Reception.
2. If your device has more than one demodulator, select a satellite input menu, SAT 1–4.
3. Select Configuration.

Each menu item displays a value setup page.

The Configuration menu comprises the following:

- **Universal/Wide Universal/Ku/C Band Frequency** (DVB-S and DVB-S2) - Sets the receiving frequency according to the satellite LNB transmitting frequency. The receiver controls the LNB band by sending a 22 kHz signal. When the signal is sent, the LNB uses its High Band Local Oscillator (L.O.). When the signal is not sent, the LNB uses its Low Band L.O.

  Two local oscillators exist, **Universal** and Universal Wide one for each band to leverage full spectrum.

  - **Universal Band** valid range:
    - 22 kHz Low tone range - 10,700,000 - 11,900,000 [kHz]
    - 22 kHz High tone range - 11,550,000 - 12,750,000 [kHz]
  - **Wide Universal Band** valid range:
    - 22 kHz Low tone range - 10,700,000 - 11,900,000 [kHz]
    - 22 kHz High tone range - 11,700,000 - 12,750,000 [kHz]
  - **Ku Band** valid range (22 kHz Low and High tone) - 9,500,000 - 14,000,000 [kHz]
  - **C Band** valid range (22 kHz Low and High tone) - 5,000,000 - 6,000,000 [kHz]

- **L Band Frequency** (DVB-S and DVB-S2) - Sets the L-band frequency
  Valid range – 950,000 to 21,150,000 [kHz].
 Configuring the DVB-S/S2 Input Port Properties

- **Symbol Rate** – DVB-S and DVB-S2. Sets the L-band symbol rate. Valid range – 1,000,000 – 45,000,000 [baud].

- **Modulator Standard** – DVB-S and DVB-S2. Selects the L-Band modulation standard. Options are:
  - DVB-S
  - DVB-S2
  - Automatic

- **MODCOD** – DVB-S and DVB-S2. Selects the modulation type and coding rate, according to the modulation standard selected.
  - **DVB-S** - Options are:
    - QPSK 1/2
    - QPSK 2/3
    - QPSK 3/4
    - QPSK 5/6
    - QPSK 7/8
    - Auto – Automatic selection of MODCOD
  - **DVB-S2** – Options are:
    - VCM\(^1\) – Variable Coding Modulation format / Automatic\(^1\)
    - QPSK 1/4\(^1\)
    - QPSK 1/3\(^1\)
    - QPSK 2/5\(^1\)
    - QPSK 1/2
    - QPSK 3/5
    - QPSK 2/3
    - QPSK 3/4
    - QPSK 4/5
    - QPSK 5/6
    - QPSK 8/9
    - QPSK 9/10
    - 8PSK 3/5
    - 8PSK 2/3
    - 8PSK 3/4
    - 8PSK 5/6
    - 8PSK 8/9
    - 8PSK 9/10
    - 16APSK 2/3\(^2\)
    - 16APSK 3/4\(^2\)
    - 16APSK 4/5\(^2\)

\(^1\) Only available with certain hardware configurations, see Front End Card Features.
\(^2\) A license is required for 16APSK modulation. Only available with certain hardware configurations, see Front End Card Features.
Configuring the DVB-S/S2 Input Port Properties

- 16APSK 5/6
- 16APSK 8/9
- 16APSK 9/10

- **Roll Off** - Selects the roll factor. DVB-S2 only. Options are:
  - Automatic
  - 20%
  - 25%
  - 35%

- **Pilot** - DVB-S2 only. The Pilot feature should only be on when the signal has Pilot symbols, otherwise the demodulator will not lock onto the signal. Options are:
  - Automatic
  - On
  - Off

- **Spectral Inversion** - DVB-S and DVB-S2. Selects the mode of operation for the spectral inversion function. Options are:
  - Automatic - Only in DVB-S and is the DVB-S default.
  - Normal - Default for DVB-S2.
  - Inverted

- **Frame Size** - DVB-S2 only. Selects the frame size. Options are:
  - Normal - 64,800 bits frame
  - Short - 16,200 bits frame

- **Scrambling Seed** - DVB-S2 only, sets the value for the physical layer scrambling seed. Valid Range - 0 – 262141.

- **Polarization** - DVB-S and DVB-S2. Selects the polarization of the antenna in the satellite LNB. Default is Off. Options are:
  - Vertical (13V)
  - Horizontal (18V)
  - Off

- **LNB Frequency Band** - DVB-S and DVB-S2. Selects the receiver frequency band according to the satellite Low Noise Block (LNB) transmitting frequency band. Options are:
  - Universal (Low: 9.75, High: 10.6)
  - Universal Wide (Low: 9.75, High: 10.75)
  - Ku Band
  - C Band

- **LO Frequency** - DVB-S2 only. Manages the Local Oscillator (LO) frequency, depending on the LNB LNB Frequency band selected:
  - Displays the Local Oscillator (LO) frequency for Universal and Universal Wide bands.
  - Enables setting the LO frequency for Ku band. Range 8.5 MHz – 13 MHz
  - Enables setting the LO frequency for C band. Range 5 MHz – 6 MHz

---

3. Only available with certain hardware configurations, see Front End Card Features.
Chapter 4 Device Configuring Using the Front Panel

Configuring the DS-3 Input Port Properties

- **22 kHz Tone** - DVB-S2 only. Selects the low of high frequency band to be used when receiving from an LNB configured to Universal and Universal Wide band. Options are:
  - **Low** (no tone, selects the 9.75 GHz band)
  - **High** (selects the 10.6 GHz or 10.75 GHz band)

  **NOTE:** When using Ku or C band, the 22 kHz function has no influence.

- **Acquisition Mode** - DVB-S and DVB-S2. Sets the frequency scanning span of the receiver when searching for the satellite carrier frequency (lock acquisition search range). Options are:
  - **Wide Search**
  - **Narrow Search**

  **NOTE:** Wide search is the normal operation mode of the receiver frequency acquisition scan. Narrow Search mode should be used when symbol rate of the input is lower than 5 Mbauds.

- **Frequency Drift Compensation** - Compensate for LNB frequency drift. With the single and quad demodulator boards it functions from 8 MBd and up. With the DVB-S/S2 demodulator board it functions from 5 MBd and up, see Front End Card Features for board details. Options are:
  - **On**
  - **Off**

- **Attenuation** - Internal attenuation for saturated signals (0 – 30 dB).

- **Gain** - Internal gain to improve signal strength.

- **ISI (Multiple Input Stream)** - Input Stream Identifier in hexadecimal. Use this parameter to select a specific transport stream from a multi-transport carrier.

- **Drop Erroneous Packets** - Use this parameter to instruct the demodulator not to pass any transport stream packets with errors. The default is to pass all TS packets.

**Configuring the DS-3 Input Port Properties**

**NOTE:** This option is only available when DS-3 is included in the hardware configuration.

To configure the ProView 7000 reception parameters:

1. Navigate **Root > Reception**.
2. Select **Configuration**.

Each menu item displays a value setup page.

The Configuration menu comprises the following:

- **Frame Format** - Sets the frame format for the input stream:
  - **Unframed**
  - **M13** (Default)
  - **C-Parity**

- **Packet Size** - Sets the packet size:

---

4. Only available with certain hardware configurations, see Front End Card Features.
Configuring the Decoding

The decoder type and modes of operation depend on the hardware configuration and are license dependent. The Decoding menu is enabled only when the required hardware is installed in the ProView 7000 device.

To configure the ProView 7000 decoding parameters:

- Navigate Root > Decoding > Decoder (no.) > Configuration.
  
  If you only have a single decoder then there is no Decoder (no.) menu.

The Decoding Configuration menu comprises:

- **Service Selection Mode** – (For details see Service Selection Mode)
- **Input Selection** – Select the transport stream (1-4).
- **Programs** – Displays a list of the programs available with IDs and PIDs enabling you to manually select PIDs or auto select PIDs for subtitling. (for details see Programs)
- **PID Selection** – This menu only displays when the Service Selection Mode is configured to PID Selection. Use this menu to select a PID.
  
  - PCR
  - Video
  - Audio
  - VBI
- **Descrambling** – This menu only displays when a CAM is mapped to a Multiplex Input and Service Selection Mode is not configured to No Decoding. Select the descrambling device for the modulated program. Options are:
  
  - Verimatrix
  - BISS
  - CAM 1
  - CAM 2
  - CAM 3
  - CAM 4
  - None
Redundancy – Sets up the decoder program redundancy (for details, see Redundancy Configuration).

Backup Source – Only when Redundancy Control is Input Redundancy or Alarms.

- Input Selection – Either one of the available Multiplex Inputs or None. When the None is selected and the switch to the backup program is triggered, the output will be muted.
- Input Program Number – The Input Program Number of the backup program.
- Descrambling – Use this feature to select the relevant CAM slot or BISS descrambling.
  - CAM Slot 1
  - CAM Slot 2
  - CAM Slot 3
  - CAM Slot 4
  - BISS
  - Verimatrix

Video – Sets up the video modulation parameters, depending on the video codecs and format (for details, see Video Configuration).

PCR – Selects the clock source for the decoded program and sets up the a/v sync parameters (for details, see PCR Configuration).

Audio1/2/3/4 – Sets up the audio decoding parameters for each one of the two audio channels in the program (for details, see Audio 1-4 Configuration).

SDI Groups – Sets up the VBI/VANC parameters for the various program related functions (for details, see SDI Groups).

VBI/VANC – Sets up the VBI/VANC parameters for the various program related functions (for details, see VBI/VANC Configuration).

DPI to GPI – Use this menu to configure alarms to switch GPI relays (for details see DPI to GPI).

OSD – Use this menu to configure the insertion of subtitles from VBI PIDs, (for details, see OSD)

Programs

Use the Programs sub-menu to display a list of the programs available at the multiplex input and select the program to be decoded. The screen provides the program name (if the input stream provides the SDT table), program identification (decimal number of the program number), the program type (TV or Radio) and the program mode (CAS/scrambled or FTA/free). Selecting a program deselects the previous one (radio button selection).

To access the Programs sub-menu:

- Navigate Root > Decoding > Decoder (no.) > Configuration > Programs.

To select a program for decoding:
1. Navigate to a program.
2. Press ENTER.
3. Press ENTER.

To display the PID list, descriptions, DVB subtitling and DPI mode for a program:
1. Navigate to a selected program.
2. Press ENTER.
Manual PID Selection

When the PID has no 59 descriptor you can manually select a PID for DVB subtitling.

To select a PID from the ES for DVB subtitling:
1. Navigate Root > Decoding > Configuration > Programs > {program} > DVB Subt.1 > PID.
2. Select a PID number.
3. Press ENTER.

The Programs menu comprises:
- {Programs}
  - PCR 1
  - Video 1
    - Auto
    - None
    - {PID number}
  - Audio 1
  - Audio 2
  - VBI 1
  - DVB Subt. 1
    - PID Selection
      - Auto
      - None
      - {PID number}
    - Preferred Language
    - Preferred Language

Service Selection Mode

Use the Service Selection Mode menu to select a service selection mode.

The Service Selection Mode menu comprises:
- Automatic Mode – Use this mode for the device to automatically decode the first program in the TS (first PAT).
- Input Program – Use this mode to set the decoder to manual program selection.
- PID Selection – Use this mode to set the decoder to manual PID selection.
- No Decoding – Use this mode to disable decoding.

Redundancy Configuration

Use the Redundancy Configuration to set up the Decoder Program Redundancy.

To access the Redundancy sub-menu:
- Navigate Root > Decoding > Decoder (no.) > Configuration > Redundancy.
- Redundancy Control – Options are:
  - Off (Default)
Chapter 4 Device Configuring Using the Front Panel

Configuring the Decoding

- **DMS** – Only displayed when the Service Redundancy is controlled by the DMS. In that case the DMS configuration decides what the active program is and no other fields are shown.
- **Alarms** – The selection of the active program is according to the configured Program Redundancy Scheme and the selected triggers.
- **Input Redundancy** – The active program is based on the active source port of the Multiplex Input of the primary program. When the Primary Source Port is active, the Primary program will be active. When the Backup Source Port is active, the decoder will decode the backup program.

  - **Redundancy Scheme** – Only when Redundancy Control is Alarms. Options are:
    - **Manual** – You can manually switch between the primary and the backup program.
    - **Manual Revert** – (Default when the Input Selection in the Backup Source is None) The device switches from the primary program to the backup program when the primary program fails on one of the redundancy triggers. You can revert from the backup program to the primary program manually.
    - **Automatic** – (Default when the Input Selection in the Backup Source is not None) The device switches to the backup program whenever the active program fails on one of the redundancy triggers. A switch back to the primary program occurs when the backup program contains errors.
  - **Pre-Descramble** – (Default is No) When Yes, the device will descramble the backup program while it is not active.
  - **Program Selection** – Primary or Backup depending on the actual status of the device.
  - **Triggers** – Only when Redundancy Control is Alarms
    - **No PCR Detected Alarm** – Yes (Default) or No.
    - **Video Decoding Failure Alarm** – Yes (Default) or No.

**Video Configuration**

Use the Video configuration menu to set up the decoded video stream output parameters for the modulated program.

To access the Video sub-menu:

- Navigate **Root > Decoding > Decoder (no.) > Configuration > Video**.

  - **Decoding Codec** – Selects the video decoding mode. Options are:
    - **Automatic**
    - **MPEG-2**
    - **H.264**
  - **Display Format** – Selects the video display format. Options are:
    - **SD**
    - **HD**
    - **Automatic Resolution**

**NOTE:** Changing the display format may take a few seconds. During this time the FP display freezes. The Aspect Ratio Conversion feature is performed if the aspect ratio of the video in the incoming transport stream is not the same as the configured aspect ratio for the output stream.

  - **HD Format** – This parameter only displays when the display format is HD.
    - **720p @ 50**
- 720p @ 59
- 720p @ 60
- 1080i @ 50
- 1080i @ 59
- 1080i @ 60

- **Analog Format 625**
  - PAL B/G
  - PAL D
  - PAL I
  - PAL N
  - French SECAM

- **Analog Format 525**
  - NTSC
  - PAL M

- **Aspect Ratio** - Selects the aspect ratio conversion for the output stream. To be performed if the incoming stream aspect ratio is not the same as the configured output aspect ratio. Options (related to selected aspect ratio):
  - 16:9 Aspect ratio
  - 4:3 Aspect ratio
  - Passthrough

- **Aspect Ratio 16x9 To 4x3** (conversion)
  - Center-Cut
  - Letterbox
  - Full Screen
  - AFD

- **Aspect Ratio 4x3 To 16x9** (conversion)
  - Center-Cut
  - Pillarbox (Side Bars)
  - Full Screen
  - AFD

- **Buffer Mode** - See Selecting Low Delay Mode for details on Low Delay. Options are:
  - Normal
  - Low Delay
  - GI Mode

The screen provides access for setting-up the following parameters:

- **Video Format** - Selects the video format. Options are:
  - 720p@50
  - 720p@59
  - 720p@60
  - 1080i@50
  - 1080i@59
  - 1080i@60
- **Aspect ratio Conversion** - Selects the aspect ratio conversion. Options are:
  - Center-cut
  - Pillarbox (Side-bars)
  - Full Screen.

### PCR Configuration

Use the **PCR Configuration** menu to set up the clock synchronization parameters for the modulated program.

The **PCR Configuration** menu provides the following options:

- **Clock Source** - Selects the clock source for the synchronization of the modulation of the audio and video streams in the program. You cannot change the clock source when A/V Sync is set to 5 ms. Options are:
  - Original PCR
  - Decoder Clock
  - Genlock<sup>5</sup>

- **A/V Sync** - Selects the audio to video synchronization parameter. Options are:
  - **Frame** - Select this parameter to limit the audio/video sync jitter to 1 frame.
  - **5 ms** - Select this parameter to limit the audio/video sync jitter to 5ms when the clock source is set to Original PCR.
  - **Off**

- **A/V Offset Compensation** - This menu only displays when A/V Sync is set to 5 ms. The range is -20 to 20 ms. The default is 0.

- **Genlock Type** - This menu only displays when Clock Source is set to Genlock. Use this menu to sync with the incoming signal. Options are:
  - **Analog** - Analog genlocking supports PAL B/G, NTSC, 720P (50, 59, 60 Hz), 1080i (50, 59, 60 Hz), and 1080p (50, 59, 60 Hz). The main output must be configured to match the format of the Genlock source. The configuration options are under the **Analog Genlock Configuration** menu.
  - **Digital** - Digital genlocking supports PAL B/G, NTSC, 720P (50, 59, 60 Hz) and 1080i (50, 59, 60 Hz). The main output must be configured to match the format of the Genlock source. The default is Digital.

- **Analog Genlock Configuration** - This menu only displays when Genlock Type is set to Analog. Options are:
  - **Horizontal Delay** - The range is 0 – 1728 in 37 ns or 27 MHz ticks. The default is 0.
  - **Vertical Delay** - The range is -7 – 6. The default is 0.
  - **SCH Phase Delay** - The range is 0° – 360°. The default is 0°.

### Audio 1-4 Configuration

Use the **Audio 1-4** configuration menus to set up the audio decoding parameters for the audio channels in the modulated program.

The **Audio Configuration** menu provides the following options:

- **Decoding Codec** - Selects the audio decoding mode. Options are:

---

<sup>5</sup> Only available with certain hardware configurations, see [Overview of Rear Panel Ports and Connectors](#).

©2015 Harmonic Inc. All rights reserved. 48 ProView 7000 Release 3.7, Rev. A
- **Automatic**
- **Musicam**
- **DD (AC-3) 2.0** – Dolby Digital 6 (AC-3)
- **DD (AC-3) PT** – Dolby Digital (AC-3) Passthrough
- **DD Plus (E-AC-3) 2.0** – Dolby Digital Plus (E-AC-3) (Audio 1 channel only with 2 audio board)
- **DD+ (E-AC-3) PT** – (Audio 1 channel only with 2 audio board)
- **HE AAC** – (Audio 1 channel only with 2 audio board)
- **AAC LC** – (Audio 1 channel only with 2 audio board)
- **Dolby E / PCM PT** – Dolby E / PCM Passthrough (Audio 2 channel only)

**NOTE:** Changing between audio Codecs takes up to one minute. During this time the FP display freezes.

- **Volume** – Sets the audio volume. Range: -63 to 0 dB
- **Delay** – Range: -128 to 128 dB
- **Mixer** – Selects the mixing L/R inputs to outputs. Options are:
  - **Stereo**
  - **Mono (Analog output only)**
  - **Both Right**
  - **Both Left**
- **AC-3 Downmixing** – Selects the mixing mode for the output. Options are:
  - **LoRo**
  - **LtRt**
- **AC-3 Operational Mode** – Selects the mode of operation for the Dolby processing. Options are:
  - **Line Out**
  - **RF Remod**
- **Digital Format** – Selects the audio format mode. When using Dolby Digital Passthrough, this parameter has no effect.
  - **Professional**
  - **Consumer**
  - **Follow the Input**

**SDI Groups**

Use the SDI tab to configure audio channels for SDI groups. Each group has four audio channels (pairs 1+2 and 3+4, referred to as two stereophonic-channels), see Figure 4-1. Once the group is selected, the user must select the stereophonic channel of the audio source.

**NOTE:** All four audios must be used on the SDI tab even if they have no input.

---

6. Dolby, Dolby E, Dolby Digital and Dolby Digital Plus are registered trademarks of Dolby Laboratories.
With two audio boards, Audio 1 is always the first pair of channels in a group and Audio 2 is always the second pair of channels in a group. Four audio board defaults are:

- Audio 1 – Group 1 Pair 1.
- Audio 2 – Group 1 Pair 2.
- Audio 3 – Group 2 Pair 1.
- Audio 4 – Group 2 Pair 2.

The menu comprises:

- Apply SDI Groups changes
  - Group 1 – There are four SDI groups to choose from. The default is Group 1.
    - Pair1 – Select N/A or Audio 1–4.
    - Pair2 – Select N/A or Audio 1–4.
  - Group 2
  - Group 3
  - Group 4

**VBI/VANC Configuration**

The VBI/VANC menu enables you to insert VBI/VANC data into the decoded video. You can insert several VANC datum items into the same line but you cannot insert several VBI items into the same line and you cannot insert VBI and VANC into the same location.

Each type has a sub-menu to configure the video source and insertion location. The sub-menus are:

- AMOL (Automatic Measurement Of Line-Ups)
Source: VBI ES

- **CC (Closed Captions)** (Default: Enabled)
  Source: Video ES

- **TVG (TV Guide)**
  Source: VBI ES

- **WSS (Wide Screen Signaling)**
  Sources:
  Decoder
  VBI ES
  Video ES
  WSS-AFD (when using AFD)

- **TTX (Teletext EBU)**
  Source: VBI ES
  - **VBI**
  - **ANC** – Standards:
    - SMPTE-2031
    - OP-47

- **VPS (Video Program System)**
  Source: VBI ES

- **VITS (Vertical Interval Test Signals)**
  Source: Decoder

- **VITC (Vertical Interval Time Code)**
  Sources:
  - **Decoder**
  - **VBI ES**
  - **Video ES**

- **VI/AFD (Video Index)**
  Sources:
  - **VBI ES**
  - **Video ES**

- **M422 (Monochrome 4:2:2)**
  Source: VBI ES

- **SCTE 104**
  Sources:
  - **DPI PID**
  - **ANC**
  - **AS Index**
  - **DPI PID Index**
DPI to GPI

Use this menu to configure SCTE 35 commands to toggle GPI relays for Digital Program Insertion. It comprises the following sub-menus:

- **Pre-Roll** – Use to configure the pre-roll.
- **OON Trigger GPI Port** – Use to configure the Out Of Network alarm switch.
- **RTN Trigger GPI Port** – Use to configure the Return to Network alarm switch.

OSD

Use this menu to configure the insertion of subtitles from VBI PIDs. It operates in Auto Mode and Program Mode in HD and SD.

- **Subtitling Type**
  - Disabled
  - DVB Subtitling – One PID is used per language. To manually select a PID see Programs.
  - VBI Teletext

- **DVB Subtitling** – This menu only displays after you select DVB Subtitling under the Subtitling Type menu
  - **PID**
    - Automatic
    - None
    - Preferred Language
  - **Preferred Language** – This menu only displays after you select Preferred Language under the PID menu

Routing and Descrambling

Use the Routing and Descrambling menu to configure input redundancy on a multiplex input, select physical input and output ports, redundancy triggers and input type.

Redundancy

Only one port is active while the other one is in standby mode, by default the **Primary Input** port is active and the **Backup Input** port is on standby. The port on stand by does not pass data. The Redundancy Triggers section is used to configure triggers that will switch to the Backup Port. The Seamless Redundancy mode doesn't require any triggers for switching between sources. While working in Seamless mode, the “Trigger Alarm” checkbox will be used to enable/disable the Alarms reporting. The default Redundancy Mode is **Off**.

To use Input Redundancy you must configure the **Primary Input** port and the **Backup Input** port. There are 7 modes:

- **Off**
- **Manual** – You can manually switch between the primary and the Backup Ports.
- **Manual Revert** – The device switches from the Primary Port to the Backup Port when the Primary Port fails on one of the redundancy triggers and the Backup Port has no active alarms. You can revert from the Backup Port to the Primary Port manually using the **Active Input menu**.
- **Automatic** – The device switches to the standby port whenever the active port fails on one of the redundancy triggers and the standby port has no active alarms.

- **Automatic Revert** – The device switches from the Primary Port to the Backup Port when the Primary Port fails on one of the redundancy triggers and the Backup Port has no active alarms. The device reverts to the primary as soon as the Primary Port has no active alarms.

- **Seamless** – If you have two equal streams, the device switches to the standby port whenever the active port fails, without loss of video packets. A maximum offset between the sources needs to be filled in. The Seamless option is only available with license.

- **External Control** – When DMS uses Disaster Recovery with a ProView 7000, the Redundancy Mode displays as *External Control* in the front panel because Disaster Recovery overrides redundancy.

You must enable at least one redundancy trigger under the **Redundancy Triggers** menu.

To configure the Routing and Descrambling parameters:

- Navigate **Root > Routing and Descrambling**.

The **Routing** menu has from 1 to 4 multiplexes\(^7\), namely:

- **TS1**
- **TS2**
- **TS3**
- **TS4**

You can use any multiplex for routing.

Each multiplex menu comprises the following sub-menus:

- **Activation**
  - **Enable** – Enable the multiplex and automatically create a TS cross connect to the corresponding multiplex out. If the corresponding multiplex out already has a program on it, it is removed. If the corresponding multiplex out already has a TS on it, the multiplex in cross connects with the first available multiplex out.
  - **Disable** – Only removes the TS cross connect from the multiplex out, the multiplex remains enabled.

- **Redundancy Mode**
  - **Off**
  - **Seamless** – When using Seamless, additional information and options will be presented:
    - **Sources Max Offset**
    - **Current Offset**
  - **Manual**
  - **Manual Revert**
  - **Automatic**
  - **Automatic Revert**

- **Primary Source** – Options are:
  - **Input Selection** – When using multiplex input port redundancy use this menu to select one of the following physical input ports for the primary input, Redundancy Mode must be set to any mode but Off:

---

7. A license is required for more than one multiplex.
Chapter 4 Device Configuring Using the Front Panel

Routing and Descrambling

- SAT 1
- SAT 2
- SAT 3
- SAT 4
- ASI 1
- ASI 2
- ASI 3
- ASI 4
- DS-3
- Socket 1
- Socket 2
- Socket 3
- Socket 4

- **T2MI** - Options are:
  - T2-MI Processing Mode - Options are:
    - None - (Default)
    - Pass - The device assumes that the transport stream is a T2-MI transport stream.
    - De-Framing - The device allocates a free de-framing engine.
  - Apply T2MI Settings

- **Multiplex-In De-Jittering** - See De-Jittering below for feature description. Options are:
  - De-Jittering Mode - Options are:
    - Enabled - Select to enable de-jittering.
    - Disabled - Select to disable de-jittering (Default).
  - Status - The device displays the current de-jitter status. See Table 4-1 for descriptions.

- **Backup Source** - Options are:

  - **Backup Input** - When using multiplex input port redundancy use this menu to select one of the following physical input ports for the backup input, Redundancy Mode must be set to any mode but Off:
    - SAT 1
    - SAT 2
    - SAT 3
    - SAT 4
    - ASI 1
    - ASI 2
    - ASI 3
    - ASI 4
    - DS-3
    - Socket 1
    - Socket 2

---

8. The number of RF satellite inputs depends on your hardware configuration.
- Socket 3
- Socket 4
- **T2MI** – Options are:
  - T2-MI Processing Mode – Options are:
    - None – (Default)
    - Pass – The device assumes that the transport stream is a T2-MI transport stream.
    - De-Framing – The device allocates a free de-framing engine.
  - Apply T2MI Settings
- **Multiplex-In De-Jittering** – See De-Jittering below for feature description. Options are:
  - De-jittering Mode – Options are:
    - Enabled – Select to enable de-jittering.
    - Disabled – Select to disable de-jittering (Default).
  - Status – The device displays the current de-jitter status. See Table 4–1 for descriptions.

**Input Selection** – This menu only displays when **Redundancy Mode** is set to Off. Use this menu to select one of the following physical input ports:
- SAT 1
- SAT 2
- SAT 3
- SAT 4
- ASI 1
- ASI 2
- ASI 3
- ASI 4
- DS-3
- Socket 1
- Socket 2
- Socket 3
- Socket 4
- None

**Output Selection** – This menu only displays when **Redundancy Mode** is set to Off. Use this menu to individually enable or disable the following physical outputs:
- ASI 1
- ASI 2
- ASI 3
- ASI 4
- Socket 1
- Socket 2
- Socket 3
- Socket 4

10. The number of RF satellite inputs depends on your hardware configuration.
11. ProView 7000. Depends on ASI BiDi configuration for ports 3 and 4 on ProView 7100.
12. ProView 7100 only, depends on ASI BiDi configuration for ports 3 and 4.
- **Descrambling**
  - **Program Descrambling** - Select a program and then select one of the following CAM options:
    - Verimatrix
    - BISS
    - CAM 1
    - CAM 2
    - CAM 3\(^{13}\)
    - CAM 4\(^{13}\)
    - None
  - **Bypass Embedded Descrambling** - Enable or disable (Default)

- **Output Bitrate** - Displays the calculated bitrate of the mux out. You can only configure the output bitrate when the MUX is not part of a TS cross-connection. Range 21 1000 – 160,000,000 bps, default 30,000,000 bps.

- **Redundancy Triggers**
  - **Sync Loss** - Enable (Default) or disable.
  - **CC Errors** - Enable (Default) or disable.
  - **PID Missing** - Enable (Default) or disable.
  - **Thresholds**
    - **Sync Loss**
      - Primary Duration - Set the period that the state must exist to trigger redundancy
      - Backup Duration - Set the period that the state must exist to trigger redundancy (Not available when Disaster Recovery is in process)
    - **CC Errors**
      - Primary Duration - Set the period that the number of CC errors must occur within to trigger redundancy
      - Primary Counter - Set the number of CC errors that must occur within a period to trigger redundancy
      - Backup Duration - Set the period that the number of CC errors must occur within to trigger redundancy (Not available when Disaster Recovery is in process)
      - Backup Counter - Set the number of CC errors that must occur within a period to trigger redundancy (Not available when Disaster Recovery is in process)
    - **PID Missing**
      - PID - Set the PID number
      - Primary Duration - Set the period that the PID must be missing for to trigger redundancy
      - Backup Duration - Set the period that the PID must be missing for to trigger redundancy

- **Input Type** - Use this menu to select the input type MPEG or DVB.

- **Transport Format** - Indicates whether the transport stream is an MPEG-2 TS or contains a T2-MI feed. This is crucial for the correct behavior of the CAM Automatic Recovery mechanism.

---

\(^{13}\) ProView 7100
Chapter 4 Device Configuring Using the Front Panel

Configuring the GbE Ports, Sockets and Routing Table

- MPEG2 TS - Indicates that the incoming stream is an MPEG-2 TS.
- T2MI - Indicates that the incoming stream is a T2-MI TS.

- DPI Filtering - Enables filtering on Event ID.
  - DPI Filtering status
  - Add Program

De-Framing

The ProView 7000 supports up to four (4) T2-MI de-framing engines. Each engine can extract one PLP out of a given T2-MI PID. The output is a CBR transport stream.

De-Jittering

The device supports up to four (4) general purpose de-jittering engines. This feature is only available on the ProView 7100. Each engine supports a bitrate of up to 54 Mbps. Only CBR TS is supported.

Table 4-1: De-Jittering Status

<table>
<thead>
<tr>
<th>Status</th>
<th>Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>OK</td>
<td>DJ is being performed</td>
</tr>
<tr>
<td>Off</td>
<td>Either the multiplex is in Admin Down or the multiplex is operating in no DJ mode</td>
</tr>
<tr>
<td>No PCR</td>
<td>No PCR has been detected.</td>
</tr>
<tr>
<td>Unsupported rate</td>
<td>The bitrate is not supported.</td>
</tr>
<tr>
<td>Illegal PCR Skew</td>
<td>Bigger than 31 PPM.</td>
</tr>
<tr>
<td>No stream detected</td>
<td>No stream is detected.</td>
</tr>
<tr>
<td>No MIP detected</td>
<td>Only applicable in SFN mode.</td>
</tr>
</tbody>
</table>

Configuring the GbE Ports, Sockets and Routing Table

Use the GbE menu to configure the GbE ports, MPE PID, sockets and routing table.

To access the GbE menu:
- Navigate Root > GbE.

The GbE menu has the following sub-menus:

- GbE Port 1/2 - Use these menus to configure the following:
  - IP Configuration - Use this menu to configure the following:
    - IP Address - The default is 127.127.0.X (X is the port number). Each port must have a unique IP address.
    - Subnet Mask - The default is 255.255.255.0.
    - Gateway - Output only. The default is 127.127.0.1.
  - MAC Address - Use this menu to view the MAC address for this port.
  - Admin Status - Use this menu to view or set the Admin Status to one of the following:
Configuring the GbE Ports, Sockets and Routing Table

- **Up** – Enable
- **Down** – Disable

If **Admin Status** is set to Up and no link is detected, a no link alarm is raised. The default is Down.

- **Auto Negotiation** – Use this menu to view the Auto Negotiation status or set it to one of the following:
  - **On** (Default)
  - **Off**

- **PHY Speed** – Use this menu to view the PHY speed. When Auto Negotiation is off you can change PHY Speed to one of the following:
  - **100**
  - **1000** (Default)

**Duplex Mode** – Only Full Duplex Mode is supported.

- **MPE**[^14] – Use the MPE menu to configure one MPE PID source for GbE out. There are three service selection modes, Program, PID and Disabled.

The **MPE** menu comprises the following sub-menus:

- **Mode**:
  - **Program** – Use this mode to configure an MPE PID by entering the program ID. The PID is configured automatically.
  - **PID** – Use this mode to configure an MPE PID by entering the PID.
  - **Disabled**

- **Input Port** – Use this menu to select the multiplex input.

- **Program Number** – This menu only displays in Program mode.

- **PID** – This menu only displays in PID mode.

- **Status**

- **Socket Configuration** – Use this menu to configure the 4 socket outs, namely:

  - **Socket 1**
  - **Socket 2**
  - **Socket 3**
  - **Socket 4**

All 4 sockets are associated to both IP ports. Use the **Socket In** menu for **GbE In** and the **Socket Out** menu for **GbE Out**. The sockets support IGMP v1, v2 and v3 and automatically detect the version.

In each socket menu you can configure the following (**Socket Out**):

- **Destination IP Address** – Only multicast IP addresses are supported. The default address is 255.1.1.X (X is the socket number).
- **Destination UDP Port** – The range is 0 – 65535. The default is 1000.
- **Encapsulation Mode**
- **Source UDP Port** – You don’t need to configure the UDP port for FEC. The range is 0 – 65535. The default is 1000.
- **Socket Status** – Up or Down

[^14]: Requires a license.
In each socket menu you can configure the following (Socket In):

- **Socket Admin Status** – Options are:
  - Up
  - Down

- **Traffic Parameters**
  - **IP Address Type** – Options are: Unicast, Multicast. The default is Multicast.
  - **IP Address** – (Only displays if IP Address Type is Multicast.) You can configure the same Destination IP Address and UDP Port for several sockets if you define the Source Specific Multicast and the Source IP Addresses are different. When the IP Address Type is Unicast, the ProView 7000 uses the active port IP address. When the IP Address Type is Multicast, you must enter the multicast IP address. The default is 238.1.1.X (X is the socket number).
  - **UDP Port** – The range is 0 – 65535. The default is 1000.

- **Socket De-Jittering Mode** – The default is Normal. Options are:
  - Low – Low Delay
  - Normal – Network jitter less than 50 msec.
  - High – Network jitter less than 300 msec.
  - SFN
  - T2-MI
  - None

- **Average Input Bitrate** – Input field that will be active when De-Jittering is enabled and the De-Jittering Mode is T2-MI or None. Value 1,000,000 - 160,000,000 bps. Default value for T2-MI is 40,000,000 and the Default for None is 160,000,000.

- **Socket De-Jittering Status** – The status messages are:
  - OK – DJ is being performed.
  - Off – Either the socket is in Admin Down or the socket is operating is in no De-Jitter mode.
  - No PCR – No PCR has been detected
  - Unsupported rate
  - Illegal PCR skew – Bigger than 31 PPM
  - No stream detected
  - No MIP Detected – Only applicable in SFN mode

- **SSM** – Options are:
  - Enable – You can configure one source IP address. Only packets with this source address are processed.
  - Disable – The device accepts all packets with destination IPs and ports that match the socket regardless of their source IP.

- **FEC** – You can enable FEC for each socket individually. The device automatically detects the size of the matrix, you don't need to configure it. The number of columns supported is 1 – 50. The number of rows supported is 4 – 50. Total matrix size is 256. Supported on ProView 7100 only.
  - None
  - 1 Dimension – Columns only.
  - 2 Dimensions – Columns and rows.

- **Reordering** – Enable Reordering when packets are RTP encapsulated to correct packet ordering. (ProView 7100 only.)
Chapter 4 Device Configuring Using the Front Panel

**CA Definitions**

- **Enable**
- **Disable**
- **NULL Insertion** – Enable to insert null packets in place of packets that cannot be corrected. (ProView 7100 only.) The default is Enable.
  - **Enable**
  - **Disable**

- **Active Port** – Use this menu to select the active port when the mode is set to In. The default is port 1.

- **Redundancy** – Use the Redundancy menu to manage GbE PHY redundancy. GbE Port 1 is always the Primary Port. GbE Port 2 is always the Backup Port. The Primary Port (GbE Port 1) is the active port and the Backup Port is the standby port by default.

  There are 4 modes:
  - **Manual** – You can manually switch between the Primary Port and the Backup Port regardless of their link status.
  - **Manual Revert** – The device switches from the Primary Port to the Backup Port when the Primary Port fails on one of the redundancy triggers and the Backup Port has no active alarms. You can revert from the Backup Port to the Primary Port manually.
  - **Automatic** – The device switches to the standby port whenever the active port fails on one of the redundancy triggers and the standby port has no active alarms.
  - **Automatic Revert** – The device switches from the Primary Port to the Backup Port when the Primary Port fails on one of the redundancy triggers and the Backup Port has no active alarms. The device reverts to the primary as soon as the Primary Port has no active alarms.

- **Routing Table** – Use the **Routing Table** menu to manage up to five routing destinations for GbE input when the IP address is on a different network. The **Routing Table** menu comprises 5 entry sub-menus.

  In each Entry sub-menu you can configure the following:
  - **Destination Type** – Options are:
    - **Network**
    - **Host**
  - **IP Address**
  - **Subnet Mask**
  - **Gateway** – Enter the GbE IP address that corresponds to the GbE port selected under **Interface**.
  - **Interface** – Options are:
    - **GbE 1**
    - **GbE 2**

**CA Definitions**

Use the **CA Definitions** menu to configure Verimatrix, BISS and associate multiplexes to CAMs and select individual programs.

To access the **CA Definitions** menu:
- Navigate **Root > CA Definitions**.

The **CA Definitions** menu comprises configuration sub menus.
Verimatrix

The Verimatrix sub-menu displays Verimatrix information.

Sub menus:
- VSC ID – Displays the virtual smart card identity.
- Lib SW Version – Displays the Verimatrix software version.

BISS

Use the BISS sub-menu to define BISS keys or to clear BISS keys.

Sub menus:
- Key Configuration
  - Key 1-10
    - Description
    - Mode
      - BISS-1
      - BISS-E Buried ID
      - BISS-E Injected ID
    - SW (BISS-1 only)
    - ESW (Injected E or Buried E)
    - ID (Injected E only).
    - Clear

CAM 1-4 Sub Menus

The CAM slot sub-menus each comprise:
- CAM Association – Use to associate the CAM slot with a multiplex in.
- Max CAM Bitrate – 72 or 96 Mbps depending on hardware configuration. The default is 72.
- CAM De-Jittering – Enable or disable.
- Automatic Recovery Policy – Use to configure the ProView 7000 to reset the CAM when one of the following alarms is raised:
  - CAM Descrambling Failure
  - CAM Processing Failure
  - Packet Loss after Descrambling
- CAM MMI – Use to access the MMI (Man Machine Interface).

CAM Association

To associate a CAM with a multiplex:
1. Navigate Root > CA Definitions > CAM (1-4).
2. Select CAM Association.
3. Select a multiplex, TS1, TS2, TS3 or TS4.

Selecting All Elementary Streams

To select all elementary streams for configuring:
1. Navigate Root > CA Definitions > CAM (1-4) > Descrambling Mode.
2. Select Full.

**Configuring Only Relevant Elementary Streams**

The descrambling mode default is Selective.

To set the CAM to Selective mode to configure only relevant elementary streams:
1. Navigate Root > CA Definitions > CAM (1-4) > Descrambling Mode.
2. Select Full.

**Accessing the CAM MMI Menu**

To access the CAM MMI menu:
- Navigate Root > CA Definitions > CAM (1-4) > CAM MMI.

**Unit Menu**

Use the following Unit menu items to configure and monitor ProView 7000s:
- Management Port Menu
- SW Version Menu
- HW Inventory Menu
- Date/Time Menu
- Set Active Version
- License
- BOOTP Menu
- LCD Contrast Menu
- GPI Menu
- Reset Unit Menu
- Restore to Defaults Menu

**Management Port Menu**

Use the Management Port menu to configure the management port.

To access the Management Port menu:
- Navigate Root > Unit > Management Port.

Each option in the menu leads to value setup screen (i.e., selecting the option displays either an edit value screen - to set a new value or a select value screen with radio button options).

The Management Port configuration menu provides the following options:
- **IP Configuration** – Manages the IP configuration of the GbE port. The sub-menu manages the following parameters:
  - **IP Address** – Sets the IP address of the port.
  - **Subnet mask** – Sets the network subnet mask address for the port.
**Default Gateway** - Sets the network default gateway address. This is the address of a local IP router on the same network as the ProView 7000, which is used to forward traffic beyond the local network.

- **MAC Address** – Displays the media access control (MAC) address for the device.
- **Auto Negotiation** – Activates the port auto negotiation capability. Radio Button options are: On and Off (Selection is not enabled. Always On).
- **PHY Speed** – Selects the physical layer speed. Radio Button options are: 100 and 1000 [Mbps] (Selection is not enabled. Set to 100 Mbps).

**SW Version Menu**

Use the **SW Version** menu to display the current version of the ProView 7000 software.

**HW Inventory Menu**

Use the **HW Inventory** menu to display the part and version numbers of hardware modules installed in the unit.

To access the **HW Inventory** menu:
- Navigate Root > Unit > HW Inventory.

The **Hardware Inventory** sub-menu contains the following items:

- **Device Model** – The Device Model sub-menu displays the device model.
- **Platform** – The Platform properties sub-menu displays the following information:
  - Part Number
  - Serial number
- **Main Board** – The Main Board properties sub-menu displays the following information:
  - Part Number
  - Hardware Revision
  - Serial Number
  - Main FPGA Version
  - Auxiliary FPGA Version
- **Front End Card** – The Front End Card properties sub-menu displays the following information on the front end unit installed in the device:
  - Part Number
  - Hardware Revision
  - Serial Number
  - FPGA Version
  - DVB-S2 Demodulator Version
  - DVB-S Demodulator Version
- **Top Options Card** – The Top Options Card properties sub-menu displays the following information:
  - Part Number
  - Hardware Revision

---

15. Demodulator not shown if DS-3 is installed.
Serial Number
Decoder SW Version

- **Bottom Option Card** – The **Bottom Option Card** properties sub-menu displays the following information:
  - Part Number
  - Hardware Revision
  - Serial Number
  - Decoder SW Version

**NOTE:** The Top Card and/or Bottom Card information is displayed only when the respective optional card is installed.

## Date/Time Menu

You can view or configure the current date and time using the front panel or the unit can synchronize its clock with an NTP server using SNTP/NTP v2 or v3.

The **Date/Time** menu comprises:

- **Date**
- **Time**
- **NTP**

NTP is disabled by default.

## Set Active Version

The ProView 7000 keeps the current and last software versions. The EMS enables you to choose the active software version. The process of changing the active software version takes several minutes and requires a reboot.

To change the device software version:
1. Navigate **Root > Unit Set Active Version**.
2. Select the second version and press **Enter**.
3. Press **Enter**.

## License

Use this menu to display the ProView 7000 licenses.

## BOOTP Menu

Use to enable BOOTP software to update the unit.

## LCD Contrast Menu

Use to set the front panel LCD contrast. You can use the up and down arrow buttons or enter a value (ProView 7100). Valid range is 01 - 31, where 1 is lowest and 31 is highest contrast.

## GPI Menu

Use the **GPI** menu to configure alarms to toggle GPI relays for any automation system on-site or to manually switch relays. It comprises the following sub-menus:
■ **Mode** – There are three modes for each GPI relay, namely:
  - **On** – Use this mode to manually switch the relay on.
  - **Off** – Use this mode to manually switch the relay off, this is the default.
  - **Alarms** – Use this mode to select individual alarms to toggle the relay.

■ **Alarm Triggers** – List of alarms to enable for the Alarms mode.

**Reset Unit Menu**

Use to perform a warm reset on the ProView 7000.
Selecting the Reset Device option, starts a three step procedure which, when completed, reboots the device.

**Restore to Defaults Menu**

Use this menu to restore the default configuration. IP management addresses are not changed.

**Presets**

Use the **Presets** menu to create several configurations. If you use several satellites, you can save each satellite configuration as a preset. The first time you use it, there is only one menu item, namely **Create**, as there are no presets yet.

To display the **Presets** menu:
- Navigate **Root > Presets**.

After you create a configuration more menu items display, the full menu list comprises:

■ **Activate** – Select a preset to activate. Activation reboots the device.

■ **Create** – Once you have created one preset, there are 2 menu options:
  - **Overwrite a Preset** – You can overwrite a preset.
  - **New Preset** – You can save the current configuration as a preset. Use the four direction buttons to enter a preset name. The name length limit is 32 characters. You can save up to 20 different presets.

■ **Delete** – Select the preset to delete.

■ **Rename** – Select a preset to rename.

■ **Delete All** – You can delete all the presets.

**DMS**

Use the **DMS** menu to display the DMS status properties. The **DMS** menu comprises:

■ **Authorized Programs** – Displays the list of programs authorized by DMS.

■ Blacked Out Programs – Displays the list of programs blacked-out by DMS.

■ **Disaster recovery**
  - **DMS ID**
  - **DMS Name**
  - **Status**
  - **Abort** – Use the Abort button to abort the scan.
- **DMS EMMs Statistics** - Displays EMM control statistics.

To display the DMS menu:
- Navigate **Root > DMS**.
Chapter 5
Monitoring Using the Front Panel

Topics:
- Device Monitoring
- Monitoring the DVB-S/S2 Input Port Properties
- Monitoring the Decoding

Device Monitoring

How to monitor the correct operation of the ProView 7000 device.

Related topics:
- Status OK
- Alarms
- DMS

Status OK

When there are no alarms the message STATUS OK displays on the LCD and the two front panel LEDs are green.

The following program information displays on the LCD:
- The DVB program selected when SDT is received with the following, name, ID, type and scrambling status.
- The MPEG service selected with the ID and scrambling status.
- Status of DMS connection. See DMS.

Video picture displays on the monitor.
Audio channels left and right give correct sound, synchronized to the displayed picture.

Alarms

Alarms alert the user to conditions that may require attention. The LCD and Warning LED is used to indicate alarms. The Warning LED on the front panel changes color according to the highest alarm severity, red, orange or yellow. Red is the highest severity.

Concerning multiplex input redundancy, alarms on the backup source port of a multiplex in port display if the relevant redundancy trigger is enabled and the threshold matches the Redundancy Triggers configuration, see Routing and Descrambling.
Home Screen

The active alarm count and the number of alarms at highest severity display on the home screen of the LCD. Alarm details display on the Alarms Table menu.

Alarms Table

The Alarms Table displays all the active alarm messages raised on the ProView 7000. The alarm severity level, a brief description and the time the alarm was triggered display.

The Alarm detailed screen provides the following information:

- The Alarm brief description
- The Alarm severity level and the full date and time the alarm was triggered
- A detailed description of the alarm
- Suggested corrective action option – Select this option to display suggested corrective action

See Appendix G, ProView 7000 Alarm List for the alarm list with corrective actions.

To read the alarm messages:
1. Navigate **Root > Alarms Table**.

2. Select an alarm from the list to display its details.

### Active Alarms (1)
- **Major** (1)

### ID: 4301 TV CAS
- **No Service Selected**

<table>
<thead>
<tr>
<th>Severity</th>
<th>Alarm</th>
<th>Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Link down</td>
<td>22:58</td>
</tr>
<tr>
<td>2</td>
<td>Critical Voltage Error</td>
<td></td>
</tr>
</tbody>
</table>

**BBC**

**Active Alarms (1)**

**Major (1)**

**ID: 4301 TV CAS**

**No Service Selected**
The device indicates in the bottom row of its idle screen one of the following:

- Disaster Recovery Active
- Locked to Alternative
- Blackout is Active
- SW Pending Activation
- Controlled by XX DMS
- Connected to XX DMS

Monitoring the DVB-S/S2 Input Port Properties

To monitor the ProView 7000 reception parameters:

1. Navigate Root > Reception.
2. If your device has more than one demodulator, select a satellite input menu, SAT 1–4.
3. Select Status.

The reception status displays whether the physical port is connected or not to the DVB Multiplex In.

**NOTE:** Some of the parameters apply to DVB-S or DVB-S2 modes only. They are displayed according to the mode used.

The Status menu comprises the following:

- **C/N** - Displays the measured carrier to noise ratio [dBc]
- **Eb/N0** - Displays the measured energy per bit to noise power spectral density ratio [dB]
- **Link Margin** - Displays the measured link margin level [dB]
- **BER** - DVB-S only. Display the bit error rate detected.
- **PER Value** - DVB-S2 only. Display the packet error rate detected. The BER/PER error rate is a decimal number x 10^-X (therefore, a.b E-X).
- **Carrier Locked** - Displays the carrier locking status: Locked (Yes) / Unlocked (No)
- **Demodulator Locked** - Displays the demodulator locking status: Locked (Yes) / Unlocked (No)
- **Tuned Frequency** - Displays the reception tuned frequency [MHz]
- **Frequency Offset** - Displays the reception frequency offset from configured frequency [MHz]
- **Spectral Inversion** - Displays the spectral inversion function operational status. Options are:
  - Normal
  - Inverted
- **Modulation** - Displays the reception modulation type
- **FEC Rate** - Displays the coding rate of the input modulation
- **Pilot** - DVB-S2 only. Displays the pilot signals injection status (On/Off)
- **Frame Size** - DVB-S2 only. Displays the size of the received frame. Options are:
Monitoring the Decoding

The decoder type and modes of operation depend on the hardware configuration and are license dependent. The Decoding Main Menu is enabled only when the required hardware is installed in the ProView 7000 device.

The Decoding Status page comprises the following:

- **CC Errors** - Displays the number of errors counted by the continuity counter (CC).
- **Video Information** - Displays the status of the following video source parameters:
  - Video Codec
  - Aspect Ratio - 4x3, 16x9
  - Scan Type
  - Frame Rate (baud)
- **Audio 1 / 2 Information** - Displays the status of the Audio Codec and Audio Sample rate for audio 1 (or audio 2) in kHz.
- **Service Information** - Displays the PID of the following decoded elementary streams:
  - Video
  - PCR
  - Audio 1 and 2
  - VBI
Chapter 6
Remote Management using EMS

The ProView 7000 EMS application provides a GUI for easy remote management of ProView 7000s.

Topics:
- Configuring the IP Parameters
- EMS System Requirements
- Installing EMS
- Launching EMS
- Adding a Device
- Changing a Device’s Connection Settings
- Connecting a Device
- Checking Device Connectivity
- Disconnecting a Device
- Removing a Device
- Displaying the Device Explorer
- EMS GUI Structure
- Manipulating EMS GUI Components
- Refreshing the EMS Screen

Configuring the IP Parameters

Before you can manage a ProView 7000 remotely, you must configure the IP parameters.

To configure the IP parameters of a ProView 7000:
1. Press Enter on the keypad.
   The root menu displays.
2. Navigate Unit > Management Port > IP Configuration.

3. Set the IP Address, Subnet Mask and Default Gateway for the port.
4. After any change in the IP configuration, the Apply port changes item is added to the IP Configuration sub-menu to allow confirmation of the port setup.
5. Select **Apply port changes**.
6. Select **Apply Changes**.

**EMS System Requirements**

Minimum platform requirements for EMS:
- P4 or equivalent processor @ 2 GHz or higher
- 1 GB of RAM (2 GB highly recommended)
- Windows XP, Windows Vista, or Windows 7 operating system
- Internet or LAN connection

**Installing EMS**

The ProView 7000 EMS is stored in the ProView 7000 for easy installation using a web browser.

To install the ProView 7000 EMS:

1. Run a web browser and enter the ProView 7000 IP address.
   
   The initial ProView 7000 dialog displays.

   ![ProView 7000 EMS](image)

   **NOTE:** The EMS application is a Java-based program which requires Java Runtime Environment version 1.6. If needed, install Java Runtime Environment 1.6, using the link provided on the Java Web start page.

   To check the ProView 7000 EMS Java version:
   
   a. Run `cmd` in Windows.
   
   b. Enter `java -version` and press `Enter` to check which version is currently on your station. Update if necessary from the Java Web start page.

   2. Click **Launch ProView 7000 EMS** on the ProView 7000 web page to install the EMS.
Launching EMS

Prerequisites:
The device IP address must be configured using the ProView 7000 front panel, see Configuring the IP Parameters.

To launch the ProView 7000 EMS:

- Double-click the Harmonic ProView 7000 EMS launch icon to launch EMS.

The EMS GUI displays.

Adding a Device

To add a device:

1. Click Add Device on the EMS toolbar
   —or—
   select Administration > Add ProView 7000.

   ![Add Device dialog](image)

   **Figure 6-1: Add Device dialog**

   The EMS displays the Add ProView 7000 Device property sheet.

2. Enter a name for the new ProView 7000 device.
3. Enter the IP Address of the new ProView 7000 device.
4. For automatic connection when launching the EMS, mark the Connect Device check box.
5. For SNMP settings click Advanced.

![ProView 7000 Device - Add - Advanced dialog]

6. Enter a Timeout value for defining the maximum time period for one connection attempt. This parameter is set to 20000 (msec) by default.

7. Enter a Retry value for setting the number of connection attempts in case of a connection failure. This parameter is set to 2 tries by default.

8. Click OK to save advanced parameters.

   The Advanced property sheet closes and the EMS returns to the Add ProView 7000 Device dialog.

9. Click Add.

### Changing a Device's Connection Settings

You can change the identification, automatic connection and SNMP settings of devices already added to EMS.

To change a device’s connection settings:
1. Right-click the device in the Devices box.
2. Select Preferences.
3. Edit the name or IP address.
4. For automatic connection when launching the EMS, mark the Connect Device check box.
5. For SNMP settings click Advanced.

### Connecting a Device

Connect a ProView 7000 device to enable the EMS to monitor and control the device. A disconnected ProView 7000 device is marked in the device list by a grayed device icon.

To connect a ProView 7000 device to the EMS:
1. Right-click the ProView 7000 device icon in the Devices box.
Checking Device Connectivity

You can ping any ProView 7000 device managed by the EMS disregarding its status.

To test the device connectivity:

1. Right-click the icon of the ProView 7000 device in the Devices box.
   
   A Device context menu displays.

2. Select **Connect**.
   
   If the device fails to connect, the device LEDs in the Devices box are red, perform the procedure in **Checking Device Connectivity**.
   
   If the ping fails and the device fails to connect, check your network connections and settings.
   
   Once connection is established, the device icon LEDs are green.

### Checking Device Connectivity

You can ping any ProView 7000 device managed by the EMS disregarding its status.

To test the device connectivity:

1. Right-click the icon of the ProView 7000 device in the Devices box.
   
   A Device context menu displays.

2. Select **Ping...** in the menu.
The Ping test property sheet displays with the IP address of the device.

3. Click **Ping**.
   
   A message displays the response of the device to the test.
4. Click **OK** to confirm the test result.
5. Click **Close** to complete the ping test.

### Disconnecting a Device

A connected ProView 7000 device is communicating with the ProView 7000 EMS and is marked in the device list by a fully colored device icon. The icon is displayed in the Device box, and, if activated, it is also displayed in the Physical Input and Physical Output boxes.

Disconnecting a device closes the tab and all relevant information displayed on the Device Explorer tab for the device.

To disconnect a connected ProView 7000 device from the EMS:
1. Right-click the icon of the connected ProView 7000 device in the Device box.
   
   A device context menu displays.

2. Select **Disconnect** in the menu.
   
   The ProView 7000 device disconnects.
   
   The colors of the ProView 7000 device icon fade to the disconnected shades (gray).

### Removing a Device

Removing, or Deleting a ProView 7000 device from the EMS management, disconnects all communication between the device and EMS and the device is no longer available via EMS. To regain access to the device using EMS, add the device to EMS, see Adding a Device for details.
Removing a device from the EMS management can be performed on any ProView 7000 device (i.e., listed in the Devices box), regardless of its status; connected (full color icon), disconnected (gray icon) or even a not responding device (red marked icon).

To remove a device:
1. Select the device which needs to be removed.
2. Click **Remove** on the EMS toolbar
   —or—
   select **Action > Remove**
   —or—
   press `<Delete>`.
   A confirmation dialog displays.
3. Select **OK**.
   The device is removed from the device list.

**Displaying the Device Explorer**

Prerequisites:
- Device must be added to the Devices box
- Device must be connected

To display the Device Explorer
1. Select the device in the Devices box of the EMS window.
2. Click **Device Explorer** in the EMS toolbar to display input and output stream trees.

**EMS GUI Structure**

The ProView 7000 Element Management System (EMS) is an intuitive graphical user interface (GUI) which enables you to manage ProView 7000s over a LAN. The main EMS components are:
- Pull-down menus
- Toolbar
- The Devices box
- The Device Explorer tabs
- The Alarms tab
- The Alarm History tab

See Figure 6–2 for EMS component names.

**Manipulating EMS GUI Components**

The EMS GUI displays the graphical information in boxes. These boxes can be collapsed when not needed or expanded to fill all available screen space.
- Use the triangles to expand or collapse boxes, see Figure 6–2.
- Click and drag box borders to resize boxes, see Figure 6–2.
Refreshing the EMS Screen

The EMS supports a user-driven screen refresh function. This function can refresh the following:

- **Element** – Updates a branch or specific element in the stream, either at the multiplexed input or the multiplexed output.
- **Device** – Updates the currently managed ProView 7000 device.

To refresh an element or device:
1. Select an element or device.
2. Select File > Refresh > [device|element]
   — or —
   click Refresh on the EMS Toolbar.

You can also perform a refresh by right-clicking the element icon and selecting the Refresh item in the displayed element drop-down menu.

Toolbar

The toolbar comprises the following shortcuts:

- **Add Device** – See Adding a Device for details.
- **Device Explorer** – See EMS Device Explorer for details.
- **Properties** – See Device Properties for details.
- **Remove** – See Removing a Device for details.
- **Connection Wizard** – See EMS Connection Wizard for details.
- **Upgrade** – See Software Management for details.
- **Refresh** – See Refreshing the EMS Screen for details.
- **DMS Info** – See DMS for details.
Figure 6-2: ProView 7000 EMS Graphical User Interface
EMS Device Explorer

The Device Explorer tabs display the input and output stream parameters for the selected device. The tab is divided into four management boxes, namely:

- The **Physical Input** box
- The **Multiplex Input** box
- The **Multiplex, Transcoding & Decoding Output** box
- The **Physical Output** box

Use these parameters to monitor and configure the device.

You can manage several devices with the EMS. Each device stream tab is labeled with the same device name that displays in the **Devices** box. The selected device stream tab label displays in white. All other tab labels display in gray.

To display the Device Explorer tab:

- Select **File > Open Device Explorer** and select a device from the displayed device list.
- or—
  1. Right-click the icon of the ProView 7000 device in the **Devices** box.

     The Device context menu displays.

     ![Device Explorer Context Menu]

     2. Select **Open Device Explorer for {ProView 7000 Name}** in the menu.

     The Device Explorer tab for the selected device displays.

To bring device stream tab to the top:

- Click a tab label
- or—
  Double-click the icon of the device in the **Devices** box.

The Device Explorer tab displays a hierarchy-map of the input and output ports, transport-streams, programs, elementary streams, PIDs, Tables, CAMs and decoders that are currently connected and cross-connected by the ProView 7000 selected for management on the EMS.
Figure 6–3: Device Explorer tab

- The Device Explorer tab is divided into four boxes, see Figure 6–3. It comprises:
  - **Physical Input** ports box, deals with the features of the device input physical interfaces (see Physical Input Ports and Slots).
  - **Multiplex Input** box, deals with the multiplexing features of the input stream (see Multiplex Inputs).
  - **Multiplex, Transcoding & Decoding Output** box, deals with the multiplexing and decoding features of the output stream (see Multiplex, Transcoding & Decoding Outputs).
  - **Physical Output** ports box, dealing with the features of the device output physical interfaces (see Physical Outputs).

The ProView 7000 EMS GUI uses a wide range of icons to identify elements displayed on the Device Explorer tab, see Appendix E, Device Explorer Icons.

**DMS**

Use DMS menu item to display information related to DMS control of the ProView 7000 device. It comprises the following tabs:

- **Authorization** – Displays the list of programs authorized by DMS.
- **Blackout** – Displays the list of programs blacked-out by DMS.
- **EMM** – Displays EMM control statistics.
  - **Reload** button – Use to refresh the display.
- **Disaster Recovery**
  - **Disaster Recovery Scan** – Use the Abort button to abort the scan.

To connect a ProView 7000 device to the EMS:
1. Right-click the ProView 7000 device icon in the Devices box.
A device context menu displays.

2. Select DMS Info.

   The DMS Info property sheet displays.

   **NOTE:** You can also click DMS Info on the toolbar to display the DMS Info property sheet.
Chapter 7
Device Configuring Using EMS

Topics:
- Physical Input Ports and Slots
- Multiplex Inputs
- Multiplex, Transcoding & Decoding Outputs
- Physical Outputs
- Element Properties
- Cross Connections
- CAM Slot Management
- EMS Connection Wizard
- Low Delay Mode
- Device Management
- Device Properties

NOTE: If you make a change that can be controlled by DMS while being controlled by DMS, you can lose that change. Transcoding and decoding changes depends on the Local Override setting in DMS.

Physical Input Ports and Slots

The Physical Input box on the Device Explorer tab presents a hierarchical tree-structure of the ProView 7000 physical inputs, see Figure 6–2 for the box location.

Use the Device Explorer tabs to manage streams, physical ports, multiplexes and CAM slots.

The ProView 7000 has the following inputs:
- ASI input ports
- DVB-S/S2\(^1\) RF modulated inputs\(^2\)
  - When the DVB-S/S2’s carrier and demodulator are locked, the icon LEDs are green, when they are not locked the icon LEDs are red. See Figure 7–38
- DS-3\(^3\) input port
- GbE ports\(^4\)
- CAM slots, responsible for the descrambling process

To display the context menu:
- Right-click an element

---

1. Requires a license with some hardware configurations, see Front End Card Features for details.
2. Not all hardware configurations support 4 demodulator ports, see Front End Card Features.
3. Requires some hardware configurations, see Front End Card Features for details (ProView 7100 only).
4. GbE in requires a license.
Related Topics:

- ASI Input Port
- DVB-S/S2 In Port Properties
- DS-3 In Port Properties
- GbE Ports for Input
- CAM Slots
- CAM Properties
- BISS Table Management

# ASI Input Port

## Port Properties

The **ASI Input Port Properties** property sheet displays the basic features of the selected ASI Input Port element.

To display the **ASI Input Port** properties:

1. Select the required ASI Input Port icon in the **Physical Input** box in the Stream Managing tab.
2. Click **Properties** on the EMS toolbar.

The displayed properties are informative only and consist of the description of the ASI Input Port and the description of the Multiplex Port.

## Port Direction

On the ProView 7100 you can change the direction of ASI ports 3 and 4.

**NOTE:** Switching ASI BiDi mode reverts device settings to defaults. Device input settings in presets and configurations from software versions prior to 3.3 are not compatible with version 3.3.

To change port direction on the ProView 7100:

1. Select the device in the **Devices** box. (The relevant device may appear selected but you must click on it before proceeding to Step 2.)
2. Select **Tools > Set ASI Ports Direction**.

   The ports direction configuration dialog displays.
3. Select the direction radio button.
4. Click OK.

The device reboots.

**DVB-S/S2 In Port Properties**

The **DVB-S/S2 In Port** property sheet displays the basic features of the selected DVB-S/S2 Input Port element.

To display the **DVB-S/S2 In Port** properties:

1. Select the **DVB-S/S2 In Port** icon in the **Physical Input** box.
2. Click **Properties** on the EMS toolbar.

![Figure 7-1: DVB-S/S2 Input Port Properties](image)

The editable properties comprise the following:

- **Modulation Standard** – Options are:
  - **Automatic**
  - **DVB-S**

## Physical Input Ports and Slots

**DVB-S2**

**NOTE:** Some of the following properties are relevant for only one modulation standard (DVB-S or DVB-S2) and displayed accordingly.

- **Symbol Rate** - Sets the symbol rate value. Range 1,000,000 – 45,000,000 Bd, adjustable in 100 Bd steps.

- **Spectral Inversion** - Sets the mode of operation for the spectral inversion function. Options are:
  - **Automatic** - Default for DVB-S.5
  - **Normal** - Default for DVB-S2.5
  - **Inverted**

- **Modulation and FEC** - Sets the modulation scheme and forward error correction for the receiver.
  - **DVB-S** - Options are:
    - **Automatic** - Modulation and FEC set by the device (Default)
    - QPSK 1/2
    - QPSK 2/3
    - QPSK 3/4
    - QPSK 5/6
    - QPSK 7/8
  - **DVB-S2** - Options are:
    - VCM5 – Variable Coding Modulation format / Automatic5 (Default)
    - QPSK 1/4 5
    - QPSK 1/3 5
    - QPSK 2/5 5
    - QPSK 1/2
    - QPSK 3/5
    - QPSK 2/3
    - QPSK 3/4
    - QPSK 4/5
    - QPSK 5/6
    - QPSK 8/9
    - QPSK 9/10
    - 8PSK 3/5
    - 8PSK 2/3
    - 8PSK 3/4
    - 8PSK 5/6
    - 8PSK 8/9
    - 8PSK 9/10
    - 16APSK 2/3 6

5. Only available with certain hardware configurations, see Front End Card Features.
- 16APSK 3/4<sup>6</sup>
- 16APSK 4/5<sup>6</sup>
- 16APSK 5/6<sup>6</sup>
- 16APSK 8/9<sup>6</sup>
- 16APSK 9/10<sup>6</sup>

- **Frame Size**<sup>7</sup> – DVB-S2 only. Options are:
  - Normal frame (64,800 bits)
  - Short frame (16,200 bits)

- **Pilot Symbols** – DVB-S2 only. Options are:
  - Automatic<sup>7</sup>
  - On – The demodulator expects to find pilot symbols in the stream. (Default)
  - Off – The demodulator does not expect not to find pilot symbols.

**NOTE:** Not finding pilot symbols when expected, or finding them when not expected, prevents demodulator lock.

- **Physical Layer Scrambling Seed** – Enables the user to set the value for the scrambling seed. DVB-S2 only. Range: 0 – 262,141.

- **Roll-Off Factor** – DVB-S2 only. Options are:
  - Automatic<sup>7</sup> – Default for DVB-S2.
  - 20%
  - 25%
  - 35% – Default for DVB-S.

- **Acquisition Mode**<sup>8</sup> – Sets the frequency scanning span of the receiver when searching for the satellite carrier frequency (lock acquisition search range). Options are:
  - Narrow
  - Wide

**NOTE:** Wide search is the normal operation mode of the receiver frequency acquisition scan. Narrow Search mode should be used when symbol rate of the input is lower than 5 MBd.

- **Frequency Drift Compensation** – Compensate for LNB frequency drift, see Front End Card Features for board details. Options are:
  - On
  - Off

- **BER Threshold** (DVB-S only) – Sets the threshold limit to raise the Bit Error Rate alarm. Range: 0.000001 (0.1x10⁻⁴) – 0.1.

- **PER Threshold** (DVB-S2 only) – Sets the threshold limit to raise Packet Error Rate alarm. Range: 0.000000001 (0.1x10⁻⁷) – 0.1.

6. A license is required for 16APSK modulation. Only available with certain hardware configurations, see Front End Card Features.

7. Only available with certain hardware configurations, see Front End Card Features.

8. Only available with certain hardware configurations, see Front End Card Features.
- **Attenuation Level** - Internal attenuation for saturated signals (0 – 30 dB).
- **Gain** - Internal gain to improve signal strength.
- **ISI (Hex) (0-FF)** - Input Stream Identifier in hexadecimal. Use this parameter to select a specific transport stream from a multi-transport carrier. If you have a quad port demodulator card then you can select up to 4 transport streams from 4 single or a multi-transport stream carrier. Default is FF.
- **Mute Upon Reception Errors** - Mark this check box to mute the input when an alarm exceeds a reception error related threshold. Click the **Alarm Threshold** button to set the reception error related alarm thresholds.
- **Drop Erroneous Packets** - Mark this check box to instruct the demodulator not to pass any transport stream packets with errors. The default is to pass all TS packets.
- **Alarm Threshold** - Click this button to display the **Alarm Threshold** property sheet. You can configure the following:
  - **BER Threshold**
  - **PER Threshold**
  - **Eb/No (dB):**
    - Automatic - Use thresholds according to the Eb/No standards.
    - Manual - Range: 0.5 – 15 dB.
- **Carrier Frequency** properties - Radio buttons selection, therefore only one is selected at a time. Changing the value on one option, changes the other one automatically:
  - **L-Band Frequency Range** - Sets the L-Band frequency of the receiver local oscillator. Range: 950,000 – 2,150,000 (in kHz), adjustable in 125 kHz steps.
  - **Frequency for the band selected in LNB** - Sets the frequency of the satellite, according to the satellite transmitting frequency, adjustable in 125 kHz steps.
- **LNB (Low Noise Block) Properties:**
  - **Polarization** - Antenna polarization. Options are:
    - 13V (Vertical)
    - 18V (Horizontal)
    - Off
  - **LNB Frequency Band** - The default is Universal. Options are:
    - Universal (9.75, 10.6)
    - Universal Wide (9.75, 10.75)
    - Ku
    - C
  - **LNB Local Oscillator Frequency (kHz)** - For Universal and Universal Wide satellite frequencies, the LNB Local Oscillator Frequency is set according to the 22 kHz Tone setting.
    For Ku band, adjustable, in the 8.5 GHz – 13 GHz range, in 125 kHz steps.
    For C band, adjustable, in the 5 GHz – 6 GHz range, in 125 kHz steps.
  - **22 kHz Tone** - **Low Band or High Band** selectable for Universal and Universal Wide satellite frequencies (not applicable for Ku band and C band frequencies and not displayed when Ku or C band are selected)
**DS-3 In Port Properties**

The **DS-3 In Port** property sheet displays its basic features.

To display the DS-3 In Port properties:
1. Select the DS-3 In Port icon in the Physical Input box.
2. Click **Properties** on the EMS toolbar.
3. Make changes to the configuration where appropriate.
4. After making changes to the configuration, click **OK** or **Apply** to confirm them.

The editable properties comprise the following:

- **Frame Format** - Options are:
  - **Unframed**
  - **M13** (Default)
  - **C-Parity**

- **Packet Size** - Options are:
  - **188**
  - **204** (Default)

- **Reed-Solomon** - Options (available when Packet Size is 204):
  - **On** (Default)
  - **Off**

- **Interleaving** (only when Packet Size is 204 and Reed-Solomon is On):
  - **On** (Default)
  - **Off**

- **Randomizing** (only when Packet Size is 204 and Reed-Solomon and Interleaving parameters are enabled):
  - **On** (Default)
  - **Off**

**GbE Ports for Input**

The GbE branch comprises four sockets and two GbE ports. All sockets are associated to both GbE ports by default.

Related topics:

- **GbE Port Properties**
- **GbE Socket Properties**
- **GbE PHY Redundancy**
GbE Port Properties

Use the GbE Port Properties property sheet to view and configure the selected GbE port.

**NOTE:** Changing GbE port properties reflects in the Physical Input and Physical Output boxes.

To display the GbE Port properties:
1. Select the required GbE Port icon in the **Physical Input** box on the **Device Explorer** tab.
2. Click **Properties** on the EMS toolbar.

The GbE Port property sheet displays.

The GbE Port property sheet comprises of a **General** and an **Advanced** tab.

**GbE Port General properties tab:**

- **Enabled** – You can enable either or both GbE ports. This parameter only works when the redundancy mode is manual, see **GbE PHY Redundancy**. If both ports are enabled then only one port is active while the other one is in standby mode, by default Port 1 is active and Port 2 is on stand by. The port on stand by does not pass data. When the port is enabled and no link is detected, the device reports a link down alarm. Disable the port to mask this alarm. The default is **Disabled**.
- **Redundancy Mode** – Set one port as the active one and set the others to standby. This parameter only works when the redundancy mode is manual, see **GbE PHY Redundancy**.
- **IP Profile** – Enables you to configure the following:
  - **IP Address** – Each port must have a different IP Address. The default is 127.127.0.X, where X is the port number.
  - **Mask** – The IP mask. The default is 255.255.255.0.
  - **MAC Address** – Each port has its own MAC Address. They are factory set and cannot be changed.

![GbE Port Properties property sheet - General tab](image)

**GbE Port Advanced properties tab:**

- **Autonegotiation Enabled** – You can enable and disable Autonegotiation. The default is **Yes**.
- **Duplex Mode** – You cannot change the Duplex Mode. It is fixed at Full Duplex.
- **Speed** - You can configure the PHY speed when Autonegotiation is disabled. The default is 1000.

![GbE Port Properties property sheet - Advanced tab](image)

**GbE Socket Properties**

Use the GbE Socket property sheet to view and configure the selected GbE port. By default all sockets are associated with both GbE ports.

To display the GbE Socket properties:
1. Select the required GbE Socket icon in the **Physical Input** box on the Device Explorer tab.
2. Click **Properties** on the EMS toolbar.

   The **GbE Socket** property sheet displays.
Chapter 7 Device Configuring Using EMS

Physical Input Ports and Slots

Figure 7-4: Socket property sheet

The property sheet comprises:

- **Enabled** - You can enable or disable each socket.

- **General** parameters box:
  - **Unicast / Multicast** - You can select either Unicast or Multicast.
  - **Destination IP Address** - You can configure the same Destination IP Address and UDP Port for several sockets if you define the Source Specific Multicast and the Source IP Addresses are different. When the IP Address Type is Unicast, the ProView 7000 uses the active port IP address. When the IP Address Type is Multicast, you must enter the multicast IP address. The default is 238.1.1.X (X is the socket number).
  - **UDP Port** - You can configure the same IP Address and UDP Port for several sockets if you define the Source Specific Multicast and the Source IP Addresses are different. The source UDP range is 0 – 65535. The default is 1000.
  - **Source Specific Multicast (SSM)** - You can configure Source Specific Multicast when using Multicast addresses to accept only data packets with a matching source address. When SSM is disabled, the device accepts all packets with destination IPs and ports that match the socket regardless of their source IP.

- **Source IP Address** - Enable **Source Specific Multicast** to enter an SSM source IP address.

- **RTP/FEC** (ProView 7100 only.)
  - **FEC** - You can enable FEC for each socket individually. The device automatically detects the size of the matrix, you don’t need to configure it. The number of columns supported is 1 – 50. The number of rows supported is 4 – 50. Total matrix size is 256.
    - **None**
    - **1 Dimension**

9. Requires a license.
2 Dimensions

- **Reordering** - Enable Reordering when packets are encapsulated to correct packet ordering.
  - Enable
  - Disable

- **Null Insertion** - Enable to insert null packets in place of packets that cannot be corrected.
  - Enable
  - Disable

- **Connectivity** box - Displays the multiplex ins and physical GbE ports associated with the socket.

- **Advanced** box
  - **De-Jitter Mode** - All input sockets are de-jittered. Options are:
    - No De-Jitter
    - Low Delay Mode
    - Normal Network Jitter (Less than 50 ms)
    - High Network Jitter (Up to 300 ms)
    - SFN De-Jitter
    - T2-MI De-Jitter

  - **Average Input Bitrate** - Input field that will be active when De-Jittering is enabled and the De-Jittering Mode is T2-MI or None. Value 1,000,000 - 160,000,000 bps. Default value for T2-MI is 40,000,000 and the Default for None is 160,000,000.

- **Status** box
  - **De-Jittering** - The status messages are:
    - OK – DJ is being performed.
    - Off – Either the socket is in Admin Down or the socket is operating in no De-Jitter mode.
    - No PCR – No PCR has been detected
    - Unsupported rate
    - Illegal PCR skew – Bigger than 31 PPM
    - No stream detected
    - No MIP Detected – only applicable in SFN mode

- **FEC**

**GbE PHY Redundancy**

GbE Port 1 is always the Primary Port. GbE Port 2 is always the Backup Port. The Primary Port (GbE Port 1) is the active port and the Backup Port is the standby port by default.

There are 4 modes:

- **Manual** - You can manually switch between the Primary Port and the Backup Port regardless of their link status.

- **Manual Revert** - The device switches from the Primary Port to the Backup Port when the Primary Port fails on one of the redundancy triggers and the Backup Port has no active alarms. You can revert from the Backup Port to the Primary Port manually.
- **Automatic** – The device switches to the standby port whenever the active port fails on one of the redundancy triggers and the standby port has no active alarms.

- **Automatic Revert** – The device switches from the Primary Port to the Backup Port when the Primary Port fails on one of the redundancy triggers and the Backup Port has no active alarms. The device reverts to the primary as soon as the Primary Port has no active alarms.

To set the GbE redundancy mode:
1. Right-click a GbE port in the Physical Input box.
2. Select **Redundancy Configuration**.
3. Select a mode
   —or—
1. Select **Tools > Redundancy Configuration**.
2. Select a mode.

To set a port as the active port:
1. Right-click the port in the Physical Input box.
2. Select **Set Active**
   —or—
   use the port property sheet, see **GbE Port Properties**.

**CAM Slots**

The ProView 7000 has two PCMCIA slots and the ProView 7100 has four PCMCIA slots on the front panel that can each accommodate a DVB-CI module with a smart card to descramble incoming video, see Figure 3–2 on page 35 for the location.

**Inserting a CAM**

1. Insert the smart card into a DVB-CI module with the contacts facing up and towards the front end.

2. Insert the DVB-CI module into one of the two PCMCIA slots with the *up* arrow pointing upwards and in the direction of insertion.
CAUTION: Do not remove or insert the DVB-CI module or the smart card while the ProView 7000 is powering up or initializing.

Figure 7–5: ProView 7000 with the DVB-CI module and Smart Card

When installed, the card is detected automatically by the ProView 7000 and enabled if the following conditions are met:

- The installed card must be EN50221 compatible
- Services have been selected
- A valid card license

CAM Slot Properties

Use the CAM Slot properties property sheet to monitor and manage individual CAM slots.

To display the property sheet for a CAM slot:

1. Select a CAM slot in the Physical Input box on the Device Explorer tab.
2. Click **Properties** on the EMS toolbar.

![CAM Slot property sheet](image)

**Figure 7-6: CAM Slot property sheet**

The **CAM Slot** property sheet includes the following:

- **Mapped to Input Multiplex Port** - Displays the current association status of the CAM slot and enables you to re-associate the CAM slot to an available multiplex input. You can only re-associate the CAM when no services are configured for the CAM.

- **CAM Vendor Card** - Provides the following information for the CAM card in the slot:
  - Vendor name
  - Number of descrambled programs
  - Number of descrambled elementary streams

- **Descrambled Programs** - Displays the program PIDs descrambled by the CAM.

- **CAM Automatic Recovery Policy** - You can configure the ProView 7000 to reset the CAM when one of the following alarms is raised:
  - **CAM Descrambling Failure** - Enabled by default.
  - **CAM Processing Failure** - Enabled by default.

- **Packet Loss after CAM** - Disabled by default.

- **Advanced**
  - **CAM Max Bitrate (Mbps)** - 72 or 96 Mbps depending on hardware configuration. The default is 72.
  - **CAM De-Jittering** - Enable or disable.

**CAM Properties**

The **CAM Card** property sheet displays the properties of the selected CAM element.

To display the CAM properties:

1. Select the required CAM icon in the **Physical Input** box on the Device Explorer tab.
2. Click **Properties** on the EMS toolbar.

![Figure 7-7: CAM Card property sheet](image)

The information displayed by the **CAM Card** property sheet includes the following:

- CAM application type
- CAM manufacturer name, number and code
- Conditional Access System IDs
- CAM operational status
- Number of descrambled programs and elementary streams

To display the **CAM MMI** menu:

- Click **CAM MMI**.

The **CAM MMI** property sheet displays.

![Figure 7-8: Sample CAM MMI property sheet](image)

Different CAMs have different options.
BISS Table Management

By default the Multiplex Ins pass through the BISS descrambler. You can also bypass the BISS descrambler on this and other Multiplex Ins. The bypass embedded descrambling option is located under the Descrambling tab of the Multiplex In properties. You can set it for each individual Multiplex input.

NOTE: When you use the latest firmware that supports 4 BISS descamblers on the ProView 7100, you can associate each program from any Multiplex In with an individual BISS key.

Related topics:
- BISS Table Management property sheet
- To Configure a BISS Key
- To Clear a BISS Key

BISS Table Management property sheet

Use the BISS Table Management property sheet to configure or remove keys.

Displaying the BISS Table Management property sheet:
1. Expand the device tree in the Physical Input box to display the descrambling branch with the BISS node.
2. Right-click BISS.

The BISS Table Management property sheet displays.

To Configure a BISS Key

Configuring a key:
1. Select a key.
2. Click Edit.
3. You can enter a description, the default description is the key name.
4. Select one of the following ID types:
   - BISS-1
Multiplex Inputs

- Injected E
- Buried E

5. Enter the SW (BISS-1 only).
6. Enter the ESW (Injected E or Buried E).
7. Enter the ID (Injected E only).
8. Click OK.

**To Clear a BISS Key**

You cannot clear a key that is in use.

Clearing a key:
1. Select a key.
2. Click Clear.

**Verimatrix Properties**

Use the Verimatrix Properties property sheet to display the following:

- **VSC ID** – The virtual smart card identity.
- **SW Version** – Displays the Verimatrix software version.
- **No. of Descrambled Programs**.
- **Max. Allowed Descrambled Programs**.
- **Descrambled Programs**

**Multiplex Inputs**

The Multiplex Input box of the Device Explorer tab presents a hierarchical tree-structure of the multiplex inputs of the ProView 7000, see Figure 6-2 for the box location.

It provides monitoring and configuring options for the features of each element in the tree:
- Input programs and elementary streams related to the multiplex input.
- Input tables related to the multiplex input.
Unreferenced PIDs related to the multiplex input.

**NOTE:** The Multiplex Input tree displays the transport rate level (in Mbps), summed at the tree highest level.

The ProView 7000 supports up to four multiplex inputs.\(^{10}\)

To display the context menu:
- Right-click the **Multiplex Input** icon.

Related topics:
- Input Programs Management
- Input Tables Management
- Input Unreferenced PIDs Management
- Multiplex In Port Properties
- Input Program Properties
- Input Elementary Stream Properties
- Input Conditional Access Messages Properties
- Input Tables Properties
- Input Unreferenced PID Properties

**Input Programs Management**

Click the **Programs** branch in the **Multiplex Input** box to display all the programs related to the multiplex inputs and the type of information provided by the program.

Each program can be scrambled or clear (marked accordingly by a locked / free program icon).

10. A license is required for more than one multiplex input.
The information provided by each program can be video, audio, ECM or other (marked by representative icons).

**NOTE:** The properties of the input programs and the elementary streams related to each program in the multiplex input stream are detailed in *Input Program Properties, Input Elementary Stream Properties* and *Multiplex Output Unreferenced PIDs Management*.

### Input Tables Management

Click the **Tables** branch in the **Multiplex Input** box to display all the tables related to the multiplex input and the type of information provided by the table.

The **Input Tables** branch provides access to the following MPEG PSI and DVB PSI/SI tables related to the multiplexed stream:

- Program Association Table (PAT) for the stream
- Conditional Access Table (CAT) and the specific Entitlement Management Messages (EMM) in the CAT
- Program Map Tables (PMTs) for each multiplex program
- Network Information Table (NIT)
- Service Description Tables (SDTs)
- Event Information Table (EIT)
- Time and Date Table (TDT/TOT) associated with the stream

**NOTE:** The displayed tables are managed by the stream type defined (MPEG or DVB). The property of the various input tables in the multiplexed input stream is detailed in *Input Tables Properties*. 
Input Unreferenced PIDs Management

Click the Unreferenced PIDs branch in the Multiplex Input box to display all the PIDs related to the multiplex input that are not referred to a specific program or table.

NOTE: The properties of the input unreferenced PIDs in the multiplexed input stream is detailed in Input Unreferenced PID Properties.

Multiplex In Port Properties

Use the Multiplex In Port property sheet to display a multiplex in port status, configure a multiplex in port or configure a port input redundancy.

To display the Multiplex In Port property sheet:

1. Select a Multiplex In Port icon in the Multiplex Input box on the Device Explorer tab.
2. Click **Properties** on the EMS toolbar.

The **Multiplex In Port** property sheet contains the General, DPI Filtering, and Descrambling tabs:

- **General** tab:
  - **Enabled** – Use to enable or disable the multiplex input.
  - **Transport Stream ID** – Displays the transport stream’s ID.
  - **Table Extraction** – Use to select **PSI/SI** for DVB or **PSI** for MPEG. For ATSC systems, set the stream type to MPEG. The default is **PSI/SI**.
  - **Redundancy Mode** – See **Redundancy** below for feature description.
  - **Active Port**

**Input Configuration**

- **Primary** box
  - **Source Port** – Use to select the primary physical input port for the multiplex input.
  - **T2-MI Mode**\(^{11}\) – See **De-Framing** below for feature description. Options are:
    - **None** – Default.

---

11. Requires a license.
Multiplex Inputs

- **Pass** – The device assumes that the transport stream is a T2-MI transport stream.
- **De-Framing** – The device allocates a free de-framing engine.
- **T2-MI PID (1–8191)** – You must configure the T2-MI PID if the T2-MI Mode is configured to De-Framing. (Required)
- **PLP ID (0–255)** – You must configure the PLP ID of the transport to be extracted if the T2-MI Mode is configured to De-Framing. The range is 0–255. The default is 0. (Required)
- **De-Jittering** – See De-Jittering below for feature description. Options are:
  - **Enabled** – Select to enable de-jittering.
  - **Disabled** – Select to disable de-jittering (Default).
- **De-Jittering Mode** – Options are:
  - **Normal De-Jitter** – The DJ adds a delay of 250 msec. The supported jitter is less than 50 msec.
  - **Low Delay** – The DJ adds a delay of 100 msec. The supported jitter is up to 65 msec.
  - **SFN** – The DJ adds a delay of 250 msec. The supported jitter is up to 50 msec.
- **T2-MI Average Input Bitrate** – Input field that will be active when De-Jittering is enabled and the De-Jittering Mode is T2-MI. Value 1,000,000 - 54,000,000 bps.
- **De-Jittering Status** – The device displays the current de-jitter status. See De-Jittering Status for descriptions.
- **Backup box** – To configure the Backup box and use redundancy, the Redundancy Mode parameter must be set to anything but Off.
- **Source Port** – Use to select the backup physical input port for the multiplex input. (Not available when Disaster Recovery is in process)
- **T2-MI Mode** – See De-Framing below for feature description. Options are:
  - **None** – (Default)
  - **Pass** – The device assumes that the transport stream is a T2-MI transport stream.
  - **De-Framing** – The device allocates a free de-framing engine.
- **T2-MI PID (1–8191)** – You must configure the T2-MI PID if the T2-MI Mode is configured to De-Framing. (Required)
- **PLP ID (0–255)** – You must configure the PLP ID of the transport to be extracted if the T2-MI Mode is configured to De-Framing. The range is 0–255. The default is 0. (Required)
- **De-Jittering** – See De-Jittering Mode below for feature description. Options are:
  - **Enabled** – Select to enable de-jittering.
  - **Disabled** – Select to disable de-jittering (Default)
- **De-Jittering Mode** – Options are:
  - **Normal De-Jitter** – The DJ adds a delay of 250 msec. The supported jitter is less than 50 msec.
  - **Low Delay** – The DJ adds a delay of 100 msec. The supported jitter is up to 65 msec.
  - **SFN** – The DJ adds a delay of 250 msec. The supported jitter is up to 50 msec.

---

12. Requires a license for SFN.
13. Requires a license for SFN.
- **Average Input Bitrate** - Input field that will be active when De-Jittering is enabled and the De-Jittering Mode is T2-MI. Value 1,000,000 - 54,000,000 bps.

- **De-Jittering Status** - The device displays the current de-jitter status. See Table 7-1: De-Jittering Status for descriptions.

- **Redundancy Triggers** - See Redundancy below for feature description.

- **MPEG Sync Loss Alarm tab**
  - **Trigger Alarm** - Use to enable or disable the trigger, default is Enable.
  - **Primary Port Event Duration** - Set the period that the state must exist to trigger redundancy
  - **Backup Port Event Duration** - Set the period that the state must exist to trigger redundancy (Not available when Disaster Recovery is in process)

- **CC Errors Alarm tab**
  - **Trigger Alarm** - Use to enable or disable the trigger, default is Enable.
  - **Primary Port Number of Errors** - Set the number of CC errors that must occur within a period to trigger redundancy
  - **Primary Port Within** - Set the period that the number of CC errors must occur within to trigger redundancy
  - **Backup Port Number of Errors** - Set the number of CC errors that must occur within a period to trigger redundancy (Not available when Disaster Recovery is in process)
  - **Backup Port Within** - Set the period that the number of CC errors must occur within to trigger redundancy (Not available when Disaster Recovery is in process)

- **PID Missing Alarm tab**
  - **Trigger Alarm** - Use to enable or disable the trigger, default is Enable.
  - **PID** - set the PID number
  - **Primary Port Missing For** - Set the period that the PID must be missing for to trigger redundancy
  - **Backup Port Missing For** - Set the period that the PID must be missing for to trigger redundancy (Not available when Disaster Recovery is in process)

**Redundancy**

Only one port is active while the other one is in standby mode, by default the Primary Port is active and the Backup Port is on standby. The port on stand by does not pass data. The **Redundancy Triggers** section is used to configure triggers that will switch to the Backup Port. The Seamless Redundancy mode doesn't require any triggers for switching between sources. While working in Seamless mode, the “Trigger Alarm” checkbox will be used to enable/disable the Alarms reporting. The default Redundancy Mode is **Off**.

The active port displays in bold in the **Multiplex Input** box. The Primary Port is designated with a **P** and the Backup Port is designated with a **B**.
To use **Input Redundancy** you must configure the **Primary Source Port** in the **General** box and the **Backup Source Port** in the **Input Redundancy** box.

There are 7 modes:

- **Off**
- **Manual** – You can manually switch between the primary and the Backup Ports.
- **Manual Revert** – The device switches from the Primary Port to the Backup Port when the Primary Port fails on one of the redundancy triggers and the Backup Port has no active alarms. You can revert from the Backup Port to the Primary Port manually by clicking on the Primary radio button.
- **Automatic** – The device switches to the standby port whenever the active port fails on one of the redundancy triggers and the standby port has no active alarms.
- **Automatic Revert** – The device switches from the Primary Port to the Backup Port when the Primary Port fails on one of the redundancy triggers and the Backup Port has no active alarms. The device reverts to the primary as soon as the Primary Port has no active alarms.
- **Seamless** – If you have two equal streams, the device switches to the standby port whenever the active port fails, without loss of video packets. A maximum offset between the sources needs to be filled in. The Seamless option is only available with license.
- **Controlled by DMS** – When DMS uses Disaster Recovery with a ProView 7000, the Redundancy Mode displays as **Controlled by DMS** in EMS because Disaster Recovery overrides redundancy. All Backup Port parameters are not available.

You must enable at least one redundancy trigger on one of the tabs using the **Trigger Alarm** check box to use redundancy.

**De-Framing**

The ProView 7000 supports up to four (4) T2-MI de-framing engines. Each engine can extract one PLP out of a given T2-MI PID. The output is a CBR transport stream.

**De-Jittering**

The device supports up to four (4) general purpose de-jittering engines. This feature is only available on the ProView 7100. Each engine supports a bitrate of up to 54 Mbps. Only CBR TS is supported.
Table 7-1: De-Jittering Status

<table>
<thead>
<tr>
<th>Status</th>
<th>Descriptions</th>
</tr>
</thead>
<tbody>
<tr>
<td>OK</td>
<td>DJ is being performed</td>
</tr>
<tr>
<td>Off</td>
<td>Either the multiplex is in Admin Down or the multiplex is operating in no DJ mode</td>
</tr>
<tr>
<td>No PCR</td>
<td>No PCR has been detected</td>
</tr>
<tr>
<td>Unsupported rate</td>
<td>The bitrate is not supported.</td>
</tr>
<tr>
<td>Illegal PCR Skew</td>
<td>Bigger than 31 PPM.</td>
</tr>
<tr>
<td>No stream detected</td>
<td>No stream is detected.</td>
</tr>
<tr>
<td>No MIP detected</td>
<td>Only applicable in SFN mode.</td>
</tr>
</tbody>
</table>

- **DPI Filtering** tab
  - **Filter By Event ID** - Set to enable the filtering (Yes) or disable the filtering (No)

To add Event IDs per program (max. 10) on which you can filter:
1. Click **Add**.
2. Insert the Program number.
3. Insert the Event ID (number).
4. Click **OK**.
5. Click **OK**.

After entering the information, you can enable or disable the filtering.

**NOTE:** Event IDs and their program number can be edited.
- **Descrambling** tab
  - **Bypass Embedded Descrambling** - Set to enable the bypass *(Yes)* or disable the bypass *(No)* (Default).
  - **Assigned CAMs** - Displays CAM slots assigned to the multiplex input.

**NOTE:** Each Input TS has a dedicated BISS mapped to it.
Input Program Properties

The Input Program property sheet provides basic information on the input program provided to the input multiplex over the received transport stream.

To display the Input Program property sheet:
1. Select the required Input Program icon in the Multiplex Input box on the Device Explorer tab.
2. Click Properties on the EMS toolbar.

The information displayed by the Input Program property sheet includes the following:
- The Program Clock Reference identification number (PCR PID).
- The Program Map Table identification number (PMT PID).
- The program reference number.
Input Elementary Stream Properties

The Input Elementary Stream (ES) property sheet provides basic information on the stream included in the input program provided to the input multiplex. The ES input multiplex tree displays Video, Audio and Other (such as DVB Subtitling) types of streams for each program.

To display the Input ES properties:

1. Select the required ES icon (Video 🎥, Audio 🎧 or Other 🎨) in the Multiplex Input box on the Device Explorer tab.
2. Click Properties on the EMS toolbar.

The information displayed by the Input ES property sheet includes the following:

- The program identification number (PID) of the input elementary stream type.
- The ES type code (in hex) and description.
- The language code for the ES (Not applicable for Video ES).

Input Conditional Access Messages Properties

The Input Conditional Access Entitlement Control Message (ECM) property sheet provides basic information on the ECM information included in the input program provided to the input multiplex.

To display the Input ECM properties:

1. Select the required ECM icon 🏷 in the Multiplex Input box on the Device Explorer tab.
2. Click **Properties** on the EMS toolbar.

The information displayed by the Input ECM property sheet includes the following:

- **ECM PID** – Displays the entitlement control message identification number of the conditional access system.
- **CA System ID** – Displays the identification of the conditional access system.

**Input Tables Properties**

The **Input Tables** property sheet provides basic information on the input tables provided to the input multiplex over the received transport stream.

These tables include:

- Conditional Access Table (CAT)
- Program Association Table (PAT)
- Program Mapping Table (PMT)
- Service Description Table (SDT)
- Network Information Table (NIT)
- Event Information Table (EIT)
- Time & Date Table (TDT/TOT)

To display the Input Tables property sheet:

1. Select the required Input Table icon from the Multiplex Input box on the Device Explorer tab.
2. Click **Properties** on the EMS toolbar.

The information provided for each of the Input Table property sheet includes the version and number of sections in the table.

The Conditional Access Table (CAT) consists of one (or more) Entitlement Management Message (EMM) for each of the input encrypted streams. Selecting the specific EMM and clicking the [Properties] button displays the EMM property sheet consisting of the EMM PID and the CA System ID.

The Program Association Table (PAT) property sheet displays the transport stream ID information, the version and number of the PAT sections.
The Program Mapping Table (PMT) consists of a group of individual tables. Selecting the specific table and clicking the [Properties] button displays the version and number of sections for the selected PMT.

The Service Description Table (SDT) consists of one (or more) services provided on the stream. Selecting the SDT icon and clicking the Properties button displays the common properties of the table, consisting of the version, number of sections data displayed and the identification number of the original network.

Selecting a specific entry in the SDT table (marked as sub-branches of the SDT table branch) and clicking the Properties button displays the following information for the service: Service ID, Service running status, Service CA mode (free/scrambled), Service name, Service provider name and service type.

**Input Unreferenced PID Properties**

The Input Unreferenced PID property sheet provides basic information on an unreferenced stream provided to the input multiplex.

To display the Input Unreferenced PID properties:
1. Select the required Unreferenced PID icon from the Multiplex Input box on the Device Explorer tab.
2. Click Properties on the EMS toolbar.

The information provided by the Input Unreferenced PID property sheet includes the following:
- The packet identification number (PID) of the related input stream.
- The type of the PID (Unreferenced).

**Multiplex, Transcoding & Decoding Outputs**

The Multiplex, Transcoding & Decoding Output box of the Device Explorer tab presents a hierarchical tree-structure of the decoded and multiplex outputs of the ProView 7000, see Figure 6–2 for the box location. It comprises two branch types; multiplexing branches (ｲ) and the decoding branch (■).

The multiplexing branch provides monitoring and configuring options for the features of stream and each element in the branch; Programs, Tables and unreferenced PIDs related to the multiplex output. For details, refer to Multiplex Output Programs Management (programs), Multiplex Output Tables Management (tables), Multiplex Output Unreferenced PIDs Management (PIDs).

The decoding branch provides monitoring and configuring options for the features of each element in the branch. For details, see Cross Connections.

Transport streams can be routed as they are to the output ports (passthrough). For details, see Passthrough TS Routing.

The ProView 7000 supports up to four multiplex outputs.14
TIP: Creation of multiplex and decoded output streams is detailed in Cross Connections.

Related topics:
- Multiplex Output
- Multiplex Output Properties
- Transport Stream Port Route Property Sheet
- Output Multiplex Program Properties
- Output Multiplex Elementary Stream Properties
- Output Tables Properties
- Output Unreferenced PID Properties
- Decoding Channel Properties

Multiplex Output

Right-click a Multiplex Output icon ( ) or any of the sub elements to display a context menu which comprises the following:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Disable/ Enable</td>
<td>A dynamic command, changing according to the multiplex output operational status.</td>
</tr>
<tr>
<td>Add Other Program...</td>
<td>Enables adding a program from the multiplex input to the multiplex output programs. Note: Not available when the device is configured to pass through the input stream to the output port.</td>
</tr>
</tbody>
</table>

14. A license is required for more than one multiplex output.
If Block DTA is licensed then all the Multiplex Outputs are disabled.

**Multiplexing an Input Program**

To multiplex an input program to the output stream:

1. Select the Add Other Program option in the context menu.
   
The Add Another Program dialog displays.

2. Select the multiplex input port and the program number to multiplex to the output.

**Multiplexing an Input PID**

To multiplex an input PID (either an unreferenced one or a PID from a defined program) to the output stream:

1. Select the Add Unreferenced PID option in the context menu.
   
The Add Unreferenced PID dialog displays.

2. Select the multiplex input port and the PID number to multiplex to the output.
TIP: Multiplexing a Program or a PID can be also done by dragging the program icon or the PID icon from the multiplex input tree and dropping it in the multiplex output tree. For detailed instructions Setting Multiplex Cross Connections.

**Multiplex Output Programs Management**

Click a Programs branch in the **Multiplex, Transcoding & Decoding Output** box to display all the programs related to the multiplex output and the type of information provided by the program.

Each program can be descrambled (marked accordingly by an unlocked / free program icon) and or transcoded. The information provided by each program can be video, audio, ECM or other (marked by representative icons).

**NOTE:** The properties of the output programs and the elementary streams related to each program in the multiplex output stream are detailed in Output Multiplex Program Properties and Output Multiplex Elementary Stream Properties.
Multiplex Output Tables Management

Click a Tables branch in the Multiplex, Transcoding & Decoding Output box to display all the tables related to the multiplex output and the type of information provided by the table.

The Output Tables branch provides access to the following MPEG PSI and DVB PSI/SI tables related to the multiplex output stream:

- The Program Association Table (PAT) for the stream
- The Conditional Access Table (CAT) and the specific Entitlement Management Messages (EMM) included in the CAT
- The specific Program Map Tables (PMTs) for each multiplex program
- The Network Information Table (NIT) – Passed from the input
- The specific Service Description Tables (SDTs)
- The Event Information Table (EIT) – Passed from the input
- The Time and Date Table (TDT/TOT) associated with the stream – Passed from the input

**NOTE:** The displayed tables are managed by the defined stream type (MPEG or DVB). The property of the various output tables in the multiplex output stream is detailed in Output Tables Properties.
Multiplex Output Unreferenced PIDs Management

The Unreferenced PIDs branch in the Multiplex, Transcoding & Decoding Output box displays all the PIDs related to the multiplex output that are not referenced by a specific program or table.

NOTE: The properties of the output unreferenced PIDs in the multiplex output stream is detailed in Output Unreferenced PID Properties.

Decoding Channel Management

Click the Decoding Channel branch in the Multiplex, Transcoding & Decoding Output box to display all the information related to the input program routed to the decoding channel.

The information provided by each program is divided into PCR, Video, Audio 1 and 2, VBI and Subtitling information (marked by representative icons).
Right-click a **Decoding Channel** icon or any of the sub elements in the branch to display a context menu which features the following options:

### Table 7-3: Decoding Channel Context Menu

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Remove Selected] Remove Selected</td>
<td>Remove the selected item, not all items can be removed.</td>
</tr>
</tbody>
</table>
| Remove All                          | Displays the following sub-menu items:  
  - Remove All Output Programs on Port  
  - Remove All Output Programs on Device  
  - Remove All Output Unreferenced PIDs on Port |
| ![Clear Decoding Channel Connection] Clear Decoding Channel Connection | Enables removing the decoding channel connection.  
  Clicking the option displays a confirmation dialog.  
  Note: Active only from the Decoding Channel up-line branch. Not displayed for a specific down drilled elements. |
| ![Refresh Decoding Channel] Refresh Decoding Channel | Updates the Decoding Channel.                                                                                                             |
| ![Properties] Properties            | Displays the marked element property sheet. For details, see *Multiplex, Transcoding & Decoding Outputs*.                                   |

### Passthrough TS Routing

Routing a transport stream to an output creates a **passthrough** output stream, identical to the input TS. In this mode, the stream information is not processed and the output bitrate will be exactly as the input bitrate.

The EMS enables the user to display the programs, tables and unreferenced PIDs available on the transport stream passed-through to the selected output.

Right-click the TS Port Output Port icon or any of the elements in the branch, to display a drop-down menu which features the following items:
Multiplex Output Properties

The Multiplex Output Port property sheet displays the current status of the multiplex output stream features and enables setting up the editable ones.

To display the Multiplex Output Stream property sheet:
1. Select the Multiplex Output icon from the Multiplex, Transcoding & Decoding Output box on the Device Explorer tab.
2. Click Properties on the EMS toolbar.

The information provided by the Multiplex Output property sheet includes the following:
- **Enabled** - Enables (Yes/No) the multiplex output operation.
- **Transport Stream ID** - Displays the transport-stream’s ID number.
- **Table Extraction** - Select PSI/SI for DVB or PSI for MPEG. The default is PSI/SI.
- **Configured Bitrate** - Displays the calculated bitrate of the Multiplex Out (bps). You can only configure the output bitrate when the Multiplex Out is not part of a TS cross-connection. The range is 221,000 - 160,000,000, default 30,000,000 bps. You can configure the multiplex output bitrate and the bitrate of all the other multiplex outputs with the Bitrate Leveling property sheet. The defaults are:
  - **Multiplex Output 1** - 70,000,000 bps

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>✗ Remove Selected</td>
<td>Removes the selected element.</td>
</tr>
<tr>
<td>Remove All</td>
<td>Displays the following sub-menu items:</td>
</tr>
<tr>
<td></td>
<td>- Remove All Output Programs on Port</td>
</tr>
<tr>
<td></td>
<td>- Remove All Output Programs on Device</td>
</tr>
<tr>
<td></td>
<td>- Remove All Output Unreferenced PIDs on Port</td>
</tr>
<tr>
<td>✅ Refresh Transport</td>
<td>Updates the Transport Stream Port Route.</td>
</tr>
<tr>
<td>Stream Port Route</td>
<td>Properties</td>
</tr>
<tr>
<td></td>
<td>Displays the marked element property sheet.</td>
</tr>
<tr>
<td></td>
<td>For details, see Multiplex, Transcoding &amp; Decoding Outputs.</td>
</tr>
</tbody>
</table>

Table 7–4: TS Port Output Port Context Menu
Multiplex Output 2 – 30,000,000 bps
Multiplex Output 3 – 30,000,000 bps
Multiplex Output 4 – 30,000,000 bps

- **Actual Bitrate** – Displays the actual bitrate of the output stream (in bps), not including NULL stuffing.

**Transport Stream Port Route Property Sheet**

The **Transport Stream Port Route** property sheet displays the current status of a transport stream routed to an output port.

To display the **Transport Stream Port Route** property sheet:
1. Select the TS port route icon in the **Multiplex, Transcoding & Decoding Output** box on the Device Explorer tab.
2. Click **Properties** on the EMS toolbar.

![Figure 7-10: Transport Stream Port Route property sheet](image)

The information provided by the **Transport Stream Port Route** property sheet includes the following:

- **Enabled** – Enables (Yes/No) the output port operation.
- **Input Port** – Displays the multiplex input port name.
- **Transport Stream ID** – Displays the transport stream ID number.
- **Output Port** – Displays the stream output port name.
• **Passed Program list** – Displays a list of the programs passed in the stream and their descrambling status.
  Click **Add** next to the list to open an **Add Other Program** property sheet which enables you to define expected programs in the received transport stream (and not available when the TS was routed) and to assign a descrambling CAM slot or BISS or Verimatrix to the program.

![Add Other Program dialog](image)

**Figure 7-11: Add Other Program dialog**

• **Descrambling Configuration**
  - Not Descrambled
  - CAM Slot 1
  - CAM Slot 2
  - CAM Slot 3
  - CAM Slot 4

• **Descrambling Status**
  - Descrambled
  - Not Descrambled

**Output Multiplex Program Properties**

The **Output Program** property sheet provides basic information on the output program provided by the output multiplex.

To display the **Output Multiplex Program** property sheet:

1. Select the required Output Program icon from the **Multiplex and Decoding Output** box on the Device Explorer tab.
2. Click **Properties** on the EMS toolbar.

![Program property sheet for Program Cross Connect](image1)

**Figure 7-12: Program property sheet for Program Cross Connect**

![Program property sheet for TS Cross Connect](image2)

**Figure 7-13: Program property sheet for TS Cross Connect**

**Related Topics:**

- Program property sheet for Program Cross Connect
- Program property sheet for TS Cross Connect

**Program property sheet for Program Cross Connect**

The **Program** property sheet for a cross connected program comprises the following:

- **General** tab
  - **Enabled** – Define the operational status of the program.
  - **Input** box
    - **Port** – Display the name of the input multiplex which receives the stream
    - **Program Number** – Display the number of the multiplex program
  - **Output** box
Multiplex, Transcoding & Decoding Outputs

- **Program Number (1 to 65535)** - Display the number of the multiplex program routed to the port.
- **PID Offset (0 to 4096)** - Display the ES PID offset.
- **PCR PID**
- **PMT PID**

- **Transcoding** box
  - Transcoding - Mark to enable transcoding.

- **Descrambling** box
  - Descramble With - To configure descrambling for the selected program, mark the descrambling check box and select a CAM or BISS or Verimatrix to use for descrambling. A BISS key must be configured before the BISS option displays here, see BISS Table Management.
  - BISS Key - Select a BISS Key from the list when Descramble With is configured with BISS.
  - Descrambled Status - The associated CAM or BISS displays here.
  - **Forwarding Mode** - To use this feature you must first configure the Descramble With option with a CAM. There are two descrambling modes to choose from:
    - Automatic - All ES PIDs that belong to the program are forwarded and descrambled (Default).
    - Selective - In this mode, ES PIDs found in the PMT table displays in the Forwarding Mode box. Use the Add button to add pre-provisional PIDs not found in the program tables. Only the ES PIDs with the Forward checkbox marked are forwarded to the output and descrambled. You must mark at least one ES PID.

- **Transcoding** tab - See Program Cross Connection for an explanation of the parameters.

**Program property sheet for TS Cross Connect**

The Program property sheet for a cross connected TS comprises the following:

- **Descramble With** - To configure descrambling for the selected program, mark the descrambling check box and select a CAM or BISS or Verimatrix to use for descrambling. A BISS key must be configured before the BISS option displays here, see BISS Table Management.
- **BISS Key** - Select a BISS Key from the list when Descramble With is configured with BISS.
- **Descrambled Status** - The associated CAM or BISS displays here.
- **Descrambling Mode** - To use this feature you must first configure the Descramble With option with a CAM.
  - Automatic - All ES PIDs are forwarded and descrambled (Default).
  - Selective - In this mode, ES PIDs found in the PMT table displays in the Descrambling Mode box. Use the Add button to add pre-provisional PIDs not found in the program tables. Only the ES PIDs with the Descramble checkbox marked are descrambled. You must mark at least one ES PID.

**Output Multiplex Elementary Stream Properties**

The Output Elementary Stream (ES) property sheet provides basic information on the output stream included in the output program provided to the output multiplex.

To display the Output Multiplex ES properties:
1. Select the required ES icon (Video 🎥, Audio 🎧 or Other 🎣) in the **Multiplex and Decoding Output** box on the Device Explorer tab.
2. Click **Properties** on the EMS toolbar.

![Figure 7-14: Video Elementary Stream property sheet](image)

The information displayed by the Output Multiplex ES property sheet includes the following:

- **PID** – The program identification number (PID) of the output elementary stream type
- **Type Description** – The ES type
- **Stream Type (hex)** – The ES type code
- **Stream Type Description** – Encoding and description
- **Language** – The language code for the ES (Not applicable for Video ES)
- **Input Program** – The number of the input program multiplex to the output program
- **Input Elementary Stream PID** – The PID of the input elementary stream multiplex to the output program

**Output Tables Properties**

The **Multiplex and Decoding Output** box on the Device Explorer tab provides managing access to the DVB PSI/SI related tables provided in the multiplex output stream.

These tables include:

- Program Association Table (PAT)
- Program Mapping Table (PMT)
- Conditional Access Table (CAT)
- Service Description Table (SDT)
- Network Information Table (NIT)
- Event Information Table (EIT)
- Time and Date Table (TDT/TOT)

To display the Output Tables properties:

1. Select the required Output Table icon from the **Multiplex and Decoding Output** box on the **Device Explorer** tab.
2. Click **Properties** on the **EMS** toolbar.

The information provided for each of the output tables includes the following:

- **Table Passed State** - Enables selecting the table source for the multiplex output. Options are:
  - Generated by the Device
  - Passed from the Input
  - Not Passed
- **Repetition Rate** - Enables setting up the table transmission repetition rate (in msec).
- **Transport Stream ID** - Displays the identification of the transport stream for the table.
- **Version** - Displays the table version.
- **Number of Sections** - Displays the number of sections used to construct the table.

**The PMT**

The Program Mapping Table (PMT) consists of a group of programs that can independently be enabled to the multiplex output.

The **PMT** property sheet enables setting the repetition rate for all PMTs and the specific PMT property sheet enables setting the table source and displays the table version and number of sections.
The CAT

The Conditional Access Table (CAT) consists of one (or more) Entitlement Management Message (EMM). Select the CAT icon and click the Properties button to display the common properties for the all EMMs in the CAT.

The EMM

Select a specific EMM icon in the CAT and click the Properties button to display the following information for the EMM: output and input PID, input port name and CA system ID.

The SDT

The Service Description Table (SDT) consists of a group of services with specific parameters. Each specific SDT property sheet provides the service provider information, the service ID, service type and service name, the service operational status and the service CA operational mode.

Output Unreferenced PID Properties

The Output Unreferenced PID property sheet provides basic information on an unreferenced stream provided to the multiplex output.

To display the Output Unreferenced PID properties:

1. Select the required Unreferenced PID icon in the Output Multiplex & Decoding box on the Device Explorer tab.
2. Click **Properties** on the **EMS** toolbar.

![PID Properties](image)

The information provided by the **Output Unreferenced PID** property sheet includes the following:

- **Output PID** – Displays the PID number of the multiplex output stream.
- **Type** – Displays the type of the PID (Unreferenced).
- **Input Port** – Displays the name of the input physical port which receives the stream.
- **Input PID** – Displays the PID number of the related input stream.

### Decoding Channel Properties

To configure the decoding channel properties:

- Right-click a decoding channel in the **Multiplex, Transcoding & Decoding Output** box, see Figure 6–2 for the box location.

**Related Topics:**

- **Service Parameters Tab**
- **Video Parameters Tab**
- **PCR Parameters Tab**
- **Audio Parameters Tabs**
- **VBI/VANC Tab**
- **OSD Tab**
- **DPI To GPI Tab**

### Service Parameters Tab

The **Service** parameters tab provides the **EMS** user the following information and set-up capabilities:

- **Source** box – Displays the stream input source and input program name for the decoder.
  
  - **Service Selection Mode** drop-down menu. Options are:
    - **Automatic** - Use this mode for ProView 7000 to automatically decode the first program in the TS (first PMT). In this mode PID selection is automatic but you can select **None** in the list in the PID Selection box.
    - **Program** - Use this mode to set the decoder to manual program selection. In this mode use the DPI section to select:
      - **Automatic**
      - **None**
Multiplex, Transcoding & Decoding Outputs

- Manual
  - PID - Use this mode to set the decoder to manual PID selection.
  - No Decoding - Use this mode to disable decoding
- Multiplex - Select the multiplex in
- Input Program - Select the input program

  **PID Selection** box - Displays the PID for the program PCR and to select the elementary stream PID for the Video and the VBI/VANC processing. It also enables the user to set the ES PID and preferred language for each one of the two audio streams (Audio1 and Audio2).
- PCR
  - Decoded PID - Displays the decoded PID
- Video
  - Decoded PID - Displays the decoded PID
  - PID Selection
    - Automatic - Select the video PID with the lowest number in the PMT
    - None - No PID selection
    - {PID number} - Select a video PID by its number
- Audio 1 - 4
  - Decoded PID - Displays the decoded PID
  - PID Selection
    - Automatic - Select the audio PID with the lowest number in the PMT
    - None - No PID selection
    - {PID number} - Select an audio PID by its number
  - Preferred Language
    - By Priority - The audio PID to decode is selected according to its priority in the PMT, enter a priority 1 - 4 (1 is the primary audio). If the program has less audios than the configured priority, no PID is selected.
- DPI (SCTE-35)
  - Decoded PID - Displays the decoded PID
  - PID Selection
    - Automatic - Select the DPI PID with the lowest number in the PMT
    - None - No PID selection
    - {PID number} - Select a DPI PID by its number
- VBI
  - Decoded PID - Displays the decoded PID
  - PID Selection
    - Automatic - Select the VBI PID with the lowest number in the PMT
    - None - No PID selection
    - {PID number} - Select a VBI PID by its number
Program Redundancy

NOTE: This feature is only available when you have a Program Redundancy license, the device is not controlled by the DMS or the device is controlled by the DMS but the decoder local override is allowed, and the decoder Service Mode is Program.

- Redundancy Control - Options are:
  - Off (Default)
  - DMS – Only displayed when the Service Redundancy is controlled by the DMS. In that case the DMS configuration decides what the active program is and no other fields are shown.
  - Alarms – The selection of the active program is according to the configured Program Redundancy Scheme and the selected triggers.
  - Input Redundancy – The active program is based on the active source port of the Multiplex Input of the primary program. When the Primary Source Port is active, the Primary program will be active. When the Backup Source Port is active, the decoder will decode the backup program

- Redundancy Scheme - Only when Redundancy Control is Alarms. Options are:
- **Manual** – You can manually switch between the primary and the backup program.
- **Manual Revert** – (Default when Multiplex is None) The device switches from the primary program to the backup program when the primary program fails on one of the redundancy triggers. You can revert from the backup program to the primary program manually.
- **Automatic** – (Default when Multiplex is not None) The device switches to the standby program whenever the active program fails on one of the redundancy triggers. A switch back to the primary program occurs when the backup program contains errors.
- **Pre-Descramble** – (Default is Disabled) When enabled, the device will descramble the backup program while it is not active.
- **Active Program** – Primary or Backup depending on the actual status of the device.
  - **Backup Source box** – Only when Redundancy Control is Input Redundancy or Alarms.
  - **Multiplex** – Either one of the available Multiplex Inputs or None. When the None is selected and the switch to the backup program is triggered, the output will be muted.
- **Input Program (1 - 65535)** – The Input Program Number of the backup program.
- **Descramble with** – Use this feature to select the relevant CAM slot or BISS descrambling.
  - CAM Slot 1
  - CAM Slot 2
  - CAM Slot 3
  - CAM Slot 4
  - BISS
  - Verimatrix
- **Descrambled Status** – Shows whether the program is being descrambled.
  - **Triggers** – Only when Redundancy Control is Alarms
    - **No PCR Detected Alarm** – Enabled (Default) or disabled.
    - **Video Decoding Failure Alarm** – Enabled (Default) or disabled.
Figure 7-16: Decoding Channel Properties - Service tab with Program Redundancy

**Video Parameters Tab**

Use the **Video** configuration tab to set up the decoded video stream output parameters for the modulated program.
Figure 7-17: Decoding Channel Properties - Video tab

- **Decoding Codec** - Selects the video decoding mode. Options are:
  - Automatic
  - MPEG-2
  - H.264

- **Display Format** - Selects the video display format. Options are:
  - SD
  - HD
  - Automatic

- **Video Format** - Selects the video format. Options are:
  - NTSC
  - PAL-B/G, -I, -D, -M, -N
  - French SECAM - The CV monitor output - Outputs Russian SECAM as French SECAM.

- **Aspect Ratio** - Selects the aspect ratio conversion for the output stream. To be performed if the incoming stream aspect ratio is not the same as the configured output aspect ratio. Options are (related to selected aspect ratio):
  - Passthrough
  - 4:3 Aspect ratio
  - 16:9 Aspect ratio

- **Aspect Ratio Conversion 16x9 to 4x3**
  - Letterbox
  - Full Screen
  - AFD

- **Aspect Ratio Conversion 4x3 to 16x9**
- **Pillarbox** (Side-bars)
- **Center-cut**
- **Full Screen**
- **AFD**

  **HD Format** – This parameter only displays when the display format is HD.
  - **720p @ 50**
  - **720p @ 59**
  - **720p @ 60**
  - **1080i @ 50**
  - **1080i @ 59**
  - **1080i @ 60**

  **Selected Display Format** – This parameter only displays when the **Display Format** parameter is set to **Automatic Resolution**.

- **Analog outputs** – Sets the parameters for the SD analog (CV) monitoring output.
  - **Video 625 Format**
    - **PAL B/G**
    - **PAL I**
    - **PAL D**
    - **PAL N**
    - **French SECAM**
  - **Video 525 Format**
    - **NTSC**
    - **PAL M**

*Advanced* video processing parameters:

- **Blanking** – Selects the response for blanking mode (underflow). Options are:
  - **Black**
  - **Mute** – Select this option to have nothing on the SDI out port when there is no video input.
  - **Last Field**
  - **Last Frame**
  - **Bar**

- **Buffer Management** – Options are:
  - **Normal**
  - **Low Delay** – Select this option to use Low Delay mode.
  - **GI Mode**

- **Additional Image Processing**

- **Buffer Resizing Mode** – Options are:
  - **Dynamic** (Default)
  - **Static**

- **Video Errors Recovery Mode** – Advanced feature. Options are:
  - **Full** – (Default)
  - **Partial**
Multiplex, Transcoding & Decoding Outputs

- None
- High

**PCR Parameters Tab**

The PCR parameters tab provides the EMS user the following information and set-up capabilities:

- **Clock Source** – You can select one of the following clock sources:
  - Original PCR
  - Decoder Clock
  - Genlock\(^{15}\) – Use this menu to sync with the incoming signal. The Genlock menu enables two radio buttons:
    - Analog – Analog genlocking supports PAL B/G, NTSC, 720P (50, 59, 60 Hz) and 1080i (50, 59, 60 Hz). The main output must be configured to PAL B/G or NTSC. When you use an analog clock source you can configure the following:
      - Horizontal Delay – The range is 0 – 1728 in 37 ns or 27 MHz ticks. The default is 0.
      - Vertical Delay – The range is -7 – 6. The default is 0.
      - SCH Phase Delay – The range is 0° – 360°. The default is 0.
    - Digital – Digital genlocking supports PAL B/G, NTSC, 720P (50, 59, 60 Hz) and 1080i (50, 59, 60 Hz). The main output must be configured to PAL B/G, NTSC, 720P (50, 59, 60 Hz) or 1080i (50, 59, 60 Hz).

    You must select either **Analog** or **Digital**. The default is **Digital**.

- **A/V Sync** – You can select one of the following audio/video synchronization parameters:
  - Off
  - Frame – Select this parameter to limit the audio/video sync jitter to 1 frame.
  - 5 ms – Select this parameter to limit the audio/video sync jitter to 5 ms when the clock source is set to Original PCR.

- **A/V Offset Compensation** – Sets the A/V offset compensation. You can only use this parameter with the 5 ms parameter. The range is -20 – 20 ms. The default is 0.

- **Decoding Buffer Delay** – Sets the delay time for the buffer. Range: 1 – 300 msec. The default is 100.

**CAUTION:** Changing the Decoding Buffer Delay value may cause unpredictable implications in the operation of the device. Consult Harmonic support before changing this parameter.

---

\(^{15}\) Only available with certain hardware configurations, see Front End Card Features.
Audio Parameters Tabs

The Audio parameters tabs provide you the following information and set-up capabilities:

**General** processing parameters on each audio tab:

- **Decoding Codec** – Selects the audio decoding mode. Options are:
  - Automatic
  - Dolby Digital\(^{16}\) (AC-3)
  - Dolby Digital (AC-3) Passthrough
  - Dolby Digital Plus\(^{16}\) (E-AC-3) (Audio 1 channel only)
  - DD+ (E-AC-3) to DD (AC-3) Passthrough (Audio 1 channel only)
  - DD+ (E-AC-3) Passthrough – (4 Channel audio board only)
  - DD+ (E-AC-3) Passthrough to Dolby Digital (AC-3) – (2 Channel audio board only)
  - Musicam
  - AAC LC (Audio 1 channel only)
  - HE AAC (Audio 1 channel only)
  - **Dolby E\(^{16}\) / Linear PCM Passthrough** (Audio 2 channel only)

- **Preferred Processing Type**
  - Passthrough
  - DownMix/Decode 2.0 – (Default)
  - Decode 5.1 – (4 Channel audio board only, ports 1 and 2)

- **Volume** – Sets the audio volume.
  Range: • 64 to 0 dB

---

- **Delay** - The delay.  
  Range: \( -128 \) to \( +128 \) msec.

- **Mixer** - Use to select the stereo output mixing options. Options are:
  - **Stereo**
  - **Mono** (Analog only)
  - **Both Left**
  - **Both Right**

- **Digital Format** - Selects the audio format mode. When using Dolby Digital Passthrough, this parameter has no effect. Options are:
  - **Professional**
  - **Consumer**
  - **Follow the Input**

- **Output Sample Rate** - Audio 1 and 2 only (4 Channel audio board only). Default is **Follow the Input**.
  - **Follow the Input**
  - **48 kHz**

**Dolby Digital (AC-3) processing parameters:**

- **Down Mixing Mode** - Selects the mixing mode for the output.
  - **LoRo**
  - **LtRt**

- **Operational Mode** - Selects the mode of operation for Dolby Digital processing.
  - **Line Out**
  - **RF Remod**

---

**Figure 7-19: Decoding Channel Properties - Audio tabs**
**SDI Tab**

Use the **SDI** tab to configure audio channels for SDI groups. Each group has four audio channels (pairs 1+2 and 3+4, referred to as two stereophonic-channels), see *Figure 7–21*. Once the group is selected, the user must select the stereophonic channel of the audio source.

**NOTE:** All four audios must be used on the SDI tab even if they have no input.

*Figure 7–20: Decoding Channel Properties - SDI tab*

*Figure 7–21: SDI Embedded channels*
SDI Groups - With two audio boards, Audio 1 is always the first pair of channels in a group and Audio 2 is always the second pair of channels in a group. Four audio board defaults are:

- **Audio 1** - Group 1 Pair 1.
- **Audio 2** - Group 1 Pair 2.
- **Audio 3** - Group 2 Pair 1.
- **Audio 4** - Group 2 Pair 2.

The editable properties comprise the following:

- **Group** - There are four SDI groups to choose from. The default is **Group 1**.
- **Pair** - Select **N/A** or **Audio 1-4**.
- **Channel** - When **Preferred Processing Type** is **Decode 5.1**, you need to configure this parameter to something other than **N/A**.
  - **N/A**
  - **L/R**
  - **C/LFE**
  - **LS/RS**

VBI/VANC Tab

The **VBI/VANC** tab enables you to insert VBI/VANC data from different sources into the decoded video. You can insert several VANC datum items into the same line but you cannot insert several VBI items into the same line and you cannot insert VBI and VANC into the same location.

![Decoding Channel property sheet - VBI/VANC tab](image)

The tab provides the following configuration Options are:

**VBI/VANC** parameters:

- **CC** (Closed Captions) (Default: Enabled)
  
  Source: Video ES
NTSC Parameters:
- **AMOL** (Automatic Measurement Of Line-Ups)
  Source: VBI ES
- **TVG** (TV Guide)
  Source: VBI ES

PAL Parameters:
- **WSS** (Wide Screen Signalling)
  Source:
  - Decoder
  - VBI ES
  - Video ES
  - WSS-AFD (when using AFD)
- **TTX** (Teletext EBU)
  Source: VBI ES
  - SMPTE-2031
  - OP-47
- **VPS** (Video Program System)
  Source: VBI ES

General Parameters:
- **VITS** (Vertical Interval Test Signals)
  Source: Decoder
- **VITC** (Vertical Interval Time Code)
  Sources:
  - Decoder
  - VBI ES
  - Video ES
- **VI/AFD** (Video Index)
  Sources:
  - VBI ES
  - Video ES
- **M422** (Monochrome 4:2:2)
  Source: VBI ES
- **SCTE-104**
  Source: DPI PID

SCTE-104 Parameters:
- **ASI Index**
- **DPI PID Index**
OSD Tab

Use the **OSD** tab to configure the insertion of DVB Subtitling and VBI Teletext subtitles. It operates in Auto Mode and Program Mode in HD and SD. The **OSD** tab provides the EMS user the following information and set-up capabilities:

- **Subtitling Type:**
  - **DVB** – One PID is used per language
    - Decoded PID
    - PID
      - Automatic
      - None
      - {PID number} – You can select a PID from the ES that is described either as DVB subtitling or data therefore anything other than audio, video or DPI). Use this option when the PID has no 59 descriptor.
    - Preferred Language

![Decoding Channel Properties - OSD tab](image)

**Figure 7-23: Decoding Channel Properties - OSD tab**

- **VBI Teletext** – You can search by page or preferred language
  - Current PID Page
  - Current PID Preferred Language – First page that contains the specified language

Disabled

- **Subtitles Zoom and Position**
  You can set the following:
  - **Zoom** – Options are:
    - ½
    - 0
    - X2
    - X3
- **X Position** – Range 100 to 100, the default is 0
- **Y Position** – Range 100 to 100, the default is 0

**DPI To GPI Tab**

Use the **DPI To GPI** tab to configure SCTE 35 commands to switch GPI relays for Digital Program Insertion. It comprises the following sub-menus:

- **Pre-Roll** – Use to configure the pre-roll.
- **Out Of Network Trigger Relay** – Use to configure the **Out Of Network** alarm switch.
- **RTN Trigger GPI Port** – Use to configure the **Return to Network** alarm switch.

**Figure 7–24: Decoding Channel Properties - DPI tab**

**Physical Outputs**

The **Physical Output** box of the **Device Explorer** tab presents a hierarchical tree-structure of the ProView 7000 physical output ports for monitoring and configuring the features of each element displayed in the tree, see **Figure 6–2** for the box location.

The ProView 7000 features various types of outputs:

- **ASI output ports**
- **GbE ports and sockets**

When the decoder module is installed in the ProView 7000 device the module provides a wide range of physical video and audio interfaces. All interfaces are displayed under the decoder card branch. From the tree view you can configure the HDMI port to output DVI or HDMI.  

---

17. Only with the single decoder card.
Right-click the device icon or any of the sub-elements in the Physical Output box to display a context menu which includes the following items:

**Table 7-5: Device Icon Context Menu**

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Refresh" /></td>
<td>Updates the physical outputs for the selected device.</td>
</tr>
<tr>
<td><img src="image" alt="Properties" /></td>
<td>Displays the marked element property sheet for the marked element. For details, see ASI Output Port Properties, GbE Port Properties, GbE Socket Properties and MPE Properties. Note: No properties are available for the decoder output interfaces.</td>
</tr>
</tbody>
</table>

**Figure 7–25: Physical Output box**

Related topics:
- ASI Output Port Properties
- GbE Ports for Output
- HDMI and DVI Output

**ASI Output Port Properties**

The ASI Output Port property sheet displays the basic features of the selected ASI Output Port element.

To display the ASI Output Port properties:
1. Select the required ASI Output Port icon in the Output Physical box on the Device Explorer tab.
2. Click **Properties** on the EMS toolbar.

The information provided by the ASI Output Port property sheet includes the following:

- **Description** – Displays the identification name of the ASI output port.
- **Connected Output Multiplex Port** – Enables selecting the multiplex output to connect to the ASI output port.

### GbE Ports for Output

The GbE branch comprises of four sockets, two GbE ports and configurable GbE properties. All sockets are associated to both GbE ports by default.

#### GbE Port Properties

Use the GbE Port property sheet to view and configure the selected GbE port. You can enter a virtual IP address for the GbE port for redundancy purposes. The virtual IP address overrides the source IP address on the IP header.

**NOTE:** Changing GbE port properties reflects in the Physical Input and Physical Output boxes.

To display the GbE port properties:

1. Select the required GbE port icon in the Physical Output box on the Device Explorer tab.
2. Click **Properties** on the EMS toolbar.

The GbE Port property sheet displays.

The GbE Port property sheet comprises of a **General** and an **Advanced** tab.

#### GbE Port General properties tab:

- **Enabled** – You can enable either or both GbE ports. The default is Disabled.
- **IP Profile** – Enables you to configure the following:
  - **IP Address** – The IP Address must be a multicast IP address. The default is 127.127.0.X, where X is the port number.
  - **Mask** – The IP mask. The default is 255.255.255.0.
  - **Gateway** – The default is 127.127.0.1.
- **MAC Address** – Each port has its own MAC Address. They are factory set and cannot be changed.
- **Override Source IP** – Enables the user to send a virtual IP address.
**Connectivity** – Displays the address of the GbE socket related to the port.

![Figure 7-26: GbE Port property sheet- General tab](image)

GbE Port Advanced properties tab:
- **Auto negotiation Enabled** – You can enable and disable Autonegotiation. The default is Yes.
- **Duplex Mode** – You cannot change the Duplex Mode. It is fixed at Full Duplex.
- **Speed** – You can configure the PHY speed when Autonegotiation is disabled. The default is 1000.

![Figure 7-27: GbE Port property sheet - Advanced tab](image)

**GbE Socket Properties**

Use the GbE Socket property sheet to view and configure the selected GbE port. By default all sockets are associated with both GbE ports. The data on each socket is sent to both output ports. You cannot associate two sockets with identical destination port and IP addresses to the same GbE port.

To display the GbE Socket properties:
1. Select the GbE Socket icon in the **Physical Output** box on the **Device Explorer** tab.
2. Click **Properties** on the EMS toolbar.

The GbE Socket property sheet comprises of a **General** and an **Advanced** tab.

GbE Socket General properties tab:
- **Enabled** - You can enable or disable each socket.
- **General** parameters box:
  - **Destination IP Address** - Only multicast IP addresses are supported. The default is 255.1.1.X, where X is the socket index.
  - **Destination UDP Port** - The destination UDP Port range is 0 – 65535. The default is 1000.
  - **Source UDP Port** - The source UDP Port range is 0 – 65535. The default is 1024.
- **Connectivity** box – Enables you to associate the socket with a multiplex out and displays the physical GbE ports associated with the socket.

![GbE Socket property sheet- General tab](image)

**Figure 7-28: GbE Socket property sheet- General tab**

GbE Socket Advanced Properties tab:
- **Encapsulation Mode** - The encapsulation mode used for the GbE port is UDP.
- **MPEG Packets/Frame** - The number of MPEG packets for each frame. The range is 1 – 7. The default is 7.
**Time To Live** – You can set the time to live (TTL, number of hops). The range is 1 – 255. The default is 64.

**Figure 7–29: GbE Socket property sheet- Advanced tab**

**MPE Properties**

Use the MPE property sheet to configure one MPE PID source for GbE out. There are three service selection modes, Program, PID and Disabled. The selected MPE PID displays in the **Status** box.

To display the MPE property sheet:

1. Expand the **Ports** and **GbE** branches in the **Physical Output** box on the **Device Explorer** tab.
2. Select **MPE**.
3. Click **Properties** on the EMS toolbar.

**Program Mode**

Use Program Mode to select a program from a list. The procedure is:

1. Select a multiplex in.

EMS lists all the input programs in that multiplex that contain MPE PIDs.

18. Requires a license.
2. Select a program from the list and apply.

**PID Mode**

Use PID mode to select a multiplex and enter the input PID number.

**Disabled**

Use Disabled mode to disable MPE PID selection.

**HDMI and DVI Output**

You can attach a video monitor to the HDMI port to monitor decoded video. The HDMI port supports HDMI and DVI modes.

To change the mode of the HDMI port:

1. Right-click **HDMI Monitor Video Port 1** under Decoders in the Physical Output box.
2. Select **Properties** in the drop-down menu.
   
   The HDMI Monitor Video Port 1 property sheet displays.
3. Select one of the following modes in the Output Mode drop-down menu:
   - HDMI
   - DVI
   
   The default is **HDMI**.

**Element Properties**

The Element Properties Configuration function, provided by the ProView 7000 EMS, allows monitoring and setting ProView 7000 properties at device level and down to specific operational elements in the device.

This element can be a device selected in the Device box or any object selected on the Device Explorer tab.

The information displays on an Element Properties Configuration pop-up property sheet.

Opening the Element Properties Configuration Management property sheet can also be done in one of the following ways:

- Select the element then select **File > Properties** in the EMS Menu bar.
- Select the element and click **Properties** on the EMS toolbar.
- Right-click the element then select Properties on the drop-down menu.

---

**TIP:** Element Properties Management Tips

Activating the **Properties** function for any element displays a pop-up property sheet which lists the properties of the selected element. Some of the properties are displayed in an editable field featuring either a pull-down select options menu (for selecting a new value for the property) or a free text (for free text setting of a new value/description). Some of the properties are informative only and cannot be changed by the EMS user.
Cross Connections

The ProView 7000 provides the ability to cross connect the input stream information to the processing functions and the outputs of the device with DSR support. These functions are made easy by EMS and includes cross connecting inputs to outputs, selecting inputs for output decoding channels, defining the inputs for the CA modules and transcoding19.

The ProView 7000 has up to four (4) input multiplexes and up to four (4) output multiplexes.

Transcoding

ProView 7100s equipped with transcoders can transcode the input video. ProView 7100s equipped with transcoders have 2 input multiplexes. Transcoding is performed with a program cross connect from the first input multiplex to any licensed output multiplex. You can transcode as many programs as you have licenses and transcoders in a ProView 7100.

Figure 7–30: Dynamic Program Cross Connection

The EMS provides wizards to guide the user in creating these connections.

Related Topics:
- Setting Multiplex Cross Connections
- Input to Decoder Channel Connection
- Editing and Deleting

Setting Multiplex Cross Connections

The ProView 7000 features multiplexing any input stream to different outputs of the device. The EMS makes it easy to cross connect an input stream, any program in the input stream or any EMM in the input Conditional Access Tables (CAT). You can cross connect any program from any input multiplex to any output multiplex as long as there are no programs from another input multiplex already cross connected to the same output multiplex. You can cross connect up to four transport streams from the RF and four (4) ASI inputs. You can connect any physical input to as many multiplex inputs as you want.

Furthermore, the EMS enables multiplexing any input PID, including PIDs in the received programs, as unreferenced multiplex output PIDs.

19. ProView 7100 only. Requires a license and transcoding hardware.
Transport Stream Cross Connect (TS Passthrough)

You can cross connect transport streams between different multiplex inputs and outputs and optionally remap selected PIDs.

To create a transport stream cross connection:

1. Drag a multiplex from the Multiplex Input box and drop it onto a multiplex out or a decoder in the Multiplex, Transcoding & Decoding Output box.

   A Cross-Connect editor property sheet displays, allowing setting up the parameters for the routed element.

2. Click Create to create the stream cross-connect.

Remapping PIDs

Prerequisites:

- DSR license
- Transport stream cross connection

To remap PIDs:

1. Right-click Transport Stream Port Route in the Multiplex, Transcoding & Decoding Output box.
2. Select Properties.
3. Select the PID Remapping tab.
4. Enter the Input PID and the Output PID.
5. Click Submit.

Program Cross Connection

You can cross connect programs from a multiplex in the Multiplex Input box with a multiplex in the Multiplex, Transcoding & Decoding Output box, configure CAM descrambling and if you have a ProView with a transcoding card, you can configure program transcoding.

The following options are available in the Dynamic Program Connection Configuration property sheet:

- **Enabled** – Define the operational status of the program.
- **Input** - Display the name of the input multiplex which receives the stream and the number of the multiplex program.

- **Output** - Display the name of the output multiplex port where the stream is routed, the number of the multiplex program routed to the port and the PID offset.

- **Transcoding box**
  - **Transcoding** - Mark to enable transcoding.

- **Descrambling box**
  - **Descramble With** - To configure descrambling for the selected program, mark the descrambling check box and select a CAM or BISS or Verimatrix to use for descrambling. A BISS key must be configured before the BISS option displays here, see BISS Table Management.
  - **BISS Key** - Select a BISS Key from the list when Descramble With is configured with BISS.
  - **Descrambled Status** - The associated CAM or BISS displays here.

- **Forwarding Mode** - To use this feature you must first configure the Descramble With option with a CAM. There are two descrambling modes to choose from:
  - **Automatic** - All ES PIDs that belong to the program are forwarded and descrambled (Default).
  - **Selective** - In this mode, ES PIDs found in the PMT table displays in the Forwarding Mode box. Use the Add button to add pre-provisional PIDs not found in the program tables. Only the ES PIDs with the Forward checkbox marked are forwarded to the output and descrambled. You must mark at least one ES PID.

If you have a ProView with a transcoding card, you can configure the following parameters on the Transcoding tab (see figure below):

- **General** - General transcoding parameters
  - **Resolution Conversion** - Options are:
    - SD to SD
    - HD to SD – (Default)
    - HD to HD
  - **Original Coding Format** - Options are:
    - H.264 – (Default)
    - MPEG-2
  - **Coding Format** - The target coding format - Options are:
    - MPEG-2 – (Default)
    - H.264
  - **Resolution** - The target resolution. Options are:
    - Follow the Input – Only available when there is no resolution conversion (Default when there is no resolution conversion)
    - 720 – Only available when output is SD (Default when transcoding HD to SD)
    - 704 – Only available when output is SD
    - 544 – Only available when output is SD
    - 528 – Only available when output is SD
    - Follow the input – Only available when output is HD (Default)
    - 1280/720P – Only available when output is HD
- 960/720P – Only available when output is HD
- 1920/1080i – Only available when output is HD
- 1440/1080i – Only available when output is HD
- 1280/1080i – Only available when output is HD

- **Profile** – The target profile. Default is **Main**.
  - Main
  - High – Only available when the **Coding Format** parameter is H.264.

- **Bitrate (bps)** – The target bitrate. Options are:

  - **Aspect Ratio** – The **Aspect Ratio** parameters are only available when transcoding HD to SD.
    - **Aspect Ratio** – The target aspect ratio. Options are:
      - 4:3
      - 16:9

  - **Aspect Ratio Conversion** – The target aspect ratio conversion. Options are:
    - Letter box
    - Center-cut
    - AFD (fall back to letter-box) – (Default)
    - AFD (fall back to Center-cut)

  - **User Data**
    - **Close Caption Conversion** – Options are:
      - Passthrough – Only available when **Original Coding Format** and **Coding Format** parameters are the same and **Resolution Conversion** is **SD to SD** or **HD to SD**.
      - **Discard**
      - ATSC A/53 – (Default for H.264 to MPEG-2 transcoding)
      - DiviCom Line 21 – Only available when the **Coding Format** parameter is MPEG-2 and **Resolution Conversion** is **SD to SD** or **HD to SD**.
      - SCTE-20 – Only available when the **Coding Format** parameter is MPEG-2 and **Resolution Conversion** is **SD to SD** or **HD to SD**.
      - NADBS – Only available when the **Coding Format** parameter is H.264 and **Resolution Conversion** is **SD to SD** or **HD to SD**.

    - **AFD** – Options are:
      - Re-Insert – (Default)
      - Discard

    - **Other** – Options are:
      - Re-Insert – (Default)
      - Discard

  - **GOP**
    - **Mode** – Options are:
Cross Connections

- Follow the input – (Default)
- Fixed (N & M)
- Variable (N & M)
- Capped (M follows the input)
- Fixed M
- **Open/Close** - Options are:
  - Follow the input – (Default)
  - Open
  - Close
- **Mini GOP Length (M)** - HD to HD and SD to SD Resolution Conversion Options:
  - 4 - (Default)
- HD to SD Resolution Conversion Options:
  - 1
  - 2
  - 4 - (Default)
- **GOP Length (N)** - Options are:

**Advanced**
- **MCTF Level** - Options are:
  - Off – (Default)
  - Very Weak
  - Weak
  - Normal
  - Strong
  - Very Strong
- **Adaptation Field Injection** check box
- **PES Insertion Rate** – This parameter is only applicable when the output Codec is **H.264** and **Resolution conversion** is **SD to SD** or **HD to SD** or **HD to HD** and the output resolution is either **Follow the Input** or 1080i. Options are:
  - Every Picture – When set to Every Picture the it inserts the PES into every field (Default).
  - Alternate – When set to Alternate it inserts the PES into every frame.
- **Set-Top Box Mode** – Fixed at DVB when output is **HD** or **Coding Format** is **H.264**. Options are:
  - DVB – (Default)
  - Motorola
  - Phillips

**NOTE:** Changing some transcoder parameters causes a delay of a few seconds in transcoding.

To create a new program cross connection:

1. Drag a program from a multiplex in the **Multiplex Input** box and drop it onto a multiplex out in the **Multiplex, Transcoding & Decoding Output** box.
The **Dynamic Program Connection Configuration** property sheet displays enabling you to configure the Program Details and Transcoding tabs.

2. Configure the required parameters.
3. If you have a transcoding card, you can mark the **Transcoding** check box and configure transcoding on the **Transcoding** tab.
4. Click **Create** to create the program cross-connect.

The program name displays under Programs in the **Multiplex, Transcoding & Decoding Output** box. The TS identity and source multiplex numbers display after the output multiplex name. See Figure 7–30.

**CAT EMM Cross Connection**

To create a new CAT EMM cross connection:

1. From the **Multiplex Input** box, drag the icon of the required EMM and drop it into the CAT icon in the **Multiplex and Decoding Output** box.
Cross Connections

Figure 7–32: CAT EMM Cross Connect

The EMM Cross-Connect Editor dialog displays, displaying the cross connect details:

- **Enabled** - Defines the operational status (enabled/disabled) of the EMM PID.
  - **Input Multiplex Port / EMM PID** - Displays the name of the multiplex input which receives the stream and the input EMM identification number.
  - **Input EMM PID**.
  - **CA System ID**.
  - **Output Multiplex Port / EMM PID** - Displays the name of the multiplex output where the stream is routed and the output EMM identification number (identical to the input PID).

2. Click **Create** to create the CAT EMM cross-connect.

Unreferenced PID Cross Connection

You can create, edit and remap unreferenced PID cross connections.

To create a new unreferenced PID cross connection:
1. From the Multiplex Input box, drag the icon of the required PID and drop it onto the Unreferenced PID icon in the Multiplex and Decoding Output box.
The Unreferenced PID Cross-Connect Editor dialog displays, displaying the cross connect details:

- **Input Multiplex Port / Input PID** – Displays the name of the multiplex input which receives the stream and the input PID number.
- **Output Multiplex Port / Output PID** – Displays the name of the multiplex output port where the stream is routed and the output PID (identical to the input PID).

2. Click **Create** to create the Unreferenced PID cross-connect.

**NIT Replacement**

You can replace the NIT in an output multiplex with a PID from an input multiplex. The default PID for the NIT is **16**.

**Replacing a NIT**

To replace the NIT with a PID from an input multiplex:

1. Drag the program ES in the **Multiplex Input** box to the NIT under Tables of the multiplex in the **Multiplex, Transcoding & Decoding Output** box.
2. Confirm the confirmation dialog.

**Cancelling a NIT Replacement**

To cancel a NIT replacement:

1. Double-click **NIT** under Tables of the multiplex in the **Multiplex, Transcoding & Decoding Output** box.

   The **NIT** property sheet displays.

2. Select **Not Passed** in the Table Passed State drop-down menu.
3. Click **Apply**.

**Input to Decoder Channel Connection**

The EMS allows defining an output decoding channel. The channel supports up to two services. The **Decoding Channel** allows configuring the service properties such as the input port, decoder ID, decoder card number and channel number.

To define a new decoding channel:
1. From the **Multiplex Input** box, drag the icon of the wanted program onto the icon of the decoding channel in the **Multiplex, Transcoding & Decoding Output** box.
The Decoding Channel property sheet displays, enabling the user to review and configure the decoding properties (for detailed description, refer to Decoding Channel Properties).

NOTE: The EMS enables building your own decoded output stream, by selecting specific elementary stream from a program. Drag and drop the ES icon from the input program branch into the Output decoding icon. The ES Decoding property sheet will open, allowing setting the relevant parameters (for detailed description, refer to Decoding Channel Properties).

CAUTION: Do not use ES from different programs.

2. Click OK to confirm the decoding set-up.

NOTE: Descrambling Set-Up Tip:
When setting a program or an ES for decoding, the decoder properties menu enables the user to descramble the program and to select the CAM slot for the descrambling process. Refer to Decoding Channel Properties in this manual for a detailed description of the options provided by the Decoding Channel property sheet.
Editing and Deleting

To edit components:
 Double-click the component in the EMS box.

To delete components:
1. Click the component in the EMS box.
2. Press the Del key.

CAM Slot Management

Use the EMS CAM management to allocate available CAM slots to selected multiplex input or to a multiplex program.

To allocate a CAM slot to a multiplex input:
1. In the Device tree, right-click the CAM slot icon and select Properties.
   The CAM Slot property sheet displays.
2. Select the input multiplex port.
3. Click OK.

4. To configure all ESs and all ECMs, select Full descrambling under Descrambling Mode.
   In Selective ES Descrambling mode only ESs that are scrambled with a CAS ID supported by the CAM, are descrambled.

Related Topics:
- Descrambling a Cross Connected Program
- Descrambling a Decoded Program

Figure 7–35: CAM Slot properties
Descrambling a Cross Connected Program

To allocate a CAM slot to a scrambled cross-connected program:
1. Cross connect an input program to the output multiplex port (see Program Cross Connection).
   Mark the Descrambling with check box in the Dynamic Program Connection Configuration property sheet and select the CAM slot for the cross-connected program.
2. Click Create to confirm the program cross-connection.

Descrambling a Decoded Program

To allocate a CAM slot to a scrambled decoded program:
1. Cross connect an input program to the decoder (see Input to Decoder Channel Connection).
2. Mark the Descrambling with check box on the Service tab on the Decoding Channel property sheet.
3. Select the CAM slot for the service.
4. Click Create to confirm the program cross-connection.

EMS Connection Wizard

The ProView 7000 EMS Connection Wizard provides EMS guided input program cross connection to any device output and device decoding channels.
1. The EMS Connection Wizard is activated from the EMS Menu tree, by selecting Actions > Connection Wizard option or by clicking Connection Wizard in the EMS toolbar.

   The displayed wizard select dialog provides access to set the following:
   - **Input Program Cross-Connections** – For details, refer to Setting Program Cross-Connection using the Connection Wizard.
   - **Input Program Decoding Channel** – For details, refer to Setting Decoding Channel using the Connection Wizard.

   ![Connection Wizard dialog](image)

Figure 7–36: Connection Wizard dialog

Related Topics:
Setting Program Cross-Connection using the Connection Wizard

To set a cross-connection by using the Connection Wizard:
1. Click **Connection Wizard** on the EMS toolbar.
2. Select **Input Program to Output Port** and click **Next**.
   A list of multiplex inputs available for selection displays.
3. Select an Input Multiplex Port and click **Next>>**.
   A list of programs available at the selected input displays.
4. Select an input program port and click **Next>>**.
   A list of multiplex outputs available for selection displays.
5. Select an Output Multiplex and click **Next>>**.
   The Cross-Connect Editor property sheet displays.

6. Set the required parameters:
   - **Enabled** – Defines the operational status of the program.
   - **Input** – Displays the name of the input physical port which receives the stream and the number of the multiplex program.
   - **Output** – Displays the name of the output physical port where the stream is routed and the number of the multiplexed program routed to the port. You can configure a new PID Offset.
   - **Descrambling** – Enables descrambling the program and selects the CAM used for the descrambling.

7. Click **Create** to create the program cross-connect.
Setting Decoding Channel using the Connection Wizard

To set a Decoding Channel by using the Connection Wizard:
1. Click **Connection Wizard** on the EMS toolbar.
2. Select **Input Program to Decoding Channel** and click **Next>>**.
3. Select the Input Multiplex Port and click **Next>>**.
4. Select an input program and click **Next>>**.
5. Select the Decoding Channel and click **Next>>**.

The **Decoding Channel** property sheet displays, enabling you to review and configure the decoder properties (for detailed description, refer to **Decoding Channel Properties**).

6. Click **OK** to confirm the decoding set-up.

**Low Delay Mode**

The ProView 7000 Low Delay Mode is designed to work with an Ellipse 1000/2000 encoder in Low Delay mode. The end-to-end delay should be less than 9 frames for PAL and 10 frames for NTSC. Low Delay Mode automatically detects regular video streams that do not require Low Delay Mode and treats them accordingly.

The following video resolutions are supported:

- SD PAL
- SD NTSC
- 720p PAL
- 720p NTSC

---

20. Requires a license.
Low Delay Mode

- 1080i PAL
- 1080i NTSC
- 4:2:2 SD AVC PAL
- 4:2:2 SD AVC NTSC
- 4:2:2 SD M2 PAL
- 4:2:2 SD M2 NTSC
- 4:2:2 720p AVC
- 4:2:2 720p M2
- 4:2:2 1080i AVC
- 4:2:2 1080i M2
- 4:2:2 1080p AVC
- 4:2:2 1080p M2

The following audio bitrates are supported for low delay applications:
- Musicam – 128 – 384 kbps
- Dolby Digital 2.0 – 256 – 640 kbps

Selecting Low Delay Mode

To select Low Delay mode:
1. Select the Decoding Channel in the Multiplex, Transcoding & Decoding Output box.
2. Click Properties on the toolbar.
   
   The Decoding Channel property sheet displays.
3. Select the Video tab.
4. Select Low Delay for Buffer Management in the Advanced box, see Figure 7–37.
Device Management

To manage a ProView 7000 device using EMS, the device must be connected. To add and connect a device, see Adding a Device and Connecting a Device.

The connected devices are listed and displayed in the Devices box. Hover the mouse pointer over a device icon to display the display tip. See Figure 7-38. The three text rows display the following:

- IP Address
- User name
- Status/DMS control status
You can access the ProView 7000 device management functions in the following ways:

- From the EMS menu
- From the EMS toolbar
- Right-click the device icon ( ) to display the devices management context menu

Related topics:

- Reboot Device
- Device Identification
- Reset CAM Slot
- Log-In / Log-Out Control of the Device
- Setting Up/Changing the Device Log-in Password
- Managing Presets
- Backing Up/Restoring the Device Configuration
- Restoring the Factory/Default Device Access Passwords

**Reboot Device**

To reboot a device:

1. Select the device in the Devices box.
2. Select **Tools > Reboot Device**.
3. Confirm.
**Device Identification**

You can blink the front panel LCD backlight of a physical device to identify it amongst other devices on a rack.

To identify a device:
1. Select the device in the **Devices** box.
2. Select **Tools > Device Identification Blinking Light**.
3. Click **Start Blinking** in the dialog.

To stop blinking:
- Click **Stop Blinking** in the dialog.

**Reset CAM Slot**

To reset a CAM slot:
1. Select the device in the **Devices** box.
2. Expand the Descrambling branch in the **Physical Input** box.
3. Right-click a CAM slot.
4. Select **Reset CAM Slot**.

**Log-In / Log-Out Control of the Device**

A connected ProView 7000 device needs to be logged-in before enabled for EMS management. The EMS user management is set at two levels:

- Monitoring level, where the user can view the device parameters and status.
- Configuring level, where the user is enabled to monitor and configure the device parameters.

Logging in is password protected. Refer to **Device Users’ Access Properties** for setting up and changing the device access password and to **Restoring the Factory/Default Device Access Passwords** for restoring factory passwords. Logging out leaves the device connected to the EMS, yet disables access to the device.

**Setting Up/Changing the Device Log-in Password**

Setting up or changing the device log-in password is enabled for Configuring level users. For details on password set-up, refer to **Device Users’ Access Properties**.

**Managing Presets**

Use the Manage Presets menu to display the **Presets Management** property sheet and manage multiple configuration files. If you use several satellites, you can create a preset file for each satellite configuration and activate the appropriate preset when you switch transponders. You can create up to 10 presets. You can download preset files to your management PC and upload them.
to other ProView 7000s with the same hardware configuration, firmware version and licenses. See Figure 7-39.

![Presets Management property sheet](image)

**Figure 7-39: Presets Management property sheet**

Related topics:
- Creating a Preset
- Activating a Preset
- Renaming a Preset
- Deleting a Preset
- Downloading Presets
- Uploading a Preset

**Creating a Preset**

Use the Create button to create a preset file from the current configuration. The file length limit is 32 characters.

To create a preset file from the current configuration:
1. Select the device in the Devices box.
2. Select **Tools > Manage Presets.**
   - The Presets Management property sheet displays.
3. Click **Create.**
4. Enter a name for the preset.
5. Click **OK.**

**Activating a Preset**

Use the **Activate** button to activate a preset in the ProView 7000. The device reboots when you activate a preset.

To activate a preset:
1. Select the device in the **Devices** box.
2. Select **Tools > Manage Presets**.
   - The Presets Management property sheet displays.
3. Select a preset in the list.
4. Click **Activate**.
   - A confirmation dialog displays.
5. Click **Yes**.

**Renaming a Preset**

Use the Rename button to rename a preset. The file length limit is 32 characters.

To rename a preset:
1. Select the device in the **Devices** box.
2. Select **Tools > Manage Presets**.
   - The Presets Management property sheet displays.
3. Select a preset in the list.
4. Click **Rename**.
5. Enter the new preset name.
6. Click **OK**.

**Deleting a Preset**

Use the **Delete** button to delete a preset.

To delete a preset:
1. Select the device in the **Devices** box.
2. Select **Tools > Manage Presets**.
   - The **Presets Management** property sheet displays.
3. Select a preset in the list.
4. Click **Delete**.
   - A confirmation dialog displays.
5. Click **Yes**.

**Downloading Presets**

Use the **Download** button to download a preset to your managing PC.

To download presets:
1. Select the device in the **Devices** box.
2. Select **Tools > Manage Presets**.
   - The **Presets Management** property sheet displays.
3. Select a preset in the list.
4. Click **Download**.
   - The file/folder dialog displays.
5. Select a destination folder for the preset files.
6. Click **OK**.
### Uploading a Preset

Use the **Upload** button to upload a preset to a ProView 7000. Preset files which you upload must have different names to those already in the ProView 7000.

To upload a preset:

1. Select the device in the **Devices** box.
2. Select **Tools > Manage Presets**.
   - The **Presets Management** property sheet displays.
3. Click **Upload**.
   - The file/folder dialog displays.
4. Select a preset file in the list.
5. Click **OK**.
   - A preset name dialog displays.
6. You can enter a different name to store this preset in the ProView 7000.
7. Click **OK**.

### Backing Up/Restoring the Device Configuration

The **Back Up / Restore Configuration** property sheet enables the EMS user to manage the configuration of the ProView 7000 device.

This property sheet enables the EMS user to back up the current device configuration and keep it for future use, to restore a backed-up device configuration and to restore the factory default device configuration.

When restoring a saved or factory/default configuration, make sure the current hardware and licensed software of the device match the device configuration when the configuration was backed up. If in doubt, consult Harmonic support.

![Backup and Restore Configuration property sheet](image)

**Figure 7-40: Backup and Restore Configuration property sheet**
Backing Up the Current Configuration

To back up the current configuration:
1. Select the device in the Devices box.
   The Back Up and Restore Configuration property sheet displays, see Figure 7–40.
3. Enter a configuration identification name in the Backup Device section of the property sheet.
4. Select the path where to backup the configuration.
5. Click Back Up.
   A message reports successful save of the configuration.

Restoring a Backed-Up Configuration

To restore a backed-up configuration:
1. Select the device in the Devices box.
2. Select Tools > Backup/Restore Configuration in the ProView 7000 EMS menu bar.
   The Backup and Restore Configuration property sheet displays, see Figure 7–40.
3. Browse the path and select the saved configuration name in the Restore Device section of
   the property sheet.
4. Click Restore.
   After confirming the retrieval, the EMS retrieves the configuration file and the ProView 7000
   is reconfigured according to the saved set-up.

Restoring the Default Configuration

You can choose to restore the default configuration or to restore the factory default database
which also resets the IP addresses to their defaults and removes all licenses.

To restore the default device configuration:
1. Select the device in the Devices box.
2. Select Tools > Backup/Restore Configuration in the ProView 7000 EMS menu bar.
   The Backup and Restore Configuration property sheet displays, see Figure 7–40.
3. Click Default.
   The Restore Default Configuration property sheet displays.
4. Choose one of the following:
   - Restore default configuration to device (default database)
   - Restore factory default configuration (default database & IP)
5. Click Restore Default Configuration.

Restoring the Factory/Default Device Access Passwords

This function enables the EMS user to restore access to a ProView 7000 device when the device
access passwords are lost.

Restoring the access to the device requires receiving a new access code from Harmonic support.
To receive this code, communicate the request to Harmonic support and provide the device Key
ID and device date (information provided in the Restore Default Password dialog.

To restore access to the device:
1. Select the device in the **Devices** box.
2. Select **Tools > Restore Default Passwords** in the ProView 7000 EMS menu bar.
   
The **Restore Default Passwords** dialog displays.

3. Use the displayed device key ID and Device date information to receive the access code.
4. Enter the access code supplied by Harmonic and click **Restore**.

**NOTE:** The Harmonic supplied access code is valid for the same day only. Once the access passwords are reset to factory values, it is recommended to change and personalize them to protect the security of the device.

You can copy the key ID and device date to the clipboard with the **Copy** button.

### Device Properties

Use the Device properties to monitor and set ProView 7000 system level parameters.

To display the Device properties:
1. Select a device icon in the **Devices** box.
2. Click **Properties** on the EMS toolbar.

   The **Device** property sheet displays with multiple tabs, each listing a specific group of device parameters.

**Related topics:**
- **Network Properties**
- **Hardware Properties**
- **Device Communication Properties**
- **Device Users’ Access Properties**
- **Device Software Upgrade Properties**
- **Device License Properties**
- **Device Date and Time Properties**
- **GPI Properties**
- **Transcoding Properties**

### Network Properties

The **Network** properties tab provides the EMS user the ability to manage the following parameters related to the ProView 7000 unit:

- Set the IP address of the port.
- Set the Mask address of the port.
- Set the Gateway address of the port.
- View the unit MAC Address.
- View Auto negotiation status of the port.
- View the traffic Speed of the port (in Mbps).
- View the Duplex Mode.
- Manage the Routing Tables – GbE In mode only.

Figure 7–41: Device property sheet – Network tab

Routing Table Management

Use the Routing Table Management property sheet to manage up to five routing destinations for GbE input when the sender is on a different network.

To display the Routing Table Management property sheet:
- Click Advanced on the Network tab of the device property sheet.

To add or edit a routing entry:
1. Click Edit Entry.
The **Routing Table Entry** property sheet displays.

![Routing Table Entry](image)

2. Select the destination type, network or host.
3. Enter the following:
   - **Destination Address**
   - **Mask**
   - **Gateway** - Enter the GbE IP address that corresponds to the selected GbE port.
4. Select the **Port**.
5. Click **OK**.

To clear a routing entry:
1. Select a routing entry.
2. Click **Clear Entry**.
3. Confirm.

**Hardware Properties**

The Hardware properties tab provides the EMS user the ability to monitor the following parameters related to the ProView 7000 unit, arranged in the following groups / sub-tabs:

<table>
<thead>
<tr>
<th>Group</th>
<th>Sub-tabs</th>
</tr>
</thead>
<tbody>
<tr>
<td>Device Box</td>
<td>Device, Platform, Main Board, Front End, Bottom Card, Top Card</td>
</tr>
<tr>
<td>Hardware Inventory Box</td>
<td>Platform, Main Board, Front End, Bottom Card, Top Card</td>
</tr>
</tbody>
</table>

**NOTE:** Each Hardware Properties sub-tab also displays the highest active alarm level related to the ProView 7000 device.

**Device Box**

The **Device** box displays the device model.

**Hardware Inventory Box**

The Hardware Inventory Box contains the following tabs:

- **Platform**
- **Main Board**
- **Front End**
- **Bottom Card**
- **Top Card**

**Platform**

The Platform properties tab displays the following information on the ProView 7000 platform:

- Part number
- Platform serial number
- Hardware Revision

![Figure 7-42: Device property sheet - Hardware - Platform tab](image)

**Main Board**

The **Main Board** properties tab displays the following ProView 7000 main board parameters:

- Main Board Serial Number
- Software Version number
- Main Board Part Number
- Hardware Revision information
- Main Board FPGA Version number
- Auxiliary FPGA Version number
- Remote Sensor 1 and 2 Temperature (in °C)
- Internal sensor temperature (in °C)
- Fan 1, 2, 3 and 4 speed (in rpm)
Figure 7–43: Device property sheet – Hardware – Main Board tab

Front End

The Front End properties tab displays the following parameters on the front end unit installed in the device:

- Front End Type
- Part Number
- Serial Number
- Hardware Revision
- Front End sensor Temperature (in °C)
- Front End FPGA Version number
- Demodulator Version information (for DVB-S and DVB-S2\textsuperscript{21} configurations, if available)

\textsuperscript{21} Requires a license with some hardware configurations, see Front End Card Features for details.
The **Bottom Card** properties tab displays the following parameters on the bottom card installed in the device:

- Bottom card type
- Bottom card part number
- Bottom card serial number
- Hardware Revision information
- Decoder Software Version information
Top Card

The Top Card properties tab displays the following parameters on the top card installed in the device:

- Top card type
- Top card part number
- Top card serial number
- Hardware Revision information
Alarms Box

The Alarms box displays the highest Alarm severity.

Device Communication Properties

The Communication properties tab provides the EMS user the ability to manage the following parameters related to the ProView 7000 unit communication:

Traps Destination Parameters Box

Traps are SNMP notifications sent by the unit to a predefined address, without user intervention. The Traps Destination Configuration section allows setting up the trap destination parameters.

The trap destination parameters consist of the destination IP address, the UDP port number, the destination description and the SNMP community string. Up to 5 trap destinations can be defined.
To configure the trap destination:
1. Right-click the requested device and select **Properties** on the context menu.
   The **Device** property sheet displays.
2. Select the **Communications** tab.
3. On the **Communication** tab, click **Add**.
   The **Trap Destination / Add** property sheet displays.
4. Fill the following fields in the Trap Destination – Add property sheet.
   - **IP Address** – Sets the IP address of the trap destination
   - **UDP Port** – Sets the UDP port number of the trap destination
   - **Description** – Optional parameter, describing the trap destination
   - **Trap Community** – Set the trap community
5. Click **OK**.
6. Click **Apply**.
SNMP Timeout & Retries Box

The SNMP Configuration area allows the user to set-up the following SNMP parameters:

- **Timeout** – Defines the maximum time period for one connection attempt (in msec). This parameter is set to 20000 by default.

- **Retries** – Sets the number of connections attempts in case of a connection failure. This parameter is set to 2 tries by default.

Other Box

- **Last Reboot** – Displays the date and time of the last reboot performed on the device.

- **Last Configuration Change** – Displays the date and time of the last configuration change on the device.

Device Users’ Access Properties

You can log in to ProView 7000 devices using EMS on two levels; Configure and Monitor.

The **Configure** defined user can monitor and configure the ProView 7000 devices and have access to all set-up functions provided by the EMS.

The **Monitor** user can view all information displayed by the EMS, but is not enabled to change any of the set-up options.

The **Users** properties tab provides the EMS user the ability to manage the user access to the unit. It provides the following options:

- Displays the currently logged in user identification and access level.

- Enables the EMS Configure user to set a new password for the configure level and for the monitor level.

![Figure 7-48: Device property sheet – Users tab](image)
The factory default passwords are:

- User: configure – configure
- User: monitor – monitor

Only a Configure user can change the passwords. It is recommended to change the passwords once the device is installed to prevent unwanted tamper with the device. Resetting the password of the device requires restoring the factory access passwords. For details, see Restoring the Factory/Default Device Access Passwords.

**Device Software Upgrade Properties**

The ProView 7000 device software can be upgraded using non EMS managed tools, consisting of BOOTP and TFTP industry standard tools.

The S/W upgrade tab sets the number of retries for each one of these two upgrade tools.

![Device property sheet - S/W Upgrade tab](image)

Figure 7-49: Device property sheet – S/W Upgrade tab

The EMS enables the user to view and switch between the current and last software version for the device. This feature is very useful when the user selects to return to the last software version after a software upgrade. For details, refer see Active Version Management. The EMS provides a Software Upgrade Manager tool. For details, see Software Upgrade Manager.
Device License Properties

The Device License tab displays the ProView 7000 licensed features.

![Figure 7-50: Device property sheet - License tab](image)

To enter a new license code:
1. Mark the **Update license** check box.
2. Enter the new license code.
3. Click **Apply**.
4. Reboot the device to activate the license.

Device Date and Time Properties

The Date & Time tab enables you to view and configure the current date and time, time zone and NTP configuration of the device, the unit can synchronize its clock with an NTP server using SNTP/NTP v2 or v3.

NTP is disabled by default.
GPI Properties

Use the GPI tab to select alarms to toggle GPI relays for any automation system on-site or to manually switch relays.

There are three modes for each GPI relay, namely:

- **Alarm Triggered** – Use this mode to select individual alarms to toggle the relay.
- **Off** – Use this mode to manually switch the relay off.
- **On** – Use this mode to manually switch the relay on.
Transcoding Properties

Use the **Transcoding** properties tab to display the total number of SD and HD licensed transcoders and the number of SD and HD transcoders in use in the device.
Device Properties

Figure 7-53: Device property sheet - Transcoding tab

Number of programs that are currently being transcoded with HD licenses.

Number of programs that can be transcoded at the same time using HD licenses.
Use the device icon, Alarms tab and Alarms History tabs to monitor ProView 7000 devices.

Topics:
- Device Communication Status
- Alarms
- Alarm History
- Refreshing the EMS Screen
- DVB-S/S2 Input Port Properties Status
- Decoding Channel Properties Status
- DPI Log

**Device Communication Status**

The communication state of the ProView 7000 EMS with a ProView 7000 device is shown by the graphical display of the device icon in the Devices box and are refreshed automatically. The alarm severity level is indicated by the device icon LEDs. A list follows with the descriptions:

- ![Disconnected](image) A device that is disconnected or not logged into is displayed in light gray.
- ![Connected](image) A connected and communicating device with no alarms is displayed in full color and the LEDs are green.
- ![DMS](image) When a device is receiving a command from a Harmonic DMS server, DMS displays next to the device icon.
- ![TX](image) TX displays next to the device icon of transcoder equipped devices.
- ![Critical](image) When a device has a critical alarm then the LEDs are red.
- ![Major](image) When a device has a major alarm and no critical alarms then the LEDs are orange.
- ![Warning](image) When a device has a warning alarm and no major or critical alarms then the LEDs are yellow.

The device tooltips display the status and of the device and if it is connected to Harmonic DMS the status of the DMS connection as per the following:

- Connected to Harmonic DMS.
- Controlled by Harmonic DMS.
Alarms

Use the Alarms tab to display the active alarms. Alarms alert the user to conditions that may require attention. Concerning multiplex input redundancy, alarms on the backup source port of a multiplex in port display on the Alarms tab if the relevant redundancy trigger is enabled and the threshold matches the Redundancy Triggers configuration, see Multiplex In Port Properties.

To display the Alarms tab:

- If the Alarms tab is collapsed, click the left most of the two triangles in the bottom left of the EMS window to expand it.

To refresh the alarm list on demand:

1. Right-click any alarm in the list.
2. Select Refresh Alarms.

The information provided for each alarm displayed consists of the following:

- **Alarm Severity** - The alarm severity level.
  - The alarm severity color codes are:
    - Critical (red)
    - Major (orange)
    - Warning (yellow)
- **Time** - Alarm generation date and time (yyyy-mm-dd hh:mm:ss format).
- **Device Name** and **IP** - The identification name and IP address of the ProView 7000 device which have raised the alarm.
- **Description** - The alarm identification and description information.
**Alarm Properties**

The *Alarm* property sheet displays detailed information on a specific alarm message.

To display the *Alarm* property sheet:
1. Right-click an alarm entry in the *Alarms* box.
2. Select *Properties* in the list.

![Alarm - Properties](image)

See Appendix G, ProView 7000 Alarm List for the alarm list with corrective actions.

**Alarm History**

Use the *Alarms History* tab to view a record of alarms triggered. You can export the alarm history in CSV format.

The alarm severity color codes are the same as those in the *Alarm* tab.

To display the alarm history for a device:
1. Select the *Alarms History* tab.
2. Select the device in the *Filter* drop-down menu.

The alarm history displays for the selected device.

**Refreshing the EMS Screen**

The EMS supports a user-driven screen refresh function. This function can refresh the following:

- **Element** – Updates a branch or specific element in the stream, either at the multiplexed input or the multiplexed output.

- **Device** – Updates the currently managed ProView 7000 device.

To refresh an element or device:
1. Select an element or device.
2. Select *File > Refresh > [device|element]*
   —or—
   
   click *Refresh* on the EMS Toolbar.
You can also perform a refresh by right-clicking the element icon and selecting the Refresh item in the displayed element drop-down menu.

**DVB- S/S2 Input Port Properties Status**

To display the DVB-S/S2 Input Port properties:
1. Select the DVB-S/S2 Input Port icon in the **Physical Input** box.
2. Click **Properties** on the **EMS** Toolbar.
3. Click Status in the **DVB-S/S2 In Port** property sheet.

The **Status Properties** box on the right hand side of the **DVB-S/S2 In Port** property sheet displays the current status of the receiver module. Thus, changing parameters in the Properties Set-Up section affects the status report only after the changes are applied to the device (by clicking **Apply** or **OK**).

The reception status is displayed whether the physical port is connected or not connected to the DVB Multiplex In. The information displayed on the status properties section is refreshed every few seconds. Some of the following properties are relevant to only one modulation standard (DVB-S or DVB-S2) and displayed accordingly.

The status properties displayed in the Status (right) section of the DVB-S/S2 In Port property sheet consists of the following parameters:

- Carrier and Demodulator lock status – ProView 7000 attempts to lock onto a carrier even when the port is not connected
- Carrier to noise ratio (C/N) measured value (in dBC)
- Energy per bit to Noise power spectral density ratio (Eb/N0) value (in dB)
- Link Margin value (in dB)
- Bit Error Rate (BER, applicable to DVB-S, as decimal number a.b E-X)
- Packet Error Rate (PER, applicable to DVB-S2, as decimal number a.b E-X)
- Tuned Frequency value (in kHz)
- Frequency Offset measured (in kHz)
- Spectral inversion operational mode detected
- FEC Rate used
- Pilot Signal operating status (DVB-S2 feature)
- Frame Size detected (DVB-S2 feature)

**Decoding Channel Properties Status**

To display the decoding channel properties **Status** tab:
1. Right-click a decoding channel in the **Multiplex, Transcoding & Decoding Output** box, see **Figure 6-2** for the box location.
2. Select the **Status** tab.
The **Status** tab comprises:

- **Error Counters** – Displays the count of the following errors detected and enables the user to reset the status counters:
  - Continuity Counter Errors
  - Subtitle Repositioning Failures
- **Video** – Displays the status of the following video source parameters:
  - Source Codec
  - Source Aspect Ratio
  - Source Resolution
  - Sequence Header Bitrate (bps)
  - GOP Size
  - GOP Structure
  - Low Delay Mode
  - Chroma Sampling
- **VBI** – Displays extracted VBI data information
  - CC
  - WSS AR
  - WSS Code
  - AFD Code
  - VITC
- **Audio 1 / 2** - Displays the status of the following audio 1 (or audio 2) source parameters:
  - Source Codec
  - Layer number
  - Sample rate (kHz)
  - Channel Mode
  - Bitrate (bps)

- **Service** - Displays the PID of the following decoded elementary streams:
  - ES
  - Video
  - PCR
  - Audio 1
  - Audio 2
  - VBI
  - Subtitling
  - DPI

### DPI Log

The ProView 7000 logs every DPI PID processed by the decoders, to an XML file. The device restarts the log at midnight. Use the Current DPI Log parameter to view the log since midnight and use the Old DPI Log parameter to view the log of the previous day.

To read the DPI PID log:


2. Under command select **Get System Log Files**.

3. Under Parameters choose one of the following:
   - Current DPI Log
   - Old DPI Log

4. Click **Execute**.
   The log displays.
Appendix A

Contacting the Technical Assistance Center

Harmonic Global Service and Support has many Technical Assistance Centers (TAC) located globally, but virtually co-located where our customers can obtain technical assistance or request on-site visits from the Regional Field Management team. The TAC operates a Follow-The-Sun support model to provide Global Technical Support anytime, anywhere, through a single case management and virtual telephone system. Depending on time of day, anywhere in the world, we will receive and address your calls or emails in one of our global support centers. The Follow-the-Sun model greatly benefits our customers by providing continuous problem resolution and escalation of issues around the clock.

Report an issue online at:
http://harmonicinc.com/webform/report-issue-online

Table A–1: Technical Support Phone Numbers and Email Addresses

<table>
<thead>
<tr>
<th>Region</th>
<th>Telephone Technical Support</th>
<th>E-mail</th>
</tr>
</thead>
<tbody>
<tr>
<td>Americas</td>
<td>888.673.4896 (888.MPEG.TWO) or +1.408.490.6477</td>
<td><a href="mailto:support@harmonicinc.com">support@harmonicinc.com</a></td>
</tr>
<tr>
<td>Europe, Middle East, and Africa</td>
<td>+44.1252.555.450</td>
<td><a href="mailto:emeasupport@harmonicinc.com">emeasupport@harmonicinc.com</a></td>
</tr>
<tr>
<td>India</td>
<td>+91.120.498.3199</td>
<td><a href="mailto:apacsupport@harmonicinc.com">apacsupport@harmonicinc.com</a></td>
</tr>
<tr>
<td>Russia</td>
<td>+7.495.926.4608</td>
<td><a href="mailto:rusupport@harmonicinc.com">rusupport@harmonicinc.com</a></td>
</tr>
<tr>
<td>Mainland China</td>
<td>+86.10.6569.5580</td>
<td><a href="mailto:chinasupport@harmonicinc.com">chinasupport@harmonicinc.com</a></td>
</tr>
<tr>
<td>Japan</td>
<td>+81.3.5565.6737</td>
<td><a href="mailto:japansupport@harmonicinc.com">japansupport@harmonicinc.com</a></td>
</tr>
<tr>
<td>Asia Pacific – Other Territories</td>
<td>+852.3184.0045 or 65.6542.0050</td>
<td><a href="mailto:apacsupport@harmonicinc.com">apacsupport@harmonicinc.com</a></td>
</tr>
</tbody>
</table>

The Harmonic Inc. support website is:
http://www.harmonicinc.com/content/technical-support

The Harmonic Inc. software download sites are:

<table>
<thead>
<tr>
<th>Distribution and Delivery Software</th>
<th>ftp://ftp.harmonicinc.com</th>
</tr>
</thead>
<tbody>
<tr>
<td>Software for select Electra Encoders</td>
<td><a href="https://harmonic.force.com/SWAccess/SWDownloadLogin">https://harmonic.force.com/SWAccess/SWDownloadLogin</a></td>
</tr>
</tbody>
</table>
The Harmonic Inc. corporate address is:
Harmonic Inc.
4300 North First St.
San Jose, CA 95134, U.S.A.
Attn: Customer Support

The corporate telephone numbers for Harmonic Inc. are:
Tel. 1.800.788.1330 (inside the U.S.)
Tel. +1.408.542.2500 (outside the U.S.)
Fax.+1.408.542.2511
Appendix B
Safety and Regulatory Compliance Information

Legal Disclaimer: Information in this document is provided in connection with Harmonic products. Unless otherwise agreed in writing Harmonic products are not designed nor intended for any application in which the failure of the product could cause personal injury or death.

NOTE: The information in this appendix may apply to purchased products only.

Important Safety Instructions

This section provides important safety guidelines for operators and service personnel. Specific warnings and cautions are found throughout the guide where they apply, but may not appear here. Please read and follow the important safety information, noting especially those instructions related to risk of fire, electric shock or injury to persons. You must adhere to the guidelines in this document to ensure and maintain compliance with existing product certifications and approvals. In this document, we use “product,” “equipment,” and “unit” interchangeably.

This equipment generates, uses, and can radiate radio frequency energy. It may cause harmful interference to radio communications if it is not installed and used in accordance with the instructions in this manual. Operation of this equipment in a residential area is likely to cause harmful interference If this occurs, the user will be required to correct the interference at his or her own expense.

In event of conflict between the information in this document and information provided with the product or on our website for a particular product, this product documentation takes precedence.

Safety Symbols & Translated Safety, Warning & Caution Instructions (English)

To avoid personal injury or property damage, before you begin installing or replacing the product, read, observe, and adhere to all the following safety instructions and information. Harmonic products and/or product packaging may be marked with the safety symbols used throughout this document, when it is necessary to alert operators, users, and service providers to pertinent safety instructions in the manuals.
<table>
<thead>
<tr>
<th>Mark</th>
<th>Notes</th>
</tr>
</thead>
</table>
| ![Safety Symbol] | **Installing or Replacing the Product Unit Warning**  
- Only trained and qualified service personnel should be allowed to install, replace, or service this unit (refer AS/NZS 3260 Clause 1.2.14.3 Service Personnel).  
- Read the installation instructions before connecting the system to the power source.  
- When installing or replacing the unit, always make the ground connection first and disconnect it last.  
- Installation of the unit must comply with local and national electrical codes.  
- This unit is intended for installation in restricted access areas. A restricted access area can be accessed only through the use of special tool, lock and key or other means of security.  
- Use only specified replacement parts.  
- Do not use this unit in or near water. Disconnect all AC power before installing any options or servicing the unit unless instructed to do so by this manual. |
| ![Safety Symbol] | **Rack Mount Warning**  
- To prevent bodily injury when mounting or servicing this unit in a rack, special precautions must be taken to ensure your safety and stability of system:  
  - Conform to local occupational health and safety requirements when moving and lifting the equipment.  
  - Ensure that mounting of the unit by mechanical loading tools should not induce hazardous conditions.  
  - To avoid risk of potential electric shock, a proper safety ground must be implemented for the rack and each piece of equipment installed on it. |
| ![Safety Symbol] | **Chassis Warning**  
- Before connecting or disconnecting ground or power wires to the chassis, ensure that power is removed from the DC circuit.  
- To prevent personal injury or damage to the chassis, lift the unit only by using handles that are an integral part of the chassis, or by holding the chassis underneath its lower edge.  
- Any instructions in this guide that require opening the chassis or removing a board should be performed by qualified service personnel only.  
- Slots and openings in the chassis are provided for ventilation. Do not block them. Leave the back of the frame clear for air exhaust cooling and to allow room for cabling - a minimum of 6 inches (15.24 cm) of clearance is recommended. |
<table>
<thead>
<tr>
<th>Mark</th>
<th>Electric Shock Warning</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="electric_shock.png" alt="Warning" /></td>
<td>This unit might have more than one power cord. To reduce the risk of electric shock, disconnect the two power supply cords before servicing the unit.</td>
</tr>
<tr>
<td></td>
<td>Before working on a chassis or working near power supplies, unplug the power cord on AC units.</td>
</tr>
<tr>
<td></td>
<td>Do not work on the system or connect or disconnect cables during periods of lightning activity.</td>
</tr>
<tr>
<td></td>
<td>This unit is grounded through the power cord grounding conductor. To avoid electric shock, plug the power cord into a properly wired receptacle before connecting the product input or outputs.</td>
</tr>
<tr>
<td></td>
<td>Route power cords and other cables so that they are not likely to be damaged. Disconnect power input to unit before cleaning. Do not use liquid or aerosol cleaners; use only a damp cloth to clean chassis.</td>
</tr>
<tr>
<td></td>
<td>Dangerous voltages exist at several points in this product. To avoid personal injury, do not touch exposed connections and components while power is on. Do not insert anything into either of the system's two power supply cavities with power connected.</td>
</tr>
<tr>
<td></td>
<td>Never install an AC power module and a DC power module in the same chassis.</td>
</tr>
<tr>
<td></td>
<td>Do not wear hand jewelry or watch when troubleshooting high current circuits, such as the power supplies.</td>
</tr>
<tr>
<td></td>
<td>To avoid fire hazard, use only the specified correct type voltage and current ratings as referenced in the appropriate parts list for this unit. Always refer fuse replacement to qualified service personnel.</td>
</tr>
<tr>
<td></td>
<td>This unit relies on the building's installation for short-circuit (overcurrent) protection. Ensure that a fuse or circuit breaker no larger than 120 VAC, 15A U.S. (240 VAC, 10A international) is used on the phase conductors (all current-carrying conductors).</td>
</tr>
<tr>
<td></td>
<td>To avoid electrocution ensure that the rack has been correctly grounded before switching on the unit. When removing the unit remove the grounding connection only after the unit is switched off and unplugged.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Mark</th>
<th>Electrostatic Discharge (ESD) Caution</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="esd.png" alt="Caution" /></td>
<td>Follow static precaution at all times when handling this unit.</td>
</tr>
<tr>
<td></td>
<td>Always wear an ESD-preventive wrist or ankle strap when handling electronic components. Connect one end of the strap to an ESD jack or an unpainted metal component on the system.</td>
</tr>
<tr>
<td></td>
<td>Handle cards by the faceplates and edges only; avoid touching the printed circuit board and connector pins.</td>
</tr>
<tr>
<td></td>
<td>Place any removed component on an antistatic surface or in a static shielding bag.</td>
</tr>
<tr>
<td></td>
<td>Avoid contact between the cards and clothing.</td>
</tr>
<tr>
<td></td>
<td>Periodically check the resistance value of the antistatic strap. Recommended value is between 1 and 10 mega-ohms (Mohms).</td>
</tr>
</tbody>
</table>
Laser Radiation Warning
Invisible laser radiation may be emitted from disconnected fibers or connectors. Do not stare into beams or view directly with optical instruments. Never operate a unit with a broken fibre or with a separated fiber connector.

Lithium Battery Handling Safety Instructions
- CALIFORNIA PERCHLORATE ADVISORY: Some lithium batteries may contain perchlorate material. The following advisory is provided: "Perchlorate Material - special handling may apply, see: www.dtsc.ca.gov/hazardous_waste/perchlorate/ for information".

Risk of explosion if battery is replaced incorrectly or with an incorrect type
Dispose of used batteries according to the manufacturer's instructions
There are no user-serviceable batteries inside Harmonic products. Refer to Harmonic qualified personnel only to service the replaceable batteries
## Installation ou remplacement de l'unité de produit Avertissement
- Il est vivement recommandé de confier l'installation, le remplacement et la maintenance de ces équipements à des personnels qualifiés et expérimentés. (voir AS / NZS 3260 article 1.2.14.3 du personnel de service).
- Avant de brancher le système sur la source d'alimentation, consulter les directives d'installation.
- Lors de l'installation ou le remplacement de l'appareil, la mise à la terre doit toujours être connectée en premier et déconnectée en dernier.
- L'équipement doit être installé conformément aux normes électroniques nationales et locales.
- Cet appareil est à installer dans des zones d'accès réservé. Ces dernières sont des zones auxquelles seul le personnel de service peut accéder en utilisant un outil spécial, un mécanisme de verrouillage et une clé, ou tout autre moyen de sécurité.
- Utilisez uniquement des pièces de rechange spécifiées.
- Ne pas utiliser ce produit dans l'eau ni à proximité de l'eau. Débrancher toutes les prises d'alimentation secteur avant d'installer des options ou d'effectuer l'entretien de l'unité, à moins d'instructions contraires dans le présent manuel.

## Rack Monture Avertissement
Pour éviter les blessures corporelles lors du montage ou l'entretien de cet appareil dans un rack, des précautions particulières doivent être prises pour assurer votre sécurité et la stabilité du système:
- Conformez-vous aux exigences de médecine du travail et de sécurité lorsque vous déplacez et soulevez le matériel.
- Assurez-vous que le montage de l'appareil par des outils de chargement mécaniques ne doit pas induire des conditions dangereuses.
- Pour éviter tout risque d'électrocution, le rack et chaque élément de l'équipement installé dans le rack doivent être correctement reliés à la terre.

## Châssis Avertissement
- Avant de connecter ou de déconnecter les câbles d'alimentation (pôles et terre) du châssis, vérifiez que le circuit de courant continu est hors tension.
- Pour éviter toute blessure ou des dommages au châssis, soulevez l'unité uniquement par les poignées du châssis lui-même ou en portant celui-ci par le bord inférieur.
- Toutes les opérations du présent guide nécessitant l'ouverture du châssis ou le retrait d'une carte doivent être uniquement effectuées par du personnel d'entretien qualifié.
- Le châssis est muni de fentes et d'ouvertures d'aération. Ne pas les bloquer. Dégager l'arrière du cadre pour permettre le refroidissement de l'évacuation d'air et laisser de la place au câblage; un dégagement d'au moins 15.24 cm (6 po) est recommandé.
### Avertissement

**Choc électrique Avertissement**

- Il est possible que cette unité soit munie de plusieurs cordons d'alimentation. Pour éviter les risques d'électrocution, débrancher les deux cordons d'alimentation avant de réparer l'unité.
- Avant de travailler sur un châssis ou à proximité d'une alimentation électrique, débrancher le cordon d'alimentation des unités en courant alternatif.
- Ne pas travailler sur le système ni brancher ou débrancher les câbles pendant un orage.
- Ce unité est mis à la terre par le conducteur de protection intégré au cordon d'alimentation. Pour éviter les chocs électriques, brancher le cordon d'alimentation dans une prise correctement câblée avant de raccorder les entrées ou sorties du unité.
- Installer les cordons d'alimentation et autres cables de sorte qu'ils ne risquent pas d'être endommagés. Couper l'alimentation avant nettoyage. Ne pas utiliser de nettoyant liquide ou en aérosol; utiliser seulement un linge humide.
- Des courants électriques dangereux circulent dans cet appareil. Afin d'éviter les lessures, ne pas toucher les connexions et composants exposés lorsque l'appareil est sous tension. Ne rien insérer dans l'une ou l'autre des cavités des prises de courant du système lorsque l'appareil est sous tension.
- N'installez jamais un module d'alimentation AC et un module d'alimentation DC dans le même châssis.
- Ne pas porter de bijoux aux mains ni de montre durant le dépannage des circuits à haute tension, comme les transformateurs.
- Pour prévenir les risques d'incendie, n'utiliser que le type, la tension et le courant nominal spécifiés dans la nomenclature des pièces de ce unité. Toujours confier le remplacement des fusibles à du personnel d'entretien qualifié.
- Pour ce qui est de la protection contre les courts-circuits (surtension), ce produit dépend de l'installation électrique du local. Vérifier qu'un fusible ou qu'un disjoncteur de 120 V alt., 15 A U.S. maximum (240 V alt., 10 A international) est utilisé sur les conducteurs de phase (conducteurs de charge).
- Pour éviter l'électrocution, assurez-vous que le rack a bien été mis à la terre avant de mettre l'unité en marche. Lors du retrait de l'unité, retirer le raccordement de terre seulement après avoir mis l'unité à l'arrêt et l'avoir débranchée.
<table>
<thead>
<tr>
<th>Mark</th>
<th>Notes</th>
</tr>
</thead>
</table>
| ![Attention](image) | **Les décharges électrostatiques (ESD) Attention**  
- Respecter systématiquement les precautions relatives aux charges électrostatiques durant la manipulation de cet unité.  
- Portez toujours un poignet ou la cheville bracelet antistatique préventive lors de la manipulation des composants électroniques. Branchez une extrémité de la sangle à une prise ESD ou d'un composant métallique non peinte sur le système.  
- Manipulez les cartes en les faces avant et les bords seulement; éviter de toucher la carte de circuit imprimé et les broches du connecteur.  
- Placer un composant retiré sur une surface antistatique ou dans un sac de protection statique.  
- Éviter tout contact entre les cartes et les vêtements.  
- Vérifier périodiquement la valeur de résistance de la sangle antistatique. Valeur recommandée est comprise entre 1 et 10 méga-ohms (Mohms). |
| ![Attention](image) | **Rayonnement laser Attention**  
- Rayonnement laser invisible peut être émis à partir de fibres ou les connecteurs débranchés. Ne pas regarder en faisceaux ou regarder directement avec des instruments optiques. Ne jamais faire fonctionner une unité en cas de bris d'une fibre ou de séparation d'un connecteur de fibre. |
| ![Attention](image) | **Batterie au lithium Manipulation instructions de sécurité**  
- Perchlorate pour la Californie Consultatif: Certaines batteries au lithium, peuvent contenir du perchlorate. le texte qui suit consultatif est prévu: "Présence de perchlorate - une manipulation spéciale peut s'appliquer, voir: [www.dtsc.ca.gov/hazardous waste/perchlorate/ for information](http://www.dtsc.ca.gov/hazardous waste/perchlorate/ for information)."  
- Il y a danger d'explosion si la batterie est remplacée de manière incorrecte ou par une batterie de type incorrect.  
- Mettre au rebut les batteries usagées conformément aux instructions du fabricant.  
- Les batteries des produits Harmonic ne peuvent pas être réparées ni entretenues par l'utilisateur. Ne confier l'entretien des batteries remplaçables qu'à du personnel compétent de Harmonic. |
### Installation oder den Austausch des Produkts Einheit Warnung

- Das Installieren, Ersetzen oder Bedienen dieser Ausrüstung sollte nur geschultem, qualifiziertem Personal gestattet worden (siehe AS / NZS 3260 Clause 1.2.14.3 Servicepersonal)
- Lesen Sie die Installationsanweisungen, bevor Sie das System an die Stromquelle anschließen.
- Der Erdanschluß muß bei der Installation der Einheit immer zuerst hergestellt und zuletzt abgetrennt werden.
- Die Installation der Geräte muss den Sicherheitsstandards entsprechen.
- Verwenden Sie nur die angegebenen Ersatzteile.

### Rack-Montage-Warnung

Zur Vermeidung von Körpervetzung beim Anbringen oder Warten dieser Einheit in einem Gestell müssen Sie besondere Vorkehrungen treffen, um sicherzustellen, daß das System stabil bleibt:
- Entsprachen den lokalen Arbeitsschutzanforderungen beim Bewegen und Heben der Ausrüstung.
- Stellen Sie sicher, dass die Montage des Gerätes durch mechanische Belastung Werkzeuge sollten nicht gefährlichen Bedingungen zu induzieren.
- Um das Risiko von möglichen elektrischen Schlag zu vermeiden, muss mit einer angemessen Erdung für Rack und jedes Gerät installiert ist implementiert werden.

### Chassis Warnung

- Gleichstrom-Unterbrechung Bevor Sie Erdungs- oder Stromkabel an das Chassis anschließen oder von ihm abtrennen, ist sicherzustellen, daß der Gleichstrom-Stromkreis unterbrochen ist.
- Um Verletzungen und Beschädigung des Chassis zu vermeiden, sollten Sie das Chassis nicht an den Henkeln auf den Elementen (wie z.B. Stromanschlüsse, Kühlungen oder Karten) heben oder kippen; oder indem Sie es unterhalb der Unterkante packen.
- Alle Hinweise in diesem Handbuch, die das Öffnen benötigen Sie das Gehäuse oder das Entfernen eines Board sollte nur von qualifiziertem Fachpersonal durchgeführt werden.
- Für Schlitzte und Öffnungen im Chassis vorgesehen. Blockieren Sie sie nicht. Lassen Sie die Rückseite des Rahmens frei für Abluftkühlung und um Platz für die Verkabelung ermöglichen - ein Minimum von 6 Zoll (15,24 cm) Abstand wird empfohlen.
<table>
<thead>
<tr>
<th>Mark</th>
<th>Elektroschock-Warnung</th>
</tr>
</thead>
<tbody>
<tr>
<td>☢</td>
<td>Diese Einheit hat möglicherweise mehr als ein Netzkabel. Zur Verringerung der Stromschlaggefahr trennen Sie beide Netzgerätekabel ab, bevor Sie die Einheit warten.</td>
</tr>
<tr>
<td>☢</td>
<td>Vor der Arbeit an einem Chassis für Arbeiten in der Nähe Stromversorgung, ziehen Sie das Netzkabel mit Netzeinheiten.</td>
</tr>
<tr>
<td>☢</td>
<td>Arbeiten Sie nicht am System und schließen Sie keine Kabel an bzw. trennen Sie keine ab, wenn es gewittert.</td>
</tr>
<tr>
<td>☢</td>
<td>Dieses Gerät ist über das Netzkabel Erdungsleiter geerdet. Um einen Stromschlag zu vermeiden, stecken Sie das Netzkabel in eine Steckdose richtig verdrahtet, bevor Sie das Produkt Eingang oder Ausgänge.</td>
</tr>
<tr>
<td>☢</td>
<td>Verlegen Sie Netzkabel und andere Kabel, so dass sie wahrscheinlich nicht beschädigt werden. Trennen Eingangsleistung Einheit vor der Reinigung. Verwenden Sie keine flüssigen oder Aerosolreiniger; nur mit einem feuchten Tuch zu reinigen Chassis.</td>
</tr>
<tr>
<td>☢</td>
<td>Ein Wechselstromsmodul und ein Gleichstrommodul dürfen niemals in demselben Chassis installiert werden.</td>
</tr>
<tr>
<td>☢</td>
<td>Tragen Sie keine Hand Schmuck oder schauen Sie bei der Fehlersuche hohen Stromkreise, wie beispielsweise die Stromversorgung.</td>
</tr>
<tr>
<td>☢</td>
<td>Um die Brandgefahr zu vermeiden, verwenden Sie nur den genannten richtige Art von Spannung und Strom Ratings als in der entsprechenden Stückliste für diese Einheit verwiesen. Beziehen sich immer auf Austausch der Sicherung von qualifiziertem Fachpersonal.</td>
</tr>
<tr>
<td>☢</td>
<td>Dieses Produkt ist darauf angewiesen, daß im Gebäude ein Kurzschluß-bzw. Überstromschutz installiert ist. Stellen Sie sicher, daß eine Sicherung oder ein Unterbrecher von nicht mehr als 240 V Wechselstrom, 10 A (bzw. in den USA 120 V Wechselstrom, 15 A) an den Phasenleitern (allen stromführenden Leitern) verwendet wird.</td>
</tr>
<tr>
<td>☢</td>
<td>Um einen Stromschlag zu vermeiden, sicherzustellen, dass die Zahnstange wurde korrekt vor dem Einschalten des Gerätes geerdet. Beim Entfernen der Einheit entfernen Sie die Masseebindung nur, nachdem das Gerät ausgeschaltet und der Netzstecker gezogen.</td>
</tr>
</tbody>
</table>

©2015 Harmonic Inc. All rights reserved.
## Site Preparation Instructions

**NOTE:** Only trained and qualified service personnel (as defined in IEC 60950 and AS/NZS 3260) should install, replace, or service the equipment. Install the system in accordance with the U.S. National Electric Code if you are in the United States.

1. Preparing & Choosing a Site for Installation
   - To ensure normal system operation, plan your site configuration and prepare the site before installation.
   - Install the unit in a restricted access area.

<table>
<thead>
<tr>
<th>Mark</th>
<th>Notes</th>
</tr>
</thead>
</table>
| !     | **Elektrostatische Entladung (ESD) Vorsicht**  
  - Folgen Sie statische vorsorglich zu jeder Zeit beim Umgang mit diesem Gerät.  
  - Hand Karten nur durch die Faceplates und Kanten; Berühren Sie die bedruckte Leiterplatte und Steckerstifte.  
  - Legen Sie alle entfernten Komponenten auf eine antistatische Oberfläche oder in einem Statik-Beutel.  
  - Kontakt zwischen den Karten und Kleidung vermeiden.  
  - Den Widerstandswert der gegen statische Gurt in regelmäßigen Abständen überprüfen. Empfohlener Wert ist zwischen 1 und 10 Mega-Ohm (MΩm). |
| !     | **Laserstrahlungen Warnung.**  
| !     | **Lithium-Batterie Handhabung Sicherheitshinweise**  
| !     | **Vorsicht**  
  - Bei Einsetzen einer falschen Batterie besteht Explosionsgefahr  
  - Entsorgen Sie die benutzten Batterien nach den Anweisungen des Herstellers.  
  - Es gibt keine zu wartenden Akkus im Harmonic Produkte. Siehe Harmonic qualifiziertes Personal, um die austauschbare Batterien Service. |
Appendix B Safety and Regulatory Compliance

Information

Site Preparation Instructions

- Choose a site with a dry, clean, well-ventilated and air-conditioned area.
- Choose a site that maintains an ambient temperature of 32 to 104°F (0 to 40°C)

2. Creating a Safe Environment

- Connect AC-powered systems to grounded power outlets or as per local regulations.
- Do not move or ship equipment unless it is correctly packed in its original wrapping and shipping containers.
- Only allow Harmonic trained personnel to undertake equipment service and maintenance. Do not permit unqualified personnel to operate the unit.
- Wear ear protection when working near an NSG Pro platform for a longer period of time.

3. Rack Mounting the Unit

- Install the system in an open rack whenever possible. If installation in an enclosed rack is unavoidable, ensure that the rack has adequate ventilation.
- Reliable earthing of rack-mounted equipment should be maintained. Particular attention should be given to supply connections other than direct connections to the branch circuit (e.g. use of power strips). This unit should be mounted at the bottom of the rack if it is the only unit in the rack.
- When mounting this unit in the partially filled rack, load the rack from the bottom to the top with the heaviest component at the bottom of the rack.
- If the rack is provided with stabilizing devices, install the stabilizers before mounting or servicing the unit in the rack.
- The rack must be anchored to an immovable support to prevent it from tipping when the unit is mounted on it. The rack must be installed according to the rack manufacturer's instructions.
- Disconnect all power and external cables before lifting the unit. Depending on the weight of the unit, more than one person might be required to lift it.

4. Power Considerations

a. AC Power

- Adding to the system a UPS (Uninterrupted Power Supply) and an AVR (Automated Voltage Regulator) is highly recommended.
- Installing the main power supply by a qualified electrician, according to power authority regulations. Make sure all powering are wired with an earth leakage, according to local regulations.
- It is recommended to install the encoder within 1.5m (approximately 5 feet) from an easily accessible grounded AC outlet.
- When the encoder is rack-mounted, ensure that the rack is correctly grounded.

b. DC Power

- Ensure a suitable overcurrent device is in-line between the equipment and the power source.
- Connect DC-input power supplies only to a DC power source that complies with the safety extra-low voltage (SELV) requirements in the UL60950-1, CAN/CSA-C22.2 No. 60950-1-03, AS/NZS 60950-1, EN/IEC 60825-1, 21 CFR 1040, EN 60950-1, and IEC 60950-1 standards.
- Ensure that power is removed from the DC circuit before installing or removing power supplies

5. Handling Fiber Channel Cables

- Always read and comply with the handling instructions on the shipping container.
- Follow all ESD precautions and approved fiber cleaning procedures.
The fiber is made of a very pure, expensive glass and should be treated with great care. Handle fibers only in areas that are very clean and do not contain sharp objects.

Wear finger cots or gloves as dirt and oils can damage the fiber and contaminate connectors.

Do not allow kinks or knots to develop in the fiber. If tangles occur, carefully work out the tangles avoiding pulling or bending the fibre beyond its bend radius.

Always use the correct tools for stripping and cleaving the fiber. It will save time and reduce breakage caused by scratches.

If you must secure a bundle of fiber cables together, avoid plastic and metal tie wraps; secure with velcro instead.

6. Disposing of the Unit
   Dispose of the unit and its components (including batteries) as specified by all national laws and regulations.

**Product End-of-Life Disassembly Instructions**

For disassembly instructions, please call the technical support in order to remove components requiring selective treatment, as defined by the EU WEEE Directive (2012/19/EU). See Contacting the Technical Assistance Center.

**Product Disassembly Process**

1. Disassemble equipment at a dedicated area only, gather the needed tools for disassembly.
2. Remove covers, housing, etc.
3. Remove and separate sub-assemblies (i.e. cables, metals, displays, fans, etc.).
4. Separate hazardous materials from the remainder of the material.
   a. Sort hazardous materials into their different types (i.e., batteries, hazardous liquids, hazardous solids, fiberglass, etc.).
   b. Proceed with hazardous waste management processes only.
5. Identify re-usable materials/sub-assemblies and separate these from the rest of the material.
6. Identify and separate recyclable materials as per below examples:
   a. Scrap material to be sent to smelter(s).
   b. E-waste such as displays, CPU’s, cables and wires, hard drives, keyboards, etc.
   c. Metals such as steel, brass, and aluminum.
   d. Plastics such as fan casings, housings, covers, etc.
   e. Fiber optics and plastic tubing not containing electrical or data wiring.

**Safety Rules (English)**

Recycler personnel are to wear personal protective equipment including proper eye protection, proper hand protection, and proper breathing protection if needed.

Recycler personnel shall be experienced with using the proper tools required for disassembling equipment. Untrained personnel shall not disassemble Harmonic products. Unfamiliarity with tools can cause damage and injury.

**Règles de sécurité (French)**

Le personnel du recycleur doit porter de l’équipement de protection individuelle, y compris des lunettes, des gants et un masque de protection appropriés au besoin.
Le personnel du recycleur doit avoir de l'expérience des outils de démontage de l'appareil. Les produits Harmonic ne doivent pas être démontés par du personnel non qualifié. Une mauvaise connaissance des outils peut causer des dommages et des blessures.

**EU Manufacturer’s Declaration of Conformity**

This equipment is in compliance with the essential requirements and other provisions of Directives 73/23/EEC and 89/336/EEC as amended by Directive 93/68/EEC.

**NOTE:** For specifics, about which standards have been applied, refer to the Declaration of Conformity of the product on Harmonic website at [Product Regulatory Compliance](http://www.harmonicinc.com) or contact Harmonic Compliance Team at regulatory.compliance@harmonicinc.com

**Electromagnetic Compatibility Notices - Class A**

a. **FCC Verification Statement (USA)**

   This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device may not cause harmful interference, and (2) this device must accept any interference received, including interference that may cause undesired operation.

   This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications. Operation of this equipment in a residential area is likely to cause harmful interference in which case users will be required to correct the interference at their own expense.

   Connections between the Harmonic equipment and other equipment must be made in a manner that is consistent with maintaining compliance with FCC radio frequency emission limits. Modifications to this equipment not expressly approved by Harmonic may void the authority granted to the user by the FCC to operate this equipment and you may be required to correct any interference to radio or television communications at your own expense.

b. **ICES-003 Statement (Canada)**

   **English:** This Class A digital apparatus complies with Canadian ICES-003.

   **French:** Cet appareil numérique de la classe A est conforme à la norme NMB-003 du Canada.

c. **CE Declaration of Conformity (European Union)**

   This product has been tested in accordance too, and complies with the Low Voltage Directive (2014/30/EU) and EMC Directive (2014/35/EU). The product has been marked with the CE Mark to illustrate its compliance.
Appendix B Safety and Regulatory Compliance

Information

Electromagnetic Compatibility Notices – Class A

d. VCCI Class A Warning (Japan)

この装置は、情報処理装置等電波障害自主規制協議会（VCCI）の基準に基づくクラスA情報技術装置です。この装置を家庭環境で使用すると電波妨害を引き起こすことがあります。この場合には使用者が適切な対策を講ずるよう要求されることがあります。

English translation of the notice above:
This is a Class A product based on the standard of the Voluntary Control Council for Interference (VCCI) from Information Technology Equipment. If this equipment is used in a domestic environment, it may cause radio interference. When such trouble occurs, the user may be required to take corrective actions.

e. BSMI EMC Notice (Taiwan)

警告使用者:
這是甲類的資訊產品，在居住的環境中使用時，可能造成射頻干擾，在這種情況下，使用者會被要求採取某些適當的對策。

English translation of the notice above:
This is a Class A Information Product, when used in residential environment, it may cause radio frequency interference, under such circumstances, the user may be requested to take appropriate counter measures.

f. Class A Warning (Korea)

주의 A급 기기 이 기기는 업무용으로 전자파 적합 등록을 한 기기이오니 판매자 또는 사용자는 이 점을 주의하시기 바라며 만약 잘못 판매 또는 구입하였을 때에는 가정용으로 교환하시기 바랍니다.

English translation of the notice above:
This is a Class A device and is registered for EMC requirements for industrial use. The seller or buyer should be aware of this. If this was sold or purchased by mistake, it should be replaced with a residential-use type.

g. Class A Statement (China)

中华人民共和国“A类”警告声明

声明

为A级产品，在生活环境中，该产品可能会造成无线电干扰。在这种情况下，可能需要用户采取切实可行的措施。

English translation of the notice above:
When labeled with the CCC marking, the product meets the applicable safety and EMC requirements for China. This is a Class A product. In a domestic environment this product may cause radio interference, in which case the user may be required to take adequate measures.

h. **Class A Warning – CISPR 22 (AS/NZS)**

Warning (English)

This is a class A product. In a domestic environment this product may cause radio interference in which case the user may be required to take adequate measures.

Attention (French)

Il s’agit d’un produit de classe A. Dans un environnement local, ce produit peut entraîner des perturbations radioélectriques, auquel cas l’utilisateur devra éventuellement prendre des mesures adéquates.

### Product Regulatory Compliance

Harmonic products are typically tested to the latest safety and electromagnetic compatibility (EMC) specifications and test methods, and are marked with one or more of the following regulatory/certification markings. Some of the certification markings will vary depending on what certifier was used to obtain a certification.

Please visit Harmonic [Product Regulatory Compliance](#) page to view information on applied safety & EMC standards and regulatory marks on Harmonic products. You can also email us at regulatory.compliance@harmonicinc.com for assistance on regulatory compliance for Harmonic products.

### Product Regulatory Compliance Markings

**Table B-1: Regulatory Compliance Markings**

<table>
<thead>
<tr>
<th>Country/Region</th>
<th>Testing Standard/ Specification</th>
<th>Certification Type</th>
<th>Regulatory Mark Name</th>
<th>Product Marketing</th>
</tr>
</thead>
<tbody>
<tr>
<td>USA/Canada</td>
<td>FCC CFR 47 Part 15, Class A ICES-003: Issue 5, 2012; Class A</td>
<td>EMC</td>
<td>FCC Class A Statement</td>
<td><img src="#" alt="FCC Class A Statement" /></td>
</tr>
</tbody>
</table>

©2015 Harmonic Inc. All rights reserved.
### Table B-1: Regulatory Compliance Markings

<table>
<thead>
<tr>
<th>Country/Region</th>
<th>Testing Standard/Specification</th>
<th>Certification Type</th>
<th>Regulatory Mark Name</th>
<th>Product Marketing</th>
</tr>
</thead>
<tbody>
<tr>
<td>Germany</td>
<td>EN 60950-1; EN60825-1 (for laser)</td>
<td>Safety</td>
<td>GS</td>
<td><img src="image" alt="GS" /></td>
</tr>
<tr>
<td>Mexico</td>
<td>NOM-019-SCFI-1998</td>
<td>Safety</td>
<td>NOM</td>
<td><img src="image" alt="NOM" /></td>
</tr>
<tr>
<td>Taiwan</td>
<td>CNS 14336-1:2010 CNS 13438:2006; Class A</td>
<td>Safety and EMC</td>
<td>BSMI Certification (RPC) Number &amp; Class A Warning</td>
<td><img src="image" alt="BSMI" /></td>
</tr>
<tr>
<td>Japan</td>
<td>VCCI V-3/2013.04; CISPR 22:2008, Class A</td>
<td>EMC</td>
<td>VCCI</td>
<td><img src="image" alt="VCCI" /></td>
</tr>
<tr>
<td>Australia and New Zealand</td>
<td>AS/NZS CISPR22:2009+A1:2010; Class A</td>
<td>Safety</td>
<td>C-Tick</td>
<td><img src="image" alt="C-Tick" /></td>
</tr>
<tr>
<td>Korea</td>
<td>KN22 Class A and KN 24</td>
<td>EMC</td>
<td>KC</td>
<td><img src="image" alt="KC" /></td>
</tr>
</tbody>
</table>
Appendix B Safety and Regulatory Compliance Information

Product Environmental Compliance

Harmonic manufactures high quality and innovative IT and telecommunications equipment, video delivery infrastructure solutions and services for its customers worldwide. Harmonic is committed to providing our customers with safe and environmentally friendly products that are compliant with all relevant regulations, customer specifications, and environmental legislation, including the directives described below.

EU RoHS

In July 2006, the European Union’s (EU) Directive (2002/95/EC) on the Restriction of the use of certain Hazardous Substances (RoHS) in Electrical and Electronic Equipment (EEE) went into effect, and in July, 2011, the European Union’s RoHS Recast Directive (2011/65/EU) also known as RoHS II entered into force.

Harmonic understands the environmental risks associated with the substances covered by the RoHS Directive and has committed to eliminating or reducing the use of these, as well as other environmentally sensitive substances in our products. Harmonic also continues to comply with the requirements under RoHS II.

For more information, please visit EU RoHS directive page at official EU website.


Restricted Substance Statement

Harmonic products contain less than the permitted limits for the six restricted substances except where exemptions published in the RoHS2 Directive are applicable. This statement is based on vendor-supplied analysis or material certifications, and/or lab test results of the component raw materials used in the manufacture of Harmonic products.

Table B–2:Restricted Substances

<table>
<thead>
<tr>
<th>Restricted Substance</th>
<th>Permitted Limit*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cadmium (Cd)</td>
<td>≤ 0.01%</td>
</tr>
<tr>
<td>Lead (Pb)</td>
<td>≤ 0.1%</td>
</tr>
<tr>
<td>Chromium (VI) (Cr (VI))</td>
<td>≤ 0.1%</td>
</tr>
<tr>
<td>Mercury (Hg)</td>
<td>≤ 0.1%</td>
</tr>
</tbody>
</table>

Table B–1:Regulatory Compliance Markings

<table>
<thead>
<tr>
<th>Country/ Region</th>
<th>Testing Standard/ Specification</th>
<th>Certification</th>
<th>Regulatory Mark Name</th>
<th>Product Marketing</th>
</tr>
</thead>
<tbody>
<tr>
<td>China</td>
<td>GB4943.1-2011, GB9254-2008, GB17625.1-2012</td>
<td>Safety and EMC</td>
<td>CCC</td>
<td></td>
</tr>
</tbody>
</table>
Appendix B Safety and Regulatory Compliance

Information

© 2015 Harmonic Inc. All rights reserved. 211 ProView 7000 Release 3.7, Rev. A

Table B–2: Restricted Substances

<table>
<thead>
<tr>
<th>Restricted Substance</th>
<th>Permitted Limit*</th>
</tr>
</thead>
<tbody>
<tr>
<td>Polybrominated biphenyls (PBBs)</td>
<td>≤ 0.1%</td>
</tr>
<tr>
<td>Polybrominated diphenyl ether (PBDE)</td>
<td>≤ 0.1%</td>
</tr>
</tbody>
</table>

*Homogeneous material definition as per the EU Directive.

EU REACH


Harmonic supports the basic aim of REACH in improving the protection of human health and environment through the better and earlier identification of intrinsic properties of chemical substances. Harmonic products are considered “articles” under REACH; therefore, we are required to provide recipients of our products with information on Substance of Very High Concern (SVHC) present in concentration above 0.1% (w/w).

Substances in our products are not intended to be released under normal or reasonably foreseeable conditions of use; therefore, the registration requirement in REACH Article 7(1) does not apply to our products.

For more information, please visit REACH regulation page at official EU website.

http://ec.europa.eu/environment/chemicals/reach/reach_en.htm

China RoHS

China’s regulation on restriction of the use of certain hazardous substances commonly (China RoHS), is applicable to all Electronic and Information Products (EIPs) and parts sold in China after March 01, 2007. China RoHS regulation restricts the use of the same six substances as the European Union’s ROHS, but has requirements for product labeling and regulated substance information disclosure.

Harmonic complies with China RoHS Phase I for labeling and information disclosure requirements and continues to monitor new developments in China RoHS Phase II towards substance restriction and certification program.

For more information, please visit China RoHS regulation page at official US export website.

http://www.export.gov/china/doingbizinchina/
China RoHS Disclosure Report

Below table shows the presence of hazardous substances, or elements in Harmonic products, if the part is present.

This table shows those components where hazardous substances may be found in Harmonic products based on, among other things, material content information provided by third party suppliers. These components may or may not be part of the product.

The Environmental Protective Use Period for Harmonic products is 20 years unless displayed otherwise on the product. The EPUP period is valid only when the products are operated or stored as per the conditions specified in the product manual.

<table>
<thead>
<tr>
<th>部件名称 (Part name)</th>
<th>有毒有害物质或元素 (Hazardous Substance)</th>
</tr>
</thead>
<tbody>
<tr>
<td>印刷线路板 (Printed Circuit Assemblies)</td>
<td>(PB)  (Hg)  (Cd)  (CrVI)  (PBB)  (PBDE)</td>
</tr>
<tr>
<td>机械组件 (Mechanical Subassemblies)</td>
<td>X  0  0  0  0  0</td>
</tr>
<tr>
<td>光学组件 (Optical Subassemblies)</td>
<td>X  0  0  0  0  0</td>
</tr>
<tr>
<td>电源 (Power Supplies)</td>
<td>X  0  0  0  0  0</td>
</tr>
<tr>
<td>缆线 / 线束 (Cables, harnesses)</td>
<td>X  0  0  0  0  0</td>
</tr>
<tr>
<td>屏幕 / 显示器 (Screens, Monitors)</td>
<td>X  0  0  0  0  0</td>
</tr>
<tr>
<td>金属零件 (Metal Parts)</td>
<td>X  0  0  0  0  0</td>
</tr>
<tr>
<td>塑料 / 发泡材料 (Plastics, foams)</td>
<td>0  0  0  0  0  0</td>
</tr>
<tr>
<td>电池 (Batteries)</td>
<td>0  0  0  0  0  0</td>
</tr>
</tbody>
</table>

O: 表示在该部件的所有均质材料中，此类有毒有害物质的含量均小于 SJ/T11363-2006 标准所规定的限量。

X: 表示至少在该部件的某一均质材料中，此类有毒有害物质的含量超出 SJ/T11363-2006 标准规定的限量。

©2015 Harmonic Inc. All rights reserved.
Other RoHS and REACH type Regulations
Harmonic will comply with RoHS and REACH type regulations evolving in other countries, if they become relevant to our products or in markets where we sell our products.

Waste Electrical and Electronic Equipment (WEEE)
European Parliament and the Council of the European Union’s WEEE Directive (2002/96/EC) came into force on August 2005 and were more recently amended in July 2012. This directive encourages the reuse, recycling, and recovery of WEEE and to improve the environmental performance of all operators involved in the life cycle of electrical and electronic equipment, especially those dealing with WEEE. Harmonic ensures that all requirements for registration, reporting, design and data tracking are complied with to meet the objectives of the WEEE directive.

For more information, please visit WEEE directive page at official EU website.

Battery Directive
In September 2006, the European Union’s Directive 2006/66/EC (Battery Directive) came into force with an aim to prohibit the sale of batteries and accumulators containing hazardous substances and to set rules and promote collection, treatment, recycling and disposal of waste batteries and accumulators. This directive applies to spent batteries collected together with WEEE and requires their removal and separate collection. Once removed from WEEE, spent batteries are governed by the Battery Directive. Harmonic uses lithium batteries in its products and our responsibility under the Battery Directive is taken care of under our WEEE Take-Back program.

For more information, please visit Batteries and Accumulators directive page at official EU website.
http://ec.europa.eu/environment/waste/batteries/

Harmonic is committed to manufacturing environmentally safe products for the community, and will make reasonable efforts and required adjustments to its practices, if necessary, to comply with various environmental directives and industry initiatives on the elimination of hazardous substances, labeling, marking, certification and registration as required in markets where we sell our products.

Download Harmonic’s Environmental Compliance Statement at the following location:

WEEE Take-Back Request Program
In order to assist EU member states to preserve, protect and improve the quality of the environment, protect human health and utilize natural resources prudently and rationally, Harmonic strives to recycle in compliance with the WEEE Directive any of its products that cannot be re-used.

Harmonic's customers should:
- Not discard equipment in household or office garbage
- Arrange proper recycling of unneeded equipment. For the take-back of Harmonic equipment, customers must:
  - Collect the information required to complete Harmonic's WEEE Take-Back Request form
Appendix B Safety and Regulatory Compliance Information

Compliance with additional country specific environmental, safety and EMC standards:

- Complete and submit the online WEEE Take-Back Request form. Please note that forms must be fully completed in order to prevent process delays.
- Receive instant online confirmation indicating the reference number.
- Receive the End of Life (EOL) asset return authorization number and instruction for EOL asset return.

- Not ship EOL product to Harmonic without a Harmonic-provided EOL asset return authorization number.

The crossed-out wheeled bin symbol on a Harmonic-branded commercial product indicates that the product should not be disposed of along with municipal waste, but invites our customers to return the product to us under Harmonic’s WEEE Take-Back program for product disposal.

Harmonic will pay for the cost of shipping and will provide a Certificate of Recycling or a Certificate of Destruction upon request. For more information on collection, reuse and recycling or to initiate the WEEE take-back process, please complete the form at http://www.harmonicinc.com/webform/weee-takeback-request or contact Harmonic Technical Assistance Center (TAC) or email RMA team at rma.emea@harmonicinc.com.

Compliance with additional country specific environmental, safety and EMC standards:

In addition to above listed standards and compliance regulations, Harmonic products may also be compliant with other country specific environmental, safety and EMC requirements. Please contact Harmonic Compliance Team at regulatory.compliance@harmonicinc.com or your local sales representative for more information about compliance with particular country or standard.
Appendix C
Characteristics and Specifications

Transport Stream Input Interfaces

**DVB-S Input**
- Connector: 4 x RF In\(^1\) (common connector with DVB-S2)
- Constellation: QPSK
- Symbol rate: 1 – 45 Msps
- FEC: All ratios compliant with standard

**DVB-S2\(^2\) Input**
- Connector: 4 x RF In\(^1\) (common connector with DVB-S)
- Constellation: VCM, QPSK, 8PSK, 16APSK\(^3\)
- Symbol rate: 1 – 45 Msps
- FEC: All ratios compliant with standard
- FEC Blocks: Short and Normal
- Roll off: 0.2, 0.25 and 0.35
- Mode: CCM, VCM and Automatic
- Pilots: On, Off and Automatic

**L-Band RF input with LNB control**
- Connectors: 4 x F-type, 75 Ohm\(^1\)
- Frequency range: 950 – 2150 MHz
- RF input level: -65 – -25 dBm
- LNB power: 13 VDC, 18 VDC / 350 mA

---

1. More than one RF in with certain hardware configurations.
2. Requires a license with some hardware configurations, see Front End Card Features for details.
3. A license is required for 16APSK modulation. Only available with certain hardware configurations.
**DS-3 (G.703) Input**

- Connectors: $2^5 \times$ BNC 75 Ohm
- 1 x input and 1 x passthrough
- An isolated pulse between 0.36V and 0.85V Peak
- Packet Length: 188 and 204 byte packets
- TS effective bitrates:
  - 44.736 Mbps in Unframed mode without FEC
  - 44.209 Mbps in Framed mode without FEC
  - 41.227 Mbps in Unframed mode with FEC
  - 40.741 Mbps in Framed mode with FEC
- Modes of operation: Unframed or Framed (M13, C-parity) with or without Forward Error Correction Reed-Solomon according to DVB-C J.83 Annex A

**ASI Input**

- Connectors: 6 x BNC 75 Ohm
  - ProView 7000: 4 inputs, 2 outputs
  - ProView 7100\(^6\): 2 inputs, 4 outputs
- Packet Length: 188 and 204 byte packets
- TS maximum bitrate: 160 Mbps

**MPEG over IP Input**

- Number of ports: 2
- Connector: 100/1000 Base-T RJ-45
- Number of independent input streams: 4
- Encapsulation protocols: MPEG-2 TS over UDP/RTP over IP v4
- IP address types:
  - Unicast
  - Multicast
- Maximum socket bitrate: 160 Mbps
- FEC compliant with ProMPEG FEC CoP#3 (according to SMPTE-2022-1, SMPTE-2022-2, SMPTE-2022-3)

---

4. The DS-3 front-end card is only available for ProView 7100.
5. One for input and one for passthrough,
6. Two of the ASI ports are bi-directional.
7. Requires a license.
Transport Stream Output Interfaces

ASI Output
- Number of outputs: 2 (4 on ProView 7100)
- Connectors: 2 (4 on ProView 7100) x BNC 75 Ohm
- Packet Length: 188 byte packets
- TS maximum output bitrate: 160 Mbps

MPEG over IP Output
- Number of ports: 2 (mirrored)
- Connector: 100/1000 Base-T RJ-45
- Number of independent output streams: 4
- Encapsulation protocols: MPEG-2 TS over UDP over IP v4, support for RTP
- IP address type: Multicast
- Maximum socket bitrate: 160 Mbps

Transport Stream Processing
- PID and service level filtering
- High accuracy PCR re-stamping
- Autogeneration or passthrough of PSI / SI tables
- CA signaling removed when descrambling

Conditional Access (DVB-CI)
- Interface: 2 independent CI slots EN-50221
- CA methods: Multicrypt, Simulcrypt
- CAS: Viaccess®, Irdeto®, Conax®, Nagravision®, NDS

Video and Audio Decoding

Video Decoding
- Number of decoding channels: 2
- Decoding formats:
  - MPEG-2 SD 4:2:0 MP@ML
  - MPEG-2 SD 4:2:0 MP@HL
  - MPEG-2 HD 4:2:0 MP@HL\(^8\)
  - MPEG-2 SD 4:2:2 @ML
  - MPEG-2 SD 4:2:2 MP@HL

---

\(^8\) Requires a license.
Video and Audio Decoding

- MPEG-2 HD 4:2:2 P@HL
- MPEG-4 AVC SD 4:2:0 MP@L3
- MPEG-4 AVC HD 4:2:0 MP@L4.0 / HP@4.0
- MPEG-4 AVC SD 4:2:2 HP@L3
- MPEG-4 AVC HD 4:2:2 @ HiP/Hi10P/Hi422P @ L4.1 (8 and 10 bit)

- Maximum video rate:
  - MPEG-2 SD 4:2:0 – 15 Mbps
  - MPEG-2 SD 4:2:2 – 50 Mbps
  - MPEG-2 HD 4:2:0 – 50 Mbps
  - MPEG-2 HD 4:2:2 – 80 Mbps
  - MPEG-4 AVC SD 4:2:0 – 10 Mbps
  - MPEG-4 AVC SD 4:2:2 – 50 Mbps
  - MPEG-4 AVC HD 4:2:0 – 20 Mbps (MP), 25 Mbps (HP)
  - MPEG-4 AVC HD 4:2:2 – 100 Mbps (CAVLAC), 50 Mbps (CABAC)

- Video formats
  - 1080i @ 25, 29.97, 30 fps
  - 1080p @ 50, 59.94, 60 fps
  - 720p @ 59.94, 50, 60 fps
  - 576i @ 25 fps
  - 480i @ 29.97 fps
  - 480p @ 59.94 fps

- Analog video output
  - PAL-B/G/I/M/N/D
  - NTSC (M)
  - French SECAM
  - Russian SECAM

Video Processing

- HD video down-converted to SD with aspect ratio conversion
- Letter Box, Center Cut
- Aspect ratio conversion 16:9 to 4:3
- VBI reinsertion in video
- CEA-608/CEA-708 CC support in CV and SDI VANC
- SMPTE RP 186:2008 (class1.1) Video Index Information Coding
- SCTE 35 queuing commands to SCTE 104 splice request messages translation

---

9. Requires a license.
10. Only available with certain hardware configurations.
### Audio Decoding
- 2 or 4\(^{11}\) x Stereo pairs audio decoding
- Stereo down-mix
- MPEG-1 Layer-II (Musicam)
- Dolby Digital\(^{12}\)
  - Dolby Digital 2.0
  - Dolby Digital 5.1 down-mix to 2.0
  - Dolby Digital 5.1 passthrough (AC-3 only)
  - Dolby Digital Plus 5.1 re-embedded to Dolby Digital 5.1 @ 640 kbps
  - Dolby Digital 5.1 down-mix to 2.0
  - Dolby Digital 5.1\(^{11}\)
- Dolby E\(^{12}\) / Linear PCM Passthrough\(^{11}\)
- AAC LC
  - AAC LC 2.0 audio
  - AAC LC 5.1 audio\(^{11}\)
  - AAC LC 5.1 audio down-mix to 2.0 audio
- HE AAC v1 and v2
  - HE AAC 2.0 audio
  - HE AAC 5.1 audio\(^{11}\)
  - HE AAC v1 5.1 audio down-mix to 2.0 audio

### Video Transcoding
- Number of transcoders: 8
- From H.264 to MPEG-2
- From MPEG-2 to H.264
- Input and output resolutions:
  - 720 x 576 @ 25Hz
  - 704 x 576 @ 25Hz
  - 544 x 576 @ 25Hz
  - 528 x 576 @ 25Hz
  - 720 x 480 @ 29.97Hz
  - 704 x 480 @ 29.97Hz
  - 544 x 480 @ 29.97Hz
  - 528 x 480 @ 29.97Hz
  - 720p 1280 x 720 50 & 59.94 Hz
  - 720p 960 x 720 50 & 59.94 Hz
  - 1080i 1920 x 1080 25, 29.97 Hz

---

\(^{11}\) Requires a license.

\(^{12}\) Dolby, Dolby E and Dolby Digital are registered trademarks of Dolby Laboratories.
Video and Audio Interfaces

Video outputs
- 2 x composite video interfaces (1 broadcast and 1 monitoring)
- 2 x SD/HD/3G-SDI with embedded audio (mirrored)
- 1 x analog video RGB-HD 15 pin D-connector
- HDMI for monitoring
- Genlock

Audio outputs
- 2 x analog audio stereo pairs, balanced (15 pin D-connector)
- 2 x digital audio (AES/EBU-S/P-DIF)
- 2 balanced digital audio interfaces (15 pin D-connector)

Control and Monitoring
- Front panel keypad and LCD
- Web browser interface
- SNMP traps and alarms
- Ethernet: RJ-45 100/1000BaseT control interface
- Terminal: RS-232

Compliance

EMC
- EN55013 Sections 4.2, 4.3, 4.5
Appendix C Characteristics and Specifications

Environment

- EN55020 Sections 4.3, 4.4, 4.5, 4.7
- EN55022 (CISPR22)
- EN55024 (CISPR24)
- EN61000 3–2, 3–3, 4–2, 4–3, 4–4, 4–5, 4–6, 4–11
- FCC Part 15 Subpart B Class A - Conducted Emissions and Radiated Emissions

Safety

- CAN/CSA–C22.2 No. 60950–1–07
- EN 60950–1 2006
- IEC 60950–1 2005
- UL 60950–1:2007
- ROHS Directive 2002/95/EC

Environment

Operation

- Temperature: 0°C – +50°C
- Humidity: 5% – 90% (non-condensing)

Storage and Transportation

- Temperature: -40°C – +70°C
- Humidity: 0% – 95% (non-condensing)

Physical and Electrical Characteristics

Size: 1 RU unit (19" rack)

- Dimensions (H x W x D): 4.4 cm x 48.3 cm x 39.37 cm (1.75" x 19" x 15.5")
- Weight: 5 kg

Power

- Voltage: 100V–240V AC, 50/60Hz
- Power consumption: Up to 120W max.
Appendix D
Connectors and Front End Card Options

Topics:
- Overview of Rear Panel Ports and Connectors
- RGB Port Pin Configuration
- ProView 7000 GPI Port Pin Configuration
- Balanced Digital Audio Port Pin Configuration
- Balanced Audio Port Pin Configuration
- GPI Relay Position Names
- Front End Card Features

Overview of Rear Panel Ports and Connectors

Figure D–1 and Figure D–2 illustrate typical ProView 7000 rear panels and Table D–7 details the ports and connectors provided on the panel. The single decoder card can be ordered with or without the Genlock feature and connector. The ProView 7100 can be ordered with no decoder card.

Figure D–1: ProView 7000 Rear Panel with Single Decoder

Figure D–2: ProView 7000 Rear Panel with Dual Decoder

©2015 Harmonic Inc. All rights reserved.
Appendix D Connectors and Front End Card Options

Overview of Rear Panel Ports and Connectors

Figure D–2: ProView 7000 Rear Panel with Dual Decoder

Figure D–3: ProView 7100 Rear Panel with Single Decoder

Figure D–4: ProView 7100 Rear Panel with Dual Decoder and Genlock

Figure D–5: 4 ProView 7100 Rear Panel with single decoder, Genlock and 4 analog audio outputs
Appendix D Connectors and Front End Card

Options

Overview of Rear Panel Ports and Connectors

Figure D- 6: 4 ProView 7100 Rear Panel with single decoder, Genlock, 4 analog audio outputs and DS3

Table D- 7: Rear Panel Ports and Connectors

<table>
<thead>
<tr>
<th>Interface</th>
<th>Description</th>
<th>Connector Type</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>DVB-S/S2 front-end module</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>RF IN&lt;sup&gt;1&lt;/sup&gt;</td>
<td>1 x DVB-S/S2 RF modulated input stream with single port demodulator card</td>
<td>F-Type 75 Ohm</td>
</tr>
<tr>
<td></td>
<td>4 x DVB-S/S2 RF modulated input stream with quad port demodulator card</td>
<td></td>
</tr>
<tr>
<td><strong>DS-3 front-end module</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Ports</td>
<td>1 x input and 1 x passthrough.</td>
<td>BNC, 75 Ohm</td>
</tr>
<tr>
<td><strong>MPEGoIP ports</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MPEGoIP 1 &amp; 2</td>
<td>2 x GbE data ports</td>
<td>100/1000 Base-T, RJ-45</td>
</tr>
<tr>
<td><strong>ASI in/out ports</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>ASI IN 1, 2, 3 &amp; 4</td>
<td>2 or 4 x ASI input stream (2 bi-directional) - ProView 7100</td>
<td>BNC 75 Ohm</td>
</tr>
<tr>
<td></td>
<td>4 x ASI input stream - ProView 7000</td>
<td></td>
</tr>
<tr>
<td>ASI OUT 1, 2, 3 &amp; 4</td>
<td>2 x ASI output stream - ProView 7000</td>
<td>BNC 75 Ohm</td>
</tr>
<tr>
<td></td>
<td>2 or 4 x ASI output stream (2 bi-directional) - ProView 7100</td>
<td></td>
</tr>
<tr>
<td><strong>Decoder module, audio/video output interface</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>HD-RGB</td>
<td>1 x RGB High Definition video output with single decoder</td>
<td>D-Type 15-pin</td>
</tr>
<tr>
<td></td>
<td></td>
<td>condensed</td>
</tr>
<tr>
<td>Genlock</td>
<td>1 x Genlock synchronization input with single decoder</td>
<td>BNC 75 Ohm</td>
</tr>
<tr>
<td></td>
<td>Genlock feature and connector is optional</td>
<td></td>
</tr>
</tbody>
</table>

©2015 Harmonic Inc. All rights reserved. 224 ProView 7000 Release 3.7, Rev. A
## Table D-7: Rear Panel Ports and Connectors

<table>
<thead>
<tr>
<th>Interface</th>
<th>Description</th>
<th>Connector Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Analog Audio</td>
<td>1 x Analog audio stereo output (balanced) with single decoder</td>
<td>D-Type 15-pin condensed</td>
</tr>
<tr>
<td></td>
<td>2 x Analog audio stereo output (balanced) with dual decoder</td>
<td>2 x D-Type 15-pin condensed, XLR harness included</td>
</tr>
<tr>
<td></td>
<td>4 x Analog audio stereo output (balanced) with single decoder</td>
<td></td>
</tr>
<tr>
<td>Digital Audio</td>
<td>1 x Digital audio stereo output (balanced) with single decoder</td>
<td>D-Type, 15-pin condensed, XLR harness with 4 XLR connectors included</td>
</tr>
<tr>
<td>Balanced</td>
<td>2 x Digital audio stereo output (balanced) with dual decoder</td>
<td></td>
</tr>
<tr>
<td>CV</td>
<td>1 x Analog video output with single decoder</td>
<td>BNC, 75 Ohm</td>
</tr>
<tr>
<td></td>
<td>2 x Analog video output with dual decoder</td>
<td></td>
</tr>
<tr>
<td>CV MON</td>
<td>1 x Analog video monitoring output with single decoder</td>
<td>BNC, 75 Ohm</td>
</tr>
<tr>
<td></td>
<td>2 x Analog video monitoring output with dual decoder</td>
<td></td>
</tr>
<tr>
<td>HD/SD-SDI</td>
<td>2 x HD/SD-SDI with embedded audio with single decoder</td>
<td>BNC, 75 Ohm</td>
</tr>
<tr>
<td></td>
<td>4 x HD/SD-SDI with embedded audio with dual decoder</td>
<td></td>
</tr>
<tr>
<td>AES/EBU</td>
<td>0 x AES/EBU digital audio output with dual decoder and dual Genlock, and with 4 x audio analog output</td>
<td>BNC, 75 Ohm</td>
</tr>
<tr>
<td></td>
<td>2 x AES/EBU digital audio output with single decoder</td>
<td></td>
</tr>
<tr>
<td></td>
<td>4 x AES/EBU digital audio output with dual decoder</td>
<td></td>
</tr>
<tr>
<td>HDMI</td>
<td>1 x HD monitoring interface, Audio 1 (stereo) embedded with single decoder</td>
<td>HDMI</td>
</tr>
<tr>
<td>Management related interfaces</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Management</td>
<td>External access to the device for control and monitoring</td>
<td>RJ-45</td>
</tr>
<tr>
<td>Control</td>
<td>RS-232 interface connector</td>
<td>D-Type, 9-pin</td>
</tr>
<tr>
<td>GPI</td>
<td>General Purpose Interface connector, provides dry contacts (relays) to drive external alarms</td>
<td>D-Type, 9-pin – ProView 7000 D-Type, 15-pin female condensed – ProView 7100</td>
</tr>
<tr>
<td></td>
<td>5 x dry contacts – ProView 7000</td>
<td></td>
</tr>
<tr>
<td></td>
<td>2 x dry contacts – ProView 7000</td>
<td></td>
</tr>
</tbody>
</table>
Table D-7: Rear Panel Ports and Connectors

<table>
<thead>
<tr>
<th>Interface</th>
<th>Description</th>
<th>Connector Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power related interfaces</td>
<td></td>
<td></td>
</tr>
<tr>
<td>AC Power Socket and Switch</td>
<td>100–240 VAC 50/60Hz external power supply connector (for 18 AWG three wire cord) and on/off power switch</td>
<td></td>
</tr>
<tr>
<td>Grounding Jackscrew</td>
<td>Jackscrew for connecting the grounding cable when the unit is rack mounted</td>
<td></td>
</tr>
</tbody>
</table>

1. For best performance connect 75 Ohm terminators on all unused RF ports.

**RGB Port Pin Configuration**

![Figure D-8: D-Sub 15 Pinouts](image)

Table D-9: D-Sub 15 Pinout Names

<table>
<thead>
<tr>
<th>Pin No.</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>RED</td>
</tr>
<tr>
<td>2</td>
<td>GREEN</td>
</tr>
<tr>
<td>3</td>
<td>BLUE</td>
</tr>
<tr>
<td>4</td>
<td>N.U.</td>
</tr>
<tr>
<td>5</td>
<td>GND</td>
</tr>
<tr>
<td>6</td>
<td>GND</td>
</tr>
<tr>
<td>7</td>
<td>GND</td>
</tr>
<tr>
<td>8</td>
<td>GND</td>
</tr>
<tr>
<td>9</td>
<td>N.U.</td>
</tr>
<tr>
<td>10</td>
<td>GND</td>
</tr>
<tr>
<td>11</td>
<td>N.U.</td>
</tr>
</tbody>
</table>
Table D-9: D-Sub 15 Pinout Names

<table>
<thead>
<tr>
<th>Pin No.</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>12</td>
<td>N.U.</td>
</tr>
<tr>
<td>13</td>
<td>H-SYNC</td>
</tr>
<tr>
<td>14</td>
<td>V-SYNC</td>
</tr>
<tr>
<td>15</td>
<td>N.U.</td>
</tr>
</tbody>
</table>

ProView 7000 GPI Port Pin Configuration

Figure D-10: D-Sub 9 Pinouts

Table D-11: D-Sub 9 Pinout Names

<table>
<thead>
<tr>
<th>Pin No.</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>NC 1</td>
</tr>
<tr>
<td>2</td>
<td>NO 1</td>
</tr>
<tr>
<td>3</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>COM 2</td>
</tr>
<tr>
<td>5</td>
<td>NO 2</td>
</tr>
<tr>
<td>6</td>
<td>COM 1</td>
</tr>
<tr>
<td>7</td>
<td></td>
</tr>
<tr>
<td>8</td>
<td></td>
</tr>
<tr>
<td>9</td>
<td>NC 2</td>
</tr>
</tbody>
</table>
ProView 7100 GPI Port Pin Configuration

Figure D-12: D-Sub 15 Socket Pinouts

Table D-13: D-Sub 15 Socket Pinout Names

<table>
<thead>
<tr>
<th>Pin No.</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>COM 1</td>
</tr>
<tr>
<td>2</td>
<td>COM 2</td>
</tr>
<tr>
<td>3</td>
<td>COM 3</td>
</tr>
<tr>
<td>4</td>
<td>COM 4</td>
</tr>
<tr>
<td>5</td>
<td>COM 5</td>
</tr>
<tr>
<td>6</td>
<td>NC 1</td>
</tr>
<tr>
<td>7</td>
<td>NC 2</td>
</tr>
<tr>
<td>8</td>
<td>NC 3</td>
</tr>
<tr>
<td>9</td>
<td>NC 4</td>
</tr>
<tr>
<td>10</td>
<td>NC 5</td>
</tr>
<tr>
<td>11</td>
<td>NO 1</td>
</tr>
<tr>
<td>12</td>
<td>NO 2</td>
</tr>
<tr>
<td>13</td>
<td>NO 3</td>
</tr>
<tr>
<td>14</td>
<td>NO 4</td>
</tr>
<tr>
<td>15</td>
<td>NO 5</td>
</tr>
</tbody>
</table>
Balanced Digital Audio Port Pin Configuration

Figure D–14: D-Sub 15 Socket Pinouts

Table D–15: D-Sub 15 Socket Pinout Names

<table>
<thead>
<tr>
<th>Pin No.</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>AES4+</td>
</tr>
<tr>
<td>2</td>
<td>AES3+</td>
</tr>
<tr>
<td>3</td>
<td>GND</td>
</tr>
<tr>
<td>4</td>
<td>AES2+</td>
</tr>
<tr>
<td>5</td>
<td>AES1+</td>
</tr>
<tr>
<td>6</td>
<td>N.U.</td>
</tr>
<tr>
<td>7</td>
<td>GND</td>
</tr>
<tr>
<td>8</td>
<td>GND</td>
</tr>
<tr>
<td>9</td>
<td>N.U.</td>
</tr>
<tr>
<td>10</td>
<td>GND</td>
</tr>
<tr>
<td>11</td>
<td>AES4-</td>
</tr>
<tr>
<td>12</td>
<td>AES3-</td>
</tr>
<tr>
<td>13</td>
<td>N.U.</td>
</tr>
<tr>
<td>14</td>
<td>AES2-</td>
</tr>
<tr>
<td>15</td>
<td>AES1-</td>
</tr>
</tbody>
</table>

AES3 and AES4 are optional for HaDAS with 4 Audio channels.
Balanced Audio Port Pin Configuration

Figure D–16: D-Sub 15 Socket Pinouts

Table D–17: D-Sub 15 Socket Pinout Names

<table>
<thead>
<tr>
<th>Pin No.</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Audio BR+</td>
</tr>
<tr>
<td>2</td>
<td>Audio BL+</td>
</tr>
<tr>
<td>3</td>
<td>GND</td>
</tr>
<tr>
<td>4</td>
<td>Audio AR+</td>
</tr>
<tr>
<td>5</td>
<td>Audio AL+</td>
</tr>
<tr>
<td>6</td>
<td>N.U.</td>
</tr>
<tr>
<td>7</td>
<td>GND</td>
</tr>
<tr>
<td>8</td>
<td>GND</td>
</tr>
<tr>
<td>9</td>
<td>N.U.</td>
</tr>
<tr>
<td>10</td>
<td>GND</td>
</tr>
<tr>
<td>11</td>
<td>Audio BR-</td>
</tr>
<tr>
<td>12</td>
<td>Audio BL-</td>
</tr>
<tr>
<td>13</td>
<td>N.U.</td>
</tr>
<tr>
<td>14</td>
<td>Audio AR-</td>
</tr>
<tr>
<td>15</td>
<td>Audio AL-</td>
</tr>
</tbody>
</table>

Table D–18: D-Sub 15 Socket Pinout Names

<table>
<thead>
<tr>
<th>Pin No.</th>
<th>Signal</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Audio DR+</td>
</tr>
</tbody>
</table>
Audio C and Audio D are optional for HaDAS with 4 Audio channels.

**Table D-18: D-Sub 15 Socket Pinout Names**

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>Audio DL+</td>
</tr>
<tr>
<td>3</td>
<td>GND</td>
</tr>
<tr>
<td>4</td>
<td>Audio CR+</td>
</tr>
<tr>
<td>5</td>
<td>Audio CL+</td>
</tr>
<tr>
<td>6</td>
<td>N.U.</td>
</tr>
<tr>
<td>7</td>
<td>GND</td>
</tr>
<tr>
<td>8</td>
<td>GND</td>
</tr>
<tr>
<td>9</td>
<td>N.U.</td>
</tr>
<tr>
<td>10</td>
<td>GND</td>
</tr>
<tr>
<td>11</td>
<td>Audio DR-</td>
</tr>
<tr>
<td>12</td>
<td>Audio DL-</td>
</tr>
<tr>
<td>13</td>
<td>N.U.</td>
</tr>
<tr>
<td>14</td>
<td>Audio CR-</td>
</tr>
<tr>
<td>15</td>
<td>Audio CL-</td>
</tr>
</tbody>
</table>

GPI Relay Position Names

- **COM (Common)**
- **NC (Normally closed)**
- **NO (Normally open)**
## Front End Card Features

<table>
<thead>
<tr>
<th>Part Number</th>
<th>Description</th>
<th>Features</th>
</tr>
</thead>
<tbody>
<tr>
<td>099-0526-0XX</td>
<td>DVB-S/S2 Demodulator</td>
<td>- 1 Port</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- DVB-S</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Automatic DVB-S MODCOD selection</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- QPSK 1/2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- QPSK 2/3</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- QPSK 3/4</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- QPSK 5/6</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- QPSK 7/8</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Automatic spectral inversion mode selection (DVB-S only)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- DVB-S2</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- VCM (DVB-S2)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- QPSK 1/4 (DVB-S2)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- QPSK 1/3 (DVB-S2)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- QPSK 2/5 (DVB-S2)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- QPSK 3/5 (DVB-S2)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- QPSK 4/5 (DVB-S2)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- QPSK 8/9 (DVB-S2)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- QPSK 9/10 (DVB-S2)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- 8PSK 3/5 (DVB-S2)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- 8PSK 2/3 (DVB-S2)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- 8PSK 3/4 (DVB-S2)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- 8PSK 5/6 (DVB-S2)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- 8PSK 8/9 (DVB-S2)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- 8PSK 9/10 (DVB-S2)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- 16APSK 2/3 (DVB-S2)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- 16APSK 3/4 (DVB-S2)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- 16APSK 4/5 (DVB-S2)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- 16APSK 5/6 (DVB-S2)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- 16APSK 8/9 (DVB-S2)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- 16APSK 9/10 (DVB-S2)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Frame size (DVB-S2 only): 64,800 or 16,200</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Physical Layer Scrambling Seed (DVB-S2)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Acquisition mode</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Frequency drift compensation from 5 MBd and up</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Spectral inversion</td>
</tr>
<tr>
<td>Part Number</td>
<td>Description</td>
<td>Features</td>
</tr>
<tr>
<td>-------------</td>
<td>-------------</td>
<td>----------</td>
</tr>
</tbody>
</table>
| 099-0536-1XX | DVB-S Demodulator | - 1 Port
- DVB-S
- Automatic MODCOD selection
- QPSK 1/2
- QPSK 2/3
- QPSK 3/4
- QPSK 5/6
- QPSK 7/8
- Frequency drift compensation |
| 099-0555-0XX | DVB-S/S2 Quad Port Demodulator | - 4 Ports
- Automatic modulation standard selection (DVB-S/DVB-S2)
- DVB-S
- QPSK 1/2
- QPSK 2/3
- QPSK 3/4
- QPSK 5/6
- QPSK 7/8
- DVB-S2¹
- Automatic pilot symbol detection (DVB-S2¹ only)
- Automatic roll-off factor (DVB-S2¹ only)
- QPSK 3/5 (DVB-S2¹)
- QPSK 4/5 (DVB-S2¹)
- QPSK 8/9 (DVB-S2¹)
- QPSK 9/10 (DVB-S2¹)
- 8PSK 3/5 (DVB-S2¹)
- 8PSK 2/3 (DVB-S2¹)
- 8PSK 3/4 (DVB-S2¹)
- 8PSK 5/6 (DVB-S2¹)
- 8PSK 8/9 (DVB-S2¹)
- 8PSK 9/10 (DVB-S2¹)
- Physical Layer Scrambling Seed (DVB-S2¹)
- Automatic spectral inversion mode selection
- Automatic MODCOD selection
- Attenuation level
- Gain
- Frequency drift compensation from 8 MBd and up |
<table>
<thead>
<tr>
<th>Part Number</th>
<th>Description</th>
<th>Features</th>
</tr>
</thead>
<tbody>
<tr>
<td>099-0568-0XX</td>
<td>DVB-S/S2 Single Port Demodulator</td>
<td>1 Port, DVB-S, QPSK 1/2, QPSK 2/3, QPSK 3/4, QPSK 5/6, QPSK 7/8, DVB-S2¹, QPSK 3/5 (DVB-S2¹), QPSK 4/5 (DVB-S2¹), QPSK 8/9 (DVB-S2¹), QPSK 9/10 (DVB-S2¹), 8PSK 3/5 (DVB-S2¹), 8PSK 2/3 (DVB-S2¹), 8PSK 3/4 (DVB-S2¹), 8PSK 5/6 (DVB-S2¹), 8PSK 8/9 (DVB-S2¹), 8PSK 9/10 (DVB-S2¹), Automatic pilot symbol detection (DVB-S2¹ only), Automatic roll-off factor (DVB-S2¹ only), Automatic modulation standard selection (DVB-S/DVB-S2¹), Automatic spectral inversion mode selection, Automatic MODCOD selection, Attenuation level, Gain, Frequency drift compensation from 8 MBd and up</td>
</tr>
<tr>
<td>099-0672-00X</td>
<td>DS-3 Ports</td>
<td>1 Input Port, 1 Passthrough</td>
</tr>
</tbody>
</table>

¹. Requires a license.
### Appendix E Device Explorer Icons

#### Physical Input/Output Icons

<table>
<thead>
<tr>
<th>Icon Description</th>
<th>In</th>
<th>Out</th>
<th>Enabled/Connected</th>
<th>Disabled/Disconnected</th>
</tr>
</thead>
<tbody>
<tr>
<td>Port Holder</td>
<td>🔄</td>
<td>🔄</td>
<td></td>
<td></td>
</tr>
<tr>
<td>ASI Physical Port</td>
<td>🔄</td>
<td>🔄</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DVB Physical Port</td>
<td>🔄</td>
<td>🔄</td>
<td></td>
<td></td>
</tr>
<tr>
<td>DS-3 Physical Port</td>
<td>🔄</td>
<td>🔄</td>
<td></td>
<td></td>
</tr>
<tr>
<td>GbE Port</td>
<td>🔄</td>
<td>🔄</td>
<td></td>
<td></td>
</tr>
<tr>
<td>GbE Socket</td>
<td>🔄</td>
<td>🔄</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CAMs Holder</td>
<td>🔄</td>
<td>🔄</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CAM Slot</td>
<td>🔄</td>
<td>🔄</td>
<td></td>
<td></td>
</tr>
<tr>
<td>CAM Card</td>
<td>🔄</td>
<td>🔄</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Decoder Module</td>
<td>🔄</td>
<td>🔄</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Decoder Card</td>
<td>🔄</td>
<td>🔄</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Decoder Output</td>
<td>🔄</td>
<td>🔄</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### Multiplexing In/Out Icons

<table>
<thead>
<tr>
<th>Icon Description</th>
<th>In</th>
<th>Out</th>
<th>Enabled/Connected</th>
<th>Disabled/Disconnected</th>
</tr>
</thead>
<tbody>
<tr>
<td>Multiplexed Port</td>
<td>🔄</td>
<td>🔄</td>
<td></td>
<td></td>
</tr>
<tr>
<td>TS Port Route</td>
<td>🔄</td>
<td>🔄</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Programs Holder</td>
<td>🔄</td>
<td>🔄</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Program</td>
<td>🔄</td>
<td>🔄</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Icon Description</td>
<td>In</td>
<td>Out</td>
<td>Enabled/Connected</td>
<td>Disabled/Disconnected</td>
</tr>
<tr>
<td>----------------------------</td>
<td>----------</td>
<td>-----------</td>
<td>-------------------</td>
<td>-----------------------</td>
</tr>
<tr>
<td>Scrambled Program</td>
<td>![Icon]</td>
<td>![Icon]</td>
<td></td>
<td>![Icon]</td>
</tr>
<tr>
<td>Descrambled Program</td>
<td>![Icon]</td>
<td>![Icon]</td>
<td></td>
<td>![Icon]</td>
</tr>
<tr>
<td>Data Type Program</td>
<td>![Icon]</td>
<td>![Icon]</td>
<td></td>
<td>![Icon]</td>
</tr>
<tr>
<td>Radio Type Program</td>
<td>![Icon]</td>
<td>![Icon]</td>
<td></td>
<td>![Icon]</td>
</tr>
<tr>
<td>Scrambled Radio Program</td>
<td>![Icon]</td>
<td>![Icon]</td>
<td></td>
<td>![Icon]</td>
</tr>
<tr>
<td>Descrambled Radio Program</td>
<td>![Icon]</td>
<td>![Icon]</td>
<td></td>
<td>![Icon]</td>
</tr>
<tr>
<td>Video Type Program</td>
<td>![Icon]</td>
<td>![Icon]</td>
<td></td>
<td>![Icon]</td>
</tr>
<tr>
<td>Scrambled Video Program</td>
<td>![Icon]</td>
<td>![Icon]</td>
<td></td>
<td>![Icon]</td>
</tr>
<tr>
<td>Descrambled Video Program</td>
<td>![Icon]</td>
<td>![Icon]</td>
<td></td>
<td>![Icon]</td>
</tr>
<tr>
<td>Video ES</td>
<td>![Icon]</td>
<td>![Icon]</td>
<td></td>
<td>![Icon]</td>
</tr>
<tr>
<td>Audio ES</td>
<td>![Icon]</td>
<td>![Icon]</td>
<td></td>
<td>![Icon]</td>
</tr>
<tr>
<td>Data ES</td>
<td>![Icon]</td>
<td>![Icon]</td>
<td></td>
<td>![Icon]</td>
</tr>
<tr>
<td>Tables Holder</td>
<td>![Icon]</td>
<td>![Icon]</td>
<td></td>
<td>![Icon]</td>
</tr>
<tr>
<td>Tables</td>
<td>![Icon]</td>
<td>![Icon]</td>
<td></td>
<td>![Icon]</td>
</tr>
<tr>
<td>Unreferenced PID Group</td>
<td>![Icon]</td>
<td>![Icon]</td>
<td></td>
<td>![Icon]</td>
</tr>
<tr>
<td>Unreferenced PID</td>
<td>![Icon]</td>
<td>![Icon]</td>
<td></td>
<td>![Icon]</td>
</tr>
</tbody>
</table>

**Decoding Icons**

<table>
<thead>
<tr>
<th>Decoding Channel</th>
<th>![Icon]</th>
<th>![Icon]</th>
</tr>
</thead>
<tbody>
<tr>
<td>ES Decoding</td>
<td>![Icon]</td>
<td>![Icon]</td>
</tr>
<tr>
<td>Video ES Decoding</td>
<td>![Icon]</td>
<td>![Icon]</td>
</tr>
<tr>
<td>Audio ES Decoding</td>
<td>![Icon]</td>
<td>![Icon]</td>
</tr>
</tbody>
</table>
Note:
Some menus only display with certain hardware configurations or menu
Appendix G
ProView 7000 Alarm List

The following table lists the ProView 7000 alarms and the information provided on the property sheet.

<table>
<thead>
<tr>
<th>Short Description</th>
<th>Severity</th>
<th>Description/Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Backup Program Activated</td>
<td>Major</td>
<td>The Backup Program has been activated due to a failure of the Primary Program.</td>
</tr>
<tr>
<td>BER Too High</td>
<td>Warning</td>
<td>The BER is too high. Verify the reception conditions and the wiring.</td>
</tr>
<tr>
<td>CAM Descrambling Failure</td>
<td>Major</td>
<td>The CAM has failed to descramble the configured programs. Try the following:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Re-insert the CAM</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Reset the CAM If the problem persists, contact your CAM vendor.</td>
</tr>
<tr>
<td>CAM Missing</td>
<td>Major</td>
<td>No CAM has been detected in the slot. Verify that the CAM is inserted properly.</td>
</tr>
<tr>
<td>CAM Processing Failure</td>
<td>Major</td>
<td>No bitrate was detected after the CAM. Verify the following:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- The input bitrate does not exceed the CAM limit</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- The CAM supports the number of descrambled programs. If the problem persists, contact your CAM vendor.</td>
</tr>
<tr>
<td>Carrier Not Detected</td>
<td>Major</td>
<td>No carrier was detected in the configured frequency. Verify that the RF Cable is properly connected and that the following is properly configured:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Carrier Frequency</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- LNB Configuration</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Spectral Inversion</td>
</tr>
<tr>
<td>CC Errors on Backup Port</td>
<td>Warning</td>
<td>CC errors have been detected on the Backup Port. Improve the reception conditions</td>
</tr>
<tr>
<td>CC Errors on Primary Port</td>
<td>Major</td>
<td>CC errors detected on the Primary Port. Improve the reception conditions</td>
</tr>
<tr>
<td>Critical High Temperature Detected</td>
<td>Critical</td>
<td>A critical high temperature has been detected. Make sure the fans are operating and are not blocked</td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Turn off the device If the problem persists, contact Harmonic's Technical Assistance Center.</td>
</tr>
<tr>
<td>Critical HW Failure</td>
<td>Critical</td>
<td>Contact Harmonic's Technical Assistance Center</td>
</tr>
<tr>
<td>Critical SW Failure</td>
<td>Major</td>
<td>Contact Harmonic's Technical Assistance Center</td>
</tr>
<tr>
<td>Short Description</td>
<td>Severity</td>
<td>Description/Action</td>
</tr>
<tr>
<td>-----------------------------------------</td>
<td>----------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>De-Jittering Failure</td>
<td>Major</td>
<td>The device has not been able to de-jitter the input stream correctly.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Refer to the de-jittering status indication</td>
</tr>
<tr>
<td>De-Jittering Failure on Backup Port</td>
<td>Major</td>
<td>The device has not been able to correctly de-jitter the input stream.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Refer to the de-jittering status indication</td>
</tr>
<tr>
<td>De-Jittering Failure on Primary Port</td>
<td>Major</td>
<td>The device has not been able to correctly de-jitter the input stream.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Refer to the de-jittering status indication</td>
</tr>
<tr>
<td>Decoding Failure</td>
<td>Major</td>
<td>The decoding operation has failed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Contact Harmonic’s Technical Assistance Center</td>
</tr>
<tr>
<td>Decoding Failure (Resolution Mismatch)</td>
<td>Major</td>
<td>The input video resolution does not match the configuration.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Re-configure the Resolution Conversion value</td>
</tr>
<tr>
<td>Demodulation Failure</td>
<td>Major</td>
<td>No carrier was detected in the configured frequency.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Verify the following is properly configured:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Modulation Standard</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ MODCOD</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Frame Size</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Pilot Symbols</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Physical Layer Scrambling Seed</td>
</tr>
<tr>
<td>Disaster Recovery Has Been Activated</td>
<td>Major</td>
<td>Disaster recovery has been activated.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Verify reception conditions</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Contact your broadcaster for further assistance</td>
</tr>
<tr>
<td>DSR Not Synced</td>
<td>Major</td>
<td>The device has lost DSR synchronization.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Verify that the relevant inputs are connected correctly</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If the problem persists, contact Harmonic’s Technical Assistance Center.</td>
</tr>
<tr>
<td>Eb/N0 Value Too Low</td>
<td>Warning</td>
<td>The Eb/N0 value is too low.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Verify the reception conditions and wiring</td>
</tr>
<tr>
<td>Embedded Descrambler Overflow</td>
<td>Major</td>
<td>The input bitrate is too high.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Either reduce the bitrate or consider bypassing the embedded descrambler</td>
</tr>
<tr>
<td>ES Decoding Failure – Unsupported Content</td>
<td>Major</td>
<td>The program cannot be decoded because the encoded content is currently not supported.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Contact Harmonic’s Technical Assistance Center</td>
</tr>
<tr>
<td>Ethernet Auto Negotiation Failure</td>
<td>Major</td>
<td>Ethernet Auto-negotiation has failed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Verify that the cable is properly wired or consider reverting to manual PHY speed configuration</td>
</tr>
<tr>
<td>Fan Failure</td>
<td>Major</td>
<td>The fan has stopped operating.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>■ Contact Harmonic's Technical Assistance Center</td>
</tr>
<tr>
<td>Short Description</td>
<td>Severity</td>
<td>Description/Action</td>
</tr>
<tr>
<td>-------------------------------------------------------</td>
<td>----------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Firmware Download Failure                             | Warning  | Firmware download has failed. Verify the following:  
|                                                        |          | ■ The correct file was selected  
|                                                        |          | ■ There are no network disconnections  
|                                                        |          | If the problem persists, contact Harmonic’s Technical Assistance Center.                                                                            |
| Firmware Upgrade Failure Previous Version Loaded.    | Warning  | Firmware upgrade has failed.  
|                                                        |          | ■ Upgrade again or revert to the previous version                                                                                                  |
| Frame Mismatch                                        | Major    | The DS-3 framing format is not as expected.  
|                                                        |          | ■ Verify that the frame format matches on both ends of the line                                                                                  |
| Frame Rate Mismatch                                   | Warning  | The configured video frame rate does not match the frame rate of the source.  
|                                                        |          | ■ Re-configure the decoding frame rate.                                                                                                           |
| GbE Backup Port Activated                             | Warning  | The GbE Backup Port has been activated.  
|                                                        |          | ■ It is recommended to revert to GbE-1 as soon as possible                                                                                       |
| GbE Input Port Failed                                 | Critical | Both GbE inputs have failed.  
|                                                        |          | ■ Verify that the cables are properly connected on both ends and the ports on both ends are enabled  
|                                                        |          | ■ Consider adjusting the redundancy mode                                                                                                          |
| High Temperature Warning                               | Warning  | A high temperature has been detected.  
|                                                        |          | ■ Make sure the fans are operating and are not blocked  
|                                                        |          | ■ Turn off the device  
|                                                        |          | For further support, contact Harmonic's Technical Assistance Center.                                                                             |
| Input Bitrate Overflow                                 | Major    | The input bitrate to the CAM is too high.  
|                                                        |          | ■ Consider to reduce the input bitrate  
|                                                        |          | For further instructions, contact Harmonic's Technical Assistance Center.                                                                         |
| Input Failure                                          | Critical | Both source inputs have failed.  
|                                                        |          | ■ Verify that the cables are properly connected on both ends  
|                                                        |          | ■ Verify the reception conditions  
|                                                        |          | ■ Consider adjusting the redundancy mode or triggers                                                                                              |
| Link Down                                             | Major    | A Link down has been detected. Check:  
<p>|                                                        |          | ■ That the cable is properly connected on both ends.                                                                                              |
|                                                        |          | ■ That the ports on both ends are enabled.                                                                                                          |</p>
<table>
<thead>
<tr>
<th>Short Description</th>
<th>Severity</th>
<th>Description/Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Locked to an Alternative Link</td>
<td>Major</td>
<td>Disaster recovery has been activated. The device has locked onto an alternative link.</td>
</tr>
<tr>
<td>Loss of Frame (LOF)</td>
<td>Major</td>
<td>DS-3 frames were not detected. ■ Verify that the frame format matches the settings in the modulator.</td>
</tr>
<tr>
<td>Loss of Signal (LOS)</td>
<td>Major</td>
<td>No valid DS-3 signal has been detected. ■ Verify that the cable is properly connected.</td>
</tr>
<tr>
<td>Low Delay Stream While Configured to Normal Mode</td>
<td>Warning</td>
<td>A low delay stream was received while the decoder buffer management was configured to normal mode. ■ Configure the decoder buffer management mode to Low Delay</td>
</tr>
<tr>
<td>MPEG Sync Loss on Backup Port</td>
<td>Warning</td>
<td>The device cannot sync to the input stream. ■ Verify that the input contains a valid MPEG transport stream</td>
</tr>
<tr>
<td>MPEG Sync Loss on Primary Port</td>
<td>Major</td>
<td>The device cannot sync to the input stream. ■ Verify that the input contains a valid MPEG transport stream</td>
</tr>
<tr>
<td>MPEG TS Input Overflow</td>
<td>Major</td>
<td>The input bitrate is too high. ■ Reduce the bitrate ■ Contact Harmonic's Technical Assistance Center</td>
</tr>
</tbody>
</table>
| MPEG TS Output Overflow                       | Major    | The effective output bitrate is too high. ■ Consider either to increase the TS bitrate or to reduce the effective bitrate |%
<p>| Multiplex Backup Port Activated               | Warning  | The backup multiplex port has been activated. ■ It is recommended to revert to the Primary Port as soon as possible |
| No Genlock Sync                               | Major    | The program cannot be decoded properly because the decoder is not able to sync it to the input Genlock signal. Verify that: ■ The Genlock input is properly wired ■ The decoder display is configured correctly |
| No PCR Detected                               | Warning  | No PCR has been detected in the decoded stream. This may cause AV sync issues. ■ Check the PCR PID configuration |
| Packet Loss Detected after CAM               | Major    | Packets were dropped by the CAM. Verify the following: ■ The input bitrate does not exceed the CAM limit ■ The CAM supports the number of descrambled programs If the problem persists, contact your CAM vendor. |
| PER Too High                                  | Warning  | The PER is too high. ■ Verify the reception conditions and wiring |</p>
<table>
<thead>
<tr>
<th>Short Description</th>
<th>Severity</th>
<th>Description/Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>PID Conflict</td>
<td>Major</td>
<td>More than one PID is mapped to the same output PID.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Review the output configuration</td>
</tr>
<tr>
<td>PID Missing on Backup Port</td>
<td>Warning</td>
<td>No bitrate has been detected on this PID. Problem originating upstream.</td>
</tr>
<tr>
<td>PID Missing on Primary Port</td>
<td>Major</td>
<td>No bitrate has been detected on this PID. Problem originating upstream.</td>
</tr>
<tr>
<td>Program Descrambling Failure</td>
<td>Major</td>
<td>Program descrambling has failed.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Verify that the number of programs descrambled is supported by the CAM</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Contact your CAM vendor</td>
</tr>
<tr>
<td>Redundancy Compromised: Source Synchronization Failure</td>
<td>Warning</td>
<td>Non-Identical sources have been detected while working in the Seamless Redundancy mode.</td>
</tr>
<tr>
<td>Redundancy Configuration Failure</td>
<td>Warning</td>
<td>The offset between the sources is greater than the configured value.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Adjust the configuration</td>
</tr>
<tr>
<td>Seamless Redundancy: Unsupported Offset</td>
<td>Warning</td>
<td>The configured Max Offset Between Sources parameter has exceeded the maximum supported value.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Contact Harmonic's Technical Assistance Center</td>
</tr>
<tr>
<td>Searching for an Alternative Link</td>
<td>Major</td>
<td>Disaster recovery has been activated. The device is searching for an alternative link.</td>
</tr>
<tr>
<td>T2-MI Not Detected on Backup Port</td>
<td>Major</td>
<td>The device cannot sync to a valid T2-MI stream.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Confirm that the T2-MI PID configuration is correct</td>
</tr>
<tr>
<td>T2-MI Not Detected on Primary Port</td>
<td>Major</td>
<td>The device cannot sync to a valid T2-MI stream.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Confirm that the T2-MI PID configuration is correct</td>
</tr>
<tr>
<td>T2-MI PID Missing on Primary Port</td>
<td>Major</td>
<td>The configured T2-MI PID is absent.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Confirm that the T2-MI PID configuration is correct</td>
</tr>
<tr>
<td>T2-MI PID Missing on Backup Port</td>
<td>Major</td>
<td>The configured T2-MI PID is absent.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Confirm that the T2-MI PID configuration is correct</td>
</tr>
<tr>
<td>T2-MI De-Framing Failure on Backup Port</td>
<td>Major</td>
<td>The device cannot sync to a valid T2-MI stream.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Confirm that the T2-MI PID configuration is correct</td>
</tr>
<tr>
<td>Short Description</td>
<td>Severity</td>
<td>Description/Action</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>----------</td>
<td>----------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| T2-MI De-Framing Failure on Primary Port | Major    | The device cannot sync to a valid T2-MI stream.  
|                                   |          | • Confirm that the T2-MI PID configuration is correct.                            |
| Transcoding Failure (DTS/PTS Errors) | Major    | The DTS/PTS in the input is not compliant.                                         |
|                                   |          | • Adjust the source.                                                               |
| Video Transcoding Failure (Resolution Mismatch) | Major    | The input video resolution does not match the configuration.                      |
|                                   |          | • Re-configure the Resolution Conversion value.                                    |
| Transcoding Failure (Scrambled Content) | Major    | The transcoded PID is scrambled.                                                   |
|                                   |          | • Configure the program to be descrambled.                                        |
| Transcoding Failure (Input Errors) | Major    | The transcoding engine detected corrupted input packets.                          |
|                                   |          | • Adjust the input.                                                                |
| Transcoding Failure (PCR Error)    | Major    | The PCR interval in the input stream is too big.                                  |
|                                   |          | • Adjust the source.                                                               |
| Transcoding Failure (PID Missing)  | Major    | The configured transcoded PID could not be detected in the input.                 |
|                                   |          | • Adjust the source.                                                               |
| Verimatrix Descrambler Over-Provisioned | Major    | The Verimatrix descrambler configuration has exceeded its specifications.          |
|                                   |          | • Contact Harmonic's Technical Assistance Center                                   |
| Verimatrix Descrambler Initialization Failure | Major    | • Contact Harmonic's Technical Assistance Center                                   |
| Video Transcoding Engine Failure   | Major    | An internal video transcoding error has occurred.                                  |
|                                   |          | If the problem persists, contact Harmonic's Technical Assistance Center.            |
| Video Transcoding Failure (Codec Mismatch) | Major    | The input codec does not match the configuration.                                  |
|                                   |          | • Re-configure the Original Codec value.                                          |
| Video Transcoding Failure (Unsupported Video Format) | Major    | The input format does not match the transcoder specifications.                    |
|                                   |          | • Contact Harmonic's Technical Assistance Center                                   |
| Voltage Error                     | Critical | • Contact Harmonic's Technical Assistance Center                                   |
Active Version Management

The ProView 7000 keeps the current and last software versions. The EMS enables you to choose the active software version. The process of changing the active software version takes several minutes and requires a reboot.

To open the Active Software Management property sheet:

- Select **Tools > Firmware > Set Active Software**.

The Active Software Management property sheet displays two software versions available. The currently active version radio button is marked.

To change the device software version:

- Select the second version and click **Set Active Version**.

**NOTE:** A software version that is invalid is indicated in its radio button as N/A and is disabled.

Software Upgrade Manager

Use the EMS Software Upgrade Manager to perform a software version upgrade for all selected devices.

**CAUTION:** The BOOTP software upgrade option should be turned off when using the EMS to upgrade the ProView 7000 device. See **Device Software Upgrade Properties**.

To open the Software Upgrade Manager:

- Select **Tools > Firmware Software Upgrade Manager**.
The Software Upgrade manager enables you to select the update file source. The manager lists all ProView 7000 devices currently managed by the EMS and provides a check box to the left of each device name for you to select which devices to upgrade.

The manager lists the following information for each device:

- Device communication status (color coded):
  - **Disconnected (gray)**
  - **No communication (red marked)**
  - **Not logged-in (half red marked)**
  - **Communicating (full colors)**
- Device IP, Serial number and Version number.
- Upgrade status (Idle or active), % of upgrade done and upgrade time.

At the right of the Software Upgrade manager property sheet, a group of buttons are provided to manage the upgrade operation:

- **[Start Upgrade]** button – Starts the upgrade session.
- **[Remove]** button – Remove a device from the displayed list.
- **[Select all]** button – Selects all devices for upgrade.
- **[Unselect all]** – Clears all devices from upgrade.
- **[Log…]** button – Displays the upgrade log.
- **[Close]** button – Closes the upgrade property sheet.

### Upgrading the Firmware of ProView 7000s

It is recommended to upgrade all ProView 7000s at the same time. A device must be connected to be able to upgrade it, see [Connecting a Device](#). Once the device upgrade is successfully completed, the devices reboot and EMS closes. It takes several minutes to upgrade a device. The new version loads into the inactive firmware slot and does not replace the active version.

**NOTE:** When upgrading from version 2.6.x to 2.7.x and a card has been added, you must perform the upgrade twice.

To upgrade the firmware of several ProView 7000s:

1. Select **Tools > Firmware > Software Upgrade Manager**. The **Software Upgrade Manager** property sheet displays.
2. Mark the Upgrade check boxes of the devices that you want to upgrade.
   —or—
   To upgrade many devices:
   a. Click Remove to remove device names that are not part of the upgrade.
   b. Click Select All to select all devices in the list.
3. Open the Upgrade File browser and browse to the zip file containing the new software on your local hard disk.
4. Click Select.
5. Click Start Upgrade.
6. When the upgrade is complete, wait a few minutes for devices to reboot then upgrade your EMS installation to the same version of the managed devices:
   a. Refresh the web page with the ProView 7000 IP address.
   b. Click Launch ProView 7000 EMS on the ProView 7000 web page to install the EMS.

To upgrade your EMS installation to the same version of the managed devices:
1. Run a web browser and enter a ProView 7000 IP address.
   The initial ProView 7000 dialog displays.
2. Click Launch ProView 7000 EMS on the ProView 7000 web page to install the EMS.
   The EMS application installs.

**Viewing the Software Upgrade Log**

To view the software upgrade log:
1. Select Tools > Firmware Software Upgrade Manager.
   The Software Upgrade Manager property sheet displays.
2. Click Log.
   The Activity Log property sheet displays.